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Conventions du document

Conventions du document
Les conventions de Style utilisées dans ce document sont décrites dans le tableau suivant.

Item Convention Exemple
Nom d’un menu ou d’un outil gras, noms séparés par le symbole > o file > Open
o file > Compress > Design
Action dans une boite de dialogue gras )
e cliquer sur Apply.
e cliquersur le bouton Graphic Select a droite du champ Horizontal Alignment Include.
e dans la liste Segment Type, cliquer sur Lines.
Nom d’un champ dans une boite de dialogue italique ]
e entrer Route A dans le champ Alignment Name.
e cliquer sur le bouton Graphic Select a droite du champ Horizontal Alignment Include.
e dans la liste Segment Type, cliquer sur Lines.
Saisie clavier gras )
e entrer Route A dans le champ Alignment Name.
Nom d’un fichier gras italique ) o . )
e ouvrir le fichier Visualisation3D.dgn dans le dossier \Formation\
Chemin d’un fichier non italique . o ) .
e ouvrir le fichier Visualisation3D.dgn dans le dossier \Formation\
Mise en évidence d’un terme italique o ) ) ) ) . i
e la bibliotheque de gabarits contient des Gabarits, qui représentent des profils types
d’un tracé.
Nom d’un logiciel, d’'une application italique

e dans Power InRoads, ouvrir la commande Fichier > Nouveau.
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Généralités

Généralités
Les fichiers décrits dans ce document englobent le paramétrage du logiciel Power InRoads associés a la plateforme de dessin Power InRoads (Plateforme) et au volet conception et réalisation
Power InRoads (Conception) dans un environnement de travail ministériel.

L'élaboration des fichiers repose sur les dernieres normes de dessin du Ministére, sur un ensemble de criteres établis par le comité de paramétrage du logiciel Power InRoads ainsi que sur les
commentaires apportés par les différents utilisateurs. Autant que possible, les standards contenus dans ces fichiers tentent de répondre a la majorité des besoins des utilisateurs a travers le
Ministere. Il se peut cependant qu’une direction territoriale ait un besoin spécifique. Elle pourra alors soit ajouter ou modifier la configuration de base des fichiers et par la méme occasion, faire
part de ce besoin au comité de paramétrage qui verra a son analyse en vue d’apporter les corrections nécessaires dans la prochaine version des fichiers.

Les fichiers sont optimisés pour fonctionner sous la version Power InRoads V8i SS2 du logiciel.

Les fichiers sont disponibles sur le portail du Ministére a I'adresse suivante :
https://www.transports.gouv.gc.ca/fr/entreprises-partenaires/entreprises-reseaux-routier/guides-formulaires/Pages/arpentage-conception.aspx
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Généralités

Déploiement des fichiers de paramétrage
Dans un premier temps, le répondant en CDAO ayant les droits d’écriture sur le répertoire de configuration (par défaut H :\) doit déployer les fichiers de paramétrage sur le réseau. Ensuite,

chaque usager exécute sur son poste le méme déploiement.

1- Double-cliquer sur le fichier ParamMTQ2019-V2_PowerIinRoads.exe.

2-  Appuyer sur Suivant.

[#] Installation - MTEQ Norme2019-V2 pour Power InRoads

Bienvenue dans l'assistant
d'installation de MTQ
Norme2019-V2 pour Power
P‘? InRoads

Cet assistant va vous guider dans linstallation de MTQ
Morme2013-V2 pour Power InRoads version 1.0 sur votre
ordinateur.

1l est recommandé de fermer toutes les applications actives
avant de continuer,

Transports - C'IJiqunzz sur SlL'!iVat:ﬁ p;ur continuer ou sur Annuler pour
abandonner linstallation.
QUébEC

P 4

Annuler
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Généralités

3- Sélectionner le dossier de destination des fichiers en appuyant sur Parcourir. Le répertoire par défaut est le H:\Bentley\Norme2019-V2\. Appuyer sur Suivant.

[E Installation - MTQ Morme2019-Y2 pour Power InRoads

Dossier de destination F@
0l MTQ Norme2019-V2 pour Power InRoads doit-l étre installé ? i Y
L=k

L'assistant va installer MTQ Norme2019-V2 pour Power InRoads dans le
dossier suivant.

Pour continuer,, diguez sur Suivant. Si vous souhaitez cheisir un dossier différent,
diquez sur Parcourir.

Parcourir...

Le programme requiert au moins 258.4 Mo d'espace disgue disponible.

< Précédent Ik Annuler

4- Sélectionner le répertoire ou sont localisés les projets routiers et les projets en chantier (répertoire local) en appuyant sur Parcourir. Appuyer sur Suivant.

[E Installation - MTQ Morme2019-V2 pour Power InRoads

Répertoire des configurations w
QU localiser vos configurations? ! 4

Pour continuer, appuyez sur Suivant. Si vous désirez un répertoire différent, appuyez

sur Parcourir.
Répertoire de projets
m. ‘ Parcourir. ..
Répertoire de projets en chantier - Chaisir un répertoire local
|C: Projets ‘ Parcourir...
< Précédent Annuler

N
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Généralités

5- Appuyer sur Installer.

2 pour

Prét a installer
L'assistant dispose & présent de toutes les informations pour installer MTQ
Norme2013-V2 pour Power InRoads sur votre ordinateur.

Cliquez sur Installer pour procéder  linstallation ou sur Précédent pour revoir ou
modifier une option d'installation.

Répertaire des configurations:
Projets :
Projets chantier C:\Projets

Dossier de destination :
H:'\Bentley\Norme2019-v2

< Précédent Installer k Annuler

6- Appuyer sur Terminer.

| .g,l Installatio

Fin de l'installation de MTQ
Norme2019-V2 pour Power
InRoads

L'assistant a terminé l'installation de MTQ Norme2019-V2 pour
Power InRoads sur votre ordinateur,

Veuillez diquer sur Terminer pour quitter I'assistant
dinstallation.

Transports I
Quél:ec

P
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Généralités \
Structure et description des répertoires
, ‘| Bentley
!
' | Norme2019-V2
Cellules Répertoire de librairies de cellules

\ Documentation  Fichiers de documentation

|
. Images Librairie d’images (JPG, TIF, BMP, PNG, etc.)
\ Preferences Fichiers de préférences pour Power InRoads (Conception)
J& Prototypes Librairie de prototypes de dessin (Seeds, Cartouches, Giratoires, etc)
l“ Support Fichiers de support servant a définir I'environnement de travail
Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif 13 f’/



Power InRoads (Plateforme)

f—

Power InRoads (Plateforme)

Ce chapitre couvre la description des fichiers de paramétrage relatifs au dessin.

——
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Power InRoads (Plateforme)

Cellules

Les librairies de cellules servent a emmagasiner les cellules de Power InRoads. Une cellule est I’équivalent d’un bloc dans AutoCAD.

(2D) AP

(2D) DIV

(2D) SIG-PAN-DANGER
(2D) SIG-PAN-INDIC
(2D) SIG-PAN-PRESC
(2D) SIG-PAN-TRAVAUX
(2D) VEG

(3D) BAT

(3D) DRA

(3D) FER

(3D) OBJ

Documentation

Documents explicatifs de la Norme 2019-V2 et des fichiers de paramétrage pour Power InRoads.

Images

Cellules 2D pour la phase d’avant-projet

Cellules 2D non catégorisées

Cellules 2D de panneaux de signalisation de danger
Cellules 2D de panneaux de signalisation d’indication
Cellules 2D de panneaux de signalisation de prescription
Cellules 2D de panneaux de signalisation de travaux
Cellules 2D pour la végétation

Cellules 3D pour des batiments

Cellules 3D pour le drainage

Cellules 3D pour les infrastructures ferroviaires
Cellules 3D pour divers objets

(3D) SER
(3D) SIG-ECL
(3D) SIG-PAN
(3D) VEG
(3D) VEH
(3D) VoI
accident
aires
echel_dyn
motif

projet
signalisation

Cellules 3D pour des services d’utilités publiques généraux
Cellules 3D pour des services d’utilités publiques d’éclairage
Cellules 3D pour des panneaux de signalisation

Cellules 3D pour végétation

Cellules 3D pour véhicules divers

Cellules 3D pour les infrastructures routiéeres

Cellules pour les pictogrammes d’accident

Cellules définissant les aires d’impression pour les cartouches
Cellules pour échelles de plan

Cellules pour la création de motifs pour le hachurage
Cellules normalisées

Cellules pour le marquage et la signalisation

Bibliotheque d’'images de différents formats (JPG, TIF, BMP, PNG etc.) servant a la modélisation 3D (répertoire Textures) et aux plans de signalisation (répertoire Panneaux).

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif
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Power InRoads (Plateforme)

Prototypes
Répertoires de fichiers DGN servant de modele de départ (Seed).

Liste des fichiers prototypes

Nom Description

GiratoiresR28_VehB-12 Modele pour la conception d’un carrefour giratoire

MS_PP Prototype pour I'outil Plan & Profile Generator

mtq2D Prototype pour un environnement de dessin 2D

mtq3D Prototype pour un environnement de dessin 3D

mtgConversion Prototype servant a la conversion de coordonnées dans le systeme de projection MTQ Québec Lambert
mtqgProjet Prototype pour définir I'ensemble des modeéles d’un projet routier

PresentAccident Modeles de cartouches pour la gestion de la sécurité routiere

PresentArpent Modeéles de cartouches pour le volet arpentage

PresentConcep Modeles de cartouches pour le volet conception
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Power InRoads (Plateforme)

Support

Répertoires de fichiers ressources servant a définir un environnement de travail personnalisé au MTQ.

e Répertoire SHX : Police de caractéres.

e Répertoire tasks : Appel des outils du fichier mtq2019.dgnlib servant a la personnalisation de la barre de taches — MTQ.

e Répertoire workspace : Fichiers de configuration pour I’environnement de base lors de la création d’un nouveau profil usager.
DLL : Fichiers ressources applications.

seed.dwg : Fichier servant a la sauvegarde en format de fichier DWG.

MA, MVBA, BA : Fichiers d’applications.

mtq_panneaux.pal, mtq_panneaux.pal_Previews : Palette de matériaux de panneaux de signalisation pour la modélisation 3D et fichier d’apergu.
e mtq_textures.pal, mtq_textures.pal_Previews : Palette de matériaux de textures pour la modélisation 3D et fichier d’apergu.
e 2019.cfg : Fichier de configuration des variables d’environnement Power InRoads.

e mtq2019.dgnlib : Fichier librairie de dessin invoquant tous les paramétres de la norme.

e (CTB: Fichiers de plumes.

e mtq_acadcolor.tbl : Table de couleurs.

e PLTCFG : Fichier de configuration d’impression.

e RSC: Fichiers ressources du logiciel.

e LIN, MLN : Fichiers de types de ligne et multiligne.

e GeoCoordFavorites.xml : Fichier des systemes de coordonnés favoris.

o WmsServerList.xml : Fichier des serveurs d’images web favoris.

e PAT : Motifs d’hachurage du logiciel AutoCAD.

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif
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Power InRoads (Plateforme)

Taches — MTQ 2019

La barre de taches MTQ 2019 a été créé dans |'objectif d’améliorer la productivité des utilisateurs en regroupant en un endroit, les outils fréquemment utilisées du logiciel ainsi que des outils
personnalisés aux besoins des utilisateurs.

On vy retrouve les catégories suivantes :

Fichier

LN a P BRI D 2ES

a

| Ouvre une fenétre Windows Explorer dans le répertoire courant du dessin.

N
—

Ouvre une fenétre Windows Explorer dans le répertoire Bentley\Norme2019-V2\Documentation ; endroit ou se situe les documents explicatifs.
o
B Crée un fichier de sauvegarde en format BAK dans le répertoire courant du dessin et ouvre ce répertoire lorsque la sauvegarde est complétée.

Copie les fichiers de configuration réseau vers le répertoire local C:\ProgramData\Bentley\PowerlnRoads V8i\WorkSpace\Projects\MTQ_Norme2019-V2 afin d’utiliser les derniers
fichiers a jour lorsque le réseau est inaccessible (exemple : utilisation de Power InRoads en chantier).

LTJ Exporte le dessin courant en format DWG. Probleme connu : Les éléments provenant des outils Civil ne s’exportent pas correctement.

E=
ﬂ-r] Exporte seulement le modéle courant en format DWG. Les fichiers en références sont insérés dans le modéle maitre. Probleme connu : Les éléments provenant des outils Civil ne
s’exportent pas correctement.
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Power InRoads (Plateforme)

Liens Web :

Ouvre le portail des Ouvrages Routiers : http://www3.publicationsduguebec.gouv.qc.ca/produits/ouvrage routier.fr.html.

Ouvre le Systeme d’interface géographique express extranet (SIGEE) : https://systemes.transports.gouv.gc.ca/SIG.

Ouvre le Systeme d’interface géographique (SIG) : http://sig.mtg.min.intra/ListeSessionsTravail.aspx?CHARG AUTMT=0 (domaine MTQ seulement).
Ouvre le portail PLN pour le Registre ministériel des plans : http://pln.mtg.min.intra (domaine MTQ seulement).

ﬁ‘l\r Ouvre la boite de dialogue du gestionnaire de service de cartes Web (W/MS - Web Map Service) permettant d’accéder a différents serveurs d’informations sous forme d’image (fichier
5 de configuration WmsServerList.xml).

SCW — Toporama — Ressources naturelles Canada : http://wms.ess-ws.nrcan.gc.ca/wms/toporama_fr.

MTQ - Orthophotos : http://ws.sco.mtg.min.intra/lizardtech/iserv/ows (disponible seulement pour les utilisateurs sur le domaine MTQ).

MTQ — Orthophotos : http://ws.sco.transports.qc/lizardtech/iserv/ows.

MTQ — Données de la Base géographique routiére (BRG) : http://www.dds.mtg.gouv.gc.ca/dds.aspx (disponible seulement pour les utilisateurs sur le domaine MTQ).
MTQ- Géocatalogue : http://geocatalogue.mtg.qc/geoserver/wms (disponible seulement pour les utilisateurs sur le domaine MTQ).

Procédure
1) A partir de l'outil , Sélectionner le systéme de coordonnées approprié.
2) Cliquer sur l'icone .
3) Sélectionner le serveur a partir de la liste.
4) Dans la partie Available Layers, sélectionner les themes désirés pour générer une carte. Appuyer sur le bouton Add to Map pour les transférer dans la partie Map Layers.
5) Appuyer sur Save and Attach pour enregistrer le fichier dans le répertoire désiré. Le fichier s’enregistre et est attaché comme référence d’image dans

@ SVN (Service Vidéo Numérique) est un service web permettant de visionner des images en continu qui sont périodiquement relevées sur le réseau routier a la gestion du MTQ (disponible
seulement pour les utilisateurs sur le domaine MTQ).

Procédure
1) A partir de I'outil , Sélectionner le systéme de coordonnées approprié.
2) Cliquer sur lI'icbne .
3) Sélectionner un point a I’écran prés du centre d’une route existante.
4)
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5N

20

Ouvre I'emplacement dans Google Maps a partir d’'un point sélectionné a I'écran.

Procédure

1) A partir de I'outil , Sélectionner le systéme de coordonnées approprié.
2) Cliquer sur l'icone .
3) Sélectionner un point a I’écran prés du centre d’une route existante.

Charge I'application complémentaire Descartes servant a I'usage de la manipulation des nuages de points et des images. L’icone apparait uniquement lorsque I'application est installée
sur le poste de 'usager. Lorsque I'application est chargée, le méme bouton permet de la décharger pour libérer I'utilisation de la licence.

Charge I'application complémentaire AutoTURN de la compagnie Transoft. Cette application permet entre autres d’effectuer la validation des rayons de braquages d’une intersection.
L'icone apparait uniquement lorsque I'application est installée sur le poste de I'usager. Les versions 6, 7, 8,9 et 10 peuvent étre utilisées pour ce produit. Lorsque I’application est
chargée, le méme bouton permet de la décharger pour libérer I'utilisation de la licence.

Ouvre l'application Excel permettant de charger I'application Générateur de rapport XML (GRX). Cette application permet de récupérer les rapports XML produits par Power InRoads
et de faciliter I'ajustement de la présentation de ces rapports. On active le GRX a partir du ruban Compléments directement dans I'application Excel. L’icOne apparait uniquement
lorsque I'application est installée sur le poste de I'usager.

Scanne toutes les sections en travers (cartouches en référence ou non) créées par les préférences LEGAL100, LEGAL200, TABLOID100 et TABLOID200 générées par
et les classifient dans un dossier distinct soit LEGAL et TABLOID dans I’outil . A partir de cet outil, il est possible
d’imprimer les sections en travers désirées. Les dossiers LEGAL COULEUR et TABLOID COULEUR sont utilisés pour I'utilisation de la table de plumes (CTB) en couleur.

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Plateforme)

Parametres du modele

o 8
-.‘__"._;;

L1

.J-flf
LU

e A N A

Définit un systeme de coordonnées géographique pour le modele en cours. Par défaut, les systemes VTM Nad 83 des fuseaux 2 a 10 ainsi que le systeme Lambert Nad83 MTQ peuvent
étre sélectionnés a partir des icones. |l est également possible de choisir un systeme de coordonnées a partir de la bibliotheque ou d’utiliser le classement par direction territoriale

(DT).
"2 10°9 "8 °7 "6 °5 4 °3 "2 & © [l

Lorsque le systeme de coordonnées est sélectionné, le bouton apparait permettant de supprimer le systeme de coordonnées en cours.

Lors d’'un changement de systéeme de coordonnées, Power InRoads demandera si on veut corriger en modifiant le systéme ou de reprojeter les coordonnées. Pour cette derniere, les
éléments de dessin seront déplacés en fonction du nouveau systéme de coordonnées.

Définit I’échelle du modeéle pour la conception d’éléments de dessin. Cet outil est un prérequis a I'utilisation de plusieurs outils dessin de la barre de taches — MTQ 2019.

Plusieurs échelles sont a la disposition de I'usager. En conception, les plus courantes sont 1:100, 1 :200, 1 :500 et 1 :1000. Dans la boite d’outils, elles ont été regroupées par échelles
courante, par grandes échelles (1 :25, 1 :50 et 1 :75), par échelles plans (1 :150, 1 :250, 1 :300, 1 :400, 1 :2000 et 1 :5000) et par petites échelles (1 :10000, 1 :20000, 1 :25000, 1 :30000
et 1 :50000).

L1/ 1, 100 200 500 100025 150 10k =~ 25 50 75 = 150 250 300 400 20005000 10k 20k 25k 30k 50K,

Il est possible en tout temps de modifier I’échelle de dessin a I'intérieur du méme modele. Ceci n’affectera aucunement les éléments déja présents dans le modéle. Autrement dit, on
peut retrouver, par exemple, des éléments représentant la vue en plan a I’échelle 1 :500 et des éléments en vue de sections en travers a I'échelle 1 :200 dans un méme modele. Il suffit
de porter une attention particuliére a I’échelle avant de concevoir un élément a une échelle désirée.

Rafraichit les paramétres du modéle. Lors d’un changement de modeéle a I'intérieur d’'un méme dessin, les paramétres d’échelle et de systeme de coordonnées ne se rafraichissent pas
automatiquement. Cet outil permet de réinitialiser I’affichage pour ces deux paramétres afin de refléter les données exactes du modéle. En plus, les champs de textes sont mis a jour.

Permet le contréle de I'affichage des niveaux.
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Icone Description de I'outil

I'g Assigne le niveau O comme niveau courant. ParNiveau pour tous les attributs.
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Lignes — Dessin

9 A0z 0O _/ W

Icone Description de I'outil

4
Place une Smartline.

AN

Place une multiligne.
Place un bloc (rectangle).
Place une figure.

Place un cercle.

Place un arc.

XS

Sélectionne les éléments linéaires.

' ]
ex-",, Permet la sélection des attributs lignes pour des éléments existants (pictogramme joune dans le coin supérieur gauche).

pro

Permet la sélection des attributs lignes pour des éléments projetés (pictogramme rouge dans le coin supérieur gauche).

-
de”'{ Permet la sélection des attributs lignes pour des éléments o démolir (pictogramme vert dans le coin supérieur gauche).
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Lignes — Modifications

q:75 il @ N

Brise une ligne.

Crée une chaine complexe.

Crée une forme plane complexe.

o
'\\.r;'- -
T

Explose un élément.

&

Change les attributs d’élément.

A
g
Inverse la direction d’un élément.
77
Z
——| Modifie I’élévation des éléments (Modéle 3D Seulement).
24
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Textes 1

jA A Np R e s S Iexfpmdem

Icone Description de I'outil

Place du texte.

[A
' - Placer note avec fleche.
- Placer note avec point.
- Placer note avec ligne.
- Placer note avec demi-fleche.
- Placer note avec demi-point.
B

A Editer texte.

A
At Accorde les attributs d’un texte.
4
A Change les attributs d’un texte.
AlA
AZA

Copie et incrémente un texte.

senss
i

Applique ou supprime un masque (arriere-plan) d’un texte ou d’une cotation.

o

Sélectionne les éléments textes.
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Icone Description de I'outil

‘ "
ex’, Permet la sélection des attributs textes ou cotations pour des éléments existants (pictogramme jaune dans le coin supérieur gauche).

-
prﬂ, Permet la sélection des attributs textes ou cotations pour des éléments projetés (pictogramme rouge dans le coin supérieur gauche).
-

dem

. Permet la sélection des attributs textes ou cotations pour des éléments & démolir (pictogramme vert dans le coin supérieur gauche).
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Cotation
— | R{ [ e o
Al |}|ﬂ*|f\ AT
|
| | - Cotation linéaire avec fleche.
' - Cotation linéaire avec fleche et orientation du texte a la verticale.
- Cotation linéaire avec oblique.
- Cotation linéaire avec demi-fleche.
- Cotation linéaire en mm avec fleche.
+ - Cotation d’élément avec fleche.
' - Cotation d’élément avec fleche et orientation du texte a la verticale.
- Cotation d’élément avec oblique.
- Cotation d’élément avec demi-fleche.
- Cotation d’élément en mm avec fleéche.
R,

N Cotation d’un rayon.

|4'-\:-"fl|; H ’
=~ - Cotation d’arc en longueur.
Tk . ,
- Cotation d’arc en angle.
=
t

— Modifie une cote.

r|‘|H
1 Accorde une cote.
=
fn +
Change une cote.
&3

Renverse le texte de la cotation selon I'orientation de la vue (2D seulement).
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Hachures

s 4l & (A & REIF [ exiprodem

7
&
%

&
X

ex

]

pro

]

dem

28

Hachurage linéaire.

Hachurage croisé.

Hachurage par motif.

Créer une région (remplissage — hachurage SOLID).

Efface un hachurage.

Supprime le remplissage des composants définis dans les sections en travers.

Hachure les composants définis dans les sections en travers selon le type de matériel pour chaque composant.

Permet la sélection des attributs d’hachures pour des éléments existants (pictogramme jaune dans le coin supérieur gauche).

Permet la sélection des attributs d’hachures pour des éléments projetés (pictogramme rouge dans le coin supérieur gauche).

Permet la sélection des attributs d’hachures pour des éléments a démolir (pictogramme vert dans le coin supérieur gauche).
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Textes2
A.

s 28 ST FrEE

33!

Icone Description de I’outil

P

Place une annotation en plan. Utilisation de I'outil Drafting > Place Plan Note.

Place une annotation en profil. Utilisation de I'outil Drafting > Place Profile Note.

Place une annotation dans une section en travers. Utilisation de I'outil Drafting > Place Cross Section Note.

Utilitaire (atool.ma) pour placer des annotations de surfaces (aires).

90 b Mo

Remplace les textes comportant des points par des virgules.

A | Définit le style de texte :
»
' - Arial.
- Arial avec masque (arriere-plan).
a:lal = Arial GraS.

i

Arial Gras avec masque (arriére-plan).
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Icone Description de I’outil

Définit la justification du texte :

i
z - Haut Gauche.
Z - Milieu Gauche.
i |- Bas Gauche.
z - Haut Centre.
3]-  Milieu Centre.
:]- Bas Centre.
j - Haut Droite.
;|- Milieu Droite.
":|- BasDroite.

E I Force la hauteur du texte en millimeétres :
m

E - 1,5mm.
- 2mm.
25|-  2,5mm.
E - 3mm.
35/ -  3,5mm.
E - 4mm.
E - 5mm.
[7]- 7mm.
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Cellules

e i N , -
Bl 5 A sk PRI I exi pro dem

; Place une cellule.
“##E  Remplace ou met a jour une cellule.

}7 Place une cellule comme terminaison de ligne.

>@»  Edite les étiquettes d’une cellule (exemple : cartouche).

-F\g;) Change les étiquettes de tous les jeux d’étiquettes d’'un modéle.

Sélectionne et place des cellules.

#4
_E Modifie la couleur des fleches blanches en bleu lorsque I'outil , Slope Direction est utilisé.
fk Sélectionne toutes les cellules du modele.

«  Permet I'insertion de cellules avec attributs pour des éléments existants (pictogramme jaune dans le coin supérieur gauche).
pm Permet l'insertion de cellules avec attributs pour des éléments projetés (pictogramme rouge dans le coin supérieur gauche).

d Permet I'insertion de cellules avec attributs pour des éléments a démolir (pictogramme vert dans le coin supérieur gauche).
em
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Mise-en-page

! N PO = £N 2 | | A | A | - |
o T e
T
-l Définit le format de papier pour la préparation d’une vue enregistrée.
- Place une aire selon le format et I’échelle du modele.
- Les cellules s’ajustent en fonction de I’échelle du modele.
- Définit les attributs de I'élément.
By
= Rotation de vue par élément.
<] crée une vue enregistrée.
O«
&4l Met ajour la vue enregistrée.
|_H . . : o
Crée un modele Feuille (Sheet) a partir du prototype PresentConcep.dgn.
sm e o . N .
+ Définit le sous-ministériat et met a jour tous les cartouches dans tous les modeles du dessin.

32

Définit la direction générale et met a jour tous les cartouches dans tous les modéles du dessin.

Définit la direction et met a jour tous les cartouches dans tous les modéles du dessin.
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Description de I'outil

m Définit la couleur du texte du niveau PAP-TEXTE.

E, Définit la hauteur du texte.

- Définit les attributs de I'élément.
- Active I'outil Placer Texte.
- La hauteur du texte s’ajuste en fonction de I’échelle du modeéle.

El Place une cellule pour I’habillage de plan, I’échelle d’un cartouche ou I'annotation d’un cartouche.

- Définit les attributs de I'élément.
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Bibliotheques de cellules

A e R S N Y Y

@

Ouvre la bibliotheque de cellules 3D Bdtiment et active les attributs appropriés.

Ouvre la bibliotheque de cellules 3D Drainage et active les attributs appropriés.

N

Ouvre la bibliotheque de cellules 3D Ferroviaire et active les attributs appropriés.

%

Ouvre la bibliotheque de cellules 3D Objets et active les attributs appropriés.

i ‘ Ouvre la bibliotheque de cellules 3D Services publics et active les attributs appropriés.

Ouvre la bibliothéque de cellules 3D Signalisation — Eclairage et active les attributs appropriés.

A

Ouvre la bibliotheque de cellules 3D Véhicules divers et active les attributs appropriés.

Ouvre la bibliothéque de cellules 3D Bdtiment et active les attributs appropriés.

NI

-

E - Ouvre la bibliotheque de cellules 3D Végeétation et active les attributs appropriés.
- Outil pour peupler une zone de végétation.

Ouvre la bibliotheque de cellules 3D Infrastructure routiére et active les attributs appropriés.

-

=
N

Wl Outil pour positionner des poteaux des extrémités de glissieres de sécurité en fonction de I'affichage des Features d’une surface :
- o Glis_ D
o Glis_G
o GlisAci_D
o GlisAci_G

@ - Efface les poteaux et extrémités de glissieres de sécurité dessiner dans le modele courant.
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Description de I'outil

% - Ouvre la bibliotheque de cellules 2D Panneaux de danger et active les attributs appropriés.

- Ouvre la bibliotheque de cellules 2D Panneaux d’indications et active les attributs appropriés.

- Ouvre la bibliotheque de cellules 2D Panneaux de prescription et active les attributs appropriés.
@ - Ouvre la bibliotheque de cellules 2D Panneaux de travaux et active les attributs appropriés.
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Marquage 3D

1L RO
7] T ™
¢ EAERNER
, :
AV BEERNER
Icone Description de I'outil
Ligne de marquage simple continu.
Ligne de marquage simple de discontinuité.
| P
. Ligne de marquage simple de continuité.
”
Ligne de marquage double continu.

Ligne de marquage double continu-discontinuité.

=

]

Ligne de marquage double discontinuité-continu.
Ligne de marquage simple de guidage.

Ligne de marquage double pour voie réservée.
Ligne de marquage pour passage de piéton.
Ligne de marquage blanche cédez pour giratoire.

Insére une cellule représentant un pictogramme de marquage de chaussée.
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Animation

BE L @A G DR E
N EHLE

g Survole une chaussée — Raccourci de la commande /nRoads Modeler > Drive Roadway.

Simule une circulation sur une chaussée.

Utilitaire pour la convergence des chaussées des simulations de circulation.

Pochage des éléments 2D sur une géométrie 3D.

Pochage dans une référence 3D.

S (A Be 7

Applique un matériel, une texture.

b
a Utilitaire pour définir les matériaux, des textures.
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Icone Description de I'outil
Transformation d’un modele tridimensionnel.

N
» Procédure

1) copier surface existante. Effectuez une copie de sauvegarde de la surface terrain naturel (Ex. Tn3D).

EN 4

2) Copier Exterior Bound. Prop. -> Existant. Copiez le Feature
Exterior Boundary de style FME de la surface proposé dans la
copie de la surface existante Tn3D.

Surface proposée

3) Modifier type Exterior pour Interior. Modifier le Type de Feature
Exterior pour Interior dans la surface Tn3D.

4) Affichage des triangles. Affichez les triangles de la surface Tn3D.

5) Sauvegarde de la surface. Enregistrez la surface Th3D.

0O - B

(th3p)  “ENSRENNRN

6) Affichage des composants. Affichez les composants de la surface
proposée.

.+ 1

Copie de la surface existante

H

Active le producteur d’animation.

ﬁ Active la barre d’apergu de I'animation.
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Description de I'outil

Oriente la caméra.
Vue de la caméra.
Crée une caméra d’animation.

Scripte une caméra.

& % ® T

«

Crée une cible.

(7

Scripte une cible.

Définit un parcours pour une caméra ou un acteur.
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Eléments de la Norme 2019-V2

Statut d’attribut d’élément
Icone Description de I'outil
-

€XI  Active les outils d’éléments existants (pictogramme jaune dans le coin supérieur gauche).

-
pro Active les outils d’éléments projetés (pictogramme rouge dans le coin supérieur gauche).

-
dem Active les outils d’éléments a démolir (pictogramme vert dans le coin supérieur gauche).
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Catégorie d’attribut d’élément

Icone
-
bat,
dra,
-
fer,

e
fon,
-
geo,
i
mod

L3

pro
-
rep

sec,
e

ser

.3

.3

ﬁ-
sig.
-

str,
"Eoph
ffegh

voi

.3

Description de I'outil
Eléments pour batiments.

Eléments pour drainage.

Eléments pour ferroviaire.

Eléments pour information fonciére.
Eléments pour géométrie.

Eléments pour modélisation.
Eléments pour vues en profil.
Eléments pour repeéres.

Eléments pour sections transversales.
Eléments pour services publics.
Eléments pour signalisation et éclairage.
Eléments pour structures.

Eléments pour topographie.
Eléments pour végétation.

Eléments pour infrastructure routiére.
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Power InRoads (Conception)

Ce chapitre couvre la description des fichiers de paramétrage relatifs au volet conception et réalisation d’un projet routier.
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Preferences
Cette section explique le contenu des fichiers de préférences du logiciel Power InRoads.

Fichier de préférences CivMTQ2019.xin

Ce fichier de préférences a été bati principalement pour deux échelles de travail en plan/profil (échelles Default (1 :500) et 1 :1000) et deux échelles de travail en section/volume (échelles Default
(1 :200) et 1 :100). Pour la plupart des outils Power InRoads, on retrouvera alors au minimum deux échelles dépendamment du plan de travail (plan, profil ou section) :

Vue en plan Vue en section
B4 Cross Sections \EI = @
File
Lrass Section Set: Mode: (@) Refresh Display On Display Off
ﬂ Start: Stop:
{23 Create Cross Section Set Name: Default
e [B I
Create: Window and Data
B View Stationing == Include Interyal: 20.000 +|
{27 Cortrols .
a Vigw Stationing Horizontal Alignment: [ 5efayk v] ﬂ {27 Custom Lo -30.000 ﬂ
[ (;ene;m » . % Layout Bight Offset: 30.000 |
egular Stations ’ (B Axes
Stat
Cardinal Stations DSlalltm — ﬂ - Gid Vetical Exaggeration: 1 0000000
Fls = i Details [] Show Data Outside Elevation Range
Station Equations Stop:  [0+000.000 #| L2 ASCIl or LandXML I
Event Points [ Annctate Cross Section LrTaces:
Fladiu.s +A ) Drop Station Equation Name Bt Preferences [53a| | | T3 Update Cross Section Object Name B Preferences =)
Transition Radi [ End-Area Violumes I:l Default Diefault l:l X
Vertical Stations Planarize Name: lame
(GED) Annotation3D A Hg'g evilet A
(GEO) Lonctrr e T E— 2
e - i
1:1000 -— - -—5
1:1000 - Texte inversé Save Nene M5_1:200 2ave
1:500 - Teade inv. {Existant) Save fs..
y B s |
-—
Effacer y Delete
< | 1 | 3 Help Help
[ Apply ] [PTEfETEHCEE---‘ [ Close ] [ Help ] Active Preference: Default Apply Preferences... Close Help Active Preference: Default

Il existe une échelle appelé Default dans les trois plans de travail (plan, profil et section). En plan et profil, cette échelle correspond a 1 :500 et en sections et volumes elle correspond a 1 :200.
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La raison de cette dénomination est que lorsqu’on charge le fichier civMTQ2019.xin dans une session de travail Power InRoads, par défaut, une préférence standard est chargée par projet tel que
définie dans le menu sous Preferred Preference :

Bt St Project Defaults

Corfiguration Name: chone>

4

|:‘E||7 2 8
o

Default Preferences Close

Delete

Import..

g g
5]
4 @

IT
@
o

Default Directory Paths

Default Grid Factor Export Prefemed Preference

faisant ainsi correspondre le nom de la préférence chargée par défaut au nom de la préférence par défaut dans les différents plans de travail. On s’assure alors que peu importe le plan sur lequel
on travaille dans un projet donné, on aura toujours une sortie graphique correspondant aux échelles de dessin normalisées du Ministére, soit 1 :500 et 1 :200. L'usager n’aura donc pas besoin de
se préoccuper de charger a chaque fois la bonne préférence dans chaque menu qu’il voudra utiliser.
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Certains menus possédent des préférences supplémentaires afin de répondre a des besoins plus spécifiques. En voici quelques-unes a titre d’exemple :

Effacer Efface les éléments et annotations de dessin

(GEO) LignRefProj Automatise les annotations des alignements (hor. Ou vert.) sur les éléments du style (GEO) LignRefProj
(GEO) LignRefExist Automatise les annotations des alignements (hor. Ou vert.) sur les éléments du style (GEO) LignRefExist
1:1000 — Texte inversé Inverse le texte des chainages de I'échelle 1 :1000

1:500 — Texte inversé Inverse le texte des chalnages de I'échelle 1 :500

Cadre 1:200 Annote un jeu de sections en travers dans un encadrer en bas de chacune des sections en travers
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Les symbologies définissent 'ensemble des parametres graphiques dans Power InRoads :
les éléments ponctuels (symbole, calque, bloc, couleur, grosseur, etc.)
les éléments linéaires (style, calque, couleur, épaisseur, etc.)

les textes (grosseur, espacement, calque, rotation, etc.)

et ce dans les différentes vues :
en plan
en section
en profil

Les symbologies portent une nomenclature distinctive pour faciliter le repérage dans le fichier. Pour chaque symbologie, un style y est associé. Le style permet de gérer 'affichage ou non des
symbologies dans les différentes vues.
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= Les styles pour la géométrie représentent les éléments horizontaux et/ou verticaux et ponctuels en plan, en section ou en profil utilisés dans le cadre d’opérations relatives aux données
d’un fichier de géométrie (fichier ALG).

= Lamention (GEO) est placée devant le type d’élément pour permettre de mieux I'identifier. Par exemple, (GEO) LignRefProj pour définir une ligne de référence projeté d’un alignement
horizontal et/ou vertical.
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(GEO) AccNonPaveBord
(GEO) AccPaveBord
(GEO) Annotation3D
(GEO) BordureBord
(GEO) Emprise

(GEO) FosseCentre
(GEO) FosseDroit

(GEO) FosseGauche
(GEO) GiratoireBord
(GEO) Giratoirellot
(GEO) GiratoireMarq
(GEO) GiratoireRayonExt
(GEO) GiratoireRayonint
(GEO) Glissiere

(GEO) GravierBord
(GEO) Tlot

(GEO) TlotDroit

(GEO) TlotGauche

(GEO) LignRefExist
(GEO) LignRefProj
(GEO) LignRefProj_V1
(GEO) LignRefProj_V2
(GEO) LignRefProj_V3
(GEO) LignRefProj_V4
(GEO) LignRefProj_V5
(GEO) LignRefProj_V6
(GEO) LignRefProj_V7
(GEO) LignRefProj_V8
(GEO) PavageBordExist

48

(GEO) Bord d’accotement non pavé (projeté)
(GEO) Bord d’accotement pavé (projeté)
(GEO) Annotation3D

(GEO) Bord de bordure (projeté)

(GEO) Limite d’emprise (projeté)

(GEO) Centre de fossé (projeté)

(GEO) Bord de fossé droit (projeté)
(GEO) Bord de fossé gauche (projeté)
(GEO) Bordure pour giratoire

(GEO) Tlot pour giratoire

(GEO) Marquage pour giratoire

(GEO) Rayon extérieur de giratoire
(GEO) Rayon intérieur de giratoire
(GEO) Glissiere (projeté)

(GEO) Bord de gravier (projeté)

(GEO) Bord d’flot central ou séparateur
(GEO) Bord d’ilot droit

(GEO) Bord d’ilot gauche

(GEO) Ligne de référence (existant)
(GEO) Ligne de référence (projeté)

(GEO) Ligne de référence (projeté) — Variante 1
(GEO) Ligne de référence (projeté) — Variante 2
(GEO) Ligne de référence (projeté) — Variante 3
(GEO) Ligne de référence (projeté) — Variante 4
(GEOQ) Ligne de référence (projeté) — Variante 5
(GEO) Ligne de référence (projeté) — Variante 6
(GEO) Ligne de référence (projeté) — Variante 7
(GEO) Ligne de référence (projeté) — Variante 8

(GEO) Bord de pavage (existant)

(GEO) PavageBordProj
(GEO) PavageCentreExist
(GEO) PavageCentreProj
(GEO) PointCalculBureau
(GEO) PtCOGO(1:1000)
(GEO) PtCOGO(1:500)
(GEO) PtEvenHor(1:1000)
(GEO) PtEvenHor(1:500)
(GEO) PtEvenTemp
(GEO) PtEvenVert(1:1000)
(GEO) PtEvenVert(1:500)
(GEO) SigMarqSimpCont
(GEO) TalusBas

(GEO) TalusHaut

(GEO) TrottoirBord

(GEO) Tuyau

(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO
(GEO

Bord de pavage (projeté)

Centre de pavage (existant)

Centre de pavage (projeté)

Point calculé au bureau

Point COGO (1:1000)

Point COGO (1:500)

Point événement horizontal (1:1000)
Point événement horizontal (1:500)
Point événement temporaire

Point événement vertical (1:1000)
Point événement vertical (1:500)
Marquage simple continu (projeté)
Bas de talus (projeté)

Haut de talus (projeté)

Bord de trottoir (projeté)

Tuyau (projeté)

—_— e, — . —m —m o e o o o s s - -
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Power InRoads (Conception)

= Les styles pour les composants fermés sont utilisés pour définir le type des composants général d’un gabarit. lls paramétrent I'apparence des lignes et du texte dans la vue en section.
Dans Power InRoads, les styles permettent d’afficher les composants en plan sur des niveaux 3D, ce qui donne un rendu réaliste a la surface proposée.

= Ces styles sont utilisés avec les données d’une librairie de gabarits (/TL) et de fichiers de surfaces (DTM).
= La mention (COMP) est placée devant le type d’élément pour permettre de mieux les identifier. Par exemple, (COMP) BbSurface pour définir un composant formant la couche de béton

bitumineux de surface.

{(COMP) BbSurface

— (COMP) BbBase [cOMP) AccPav
-ﬂ-—ﬂ_ o
- [COMP) AccGra
‘ [COMP) Fond

Sﬂ"*’*\

{COMP) SFond

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif 49

7

T



Power InRoads (Conception)

(COMP) _NonModel
(COMP) AccBét
(COMP) AccGra
(COMP) AccPav
(COMP) Autre

(COMP) BandRug
(COMP) Banqu
(COMP) BbAutre
(COMP) BbBase
(COMP) BbBaselnt
(COMP) BbCorrection
(COMP) BbPlanage
(COMP) BbSurface
(COMP) BétonbDalle
(COMP) Bordure
(COMP) Cl6ture
(COMP) Conduite
(COMP) Déb2eClasseNonRécup
(COMP) Déb2eClasseRécup
(COMP) Drain

(COMP) Eaulour
(COMP) EcranProtec
(COMP) Enrochement
(COMP) Epaulement
(COMP) Fond

(COMP) FondInf
(COMP) FondInfSurRoc
(COMP) FondSurlLarg
(COMP) FondSurRoc
(COMP) Glissiere

50

Composant non modélisable

Composant d’accotement en béton

Composant d’accotement en gravier

Composant d’accotement pavé

Composant autre

Composant pour bandes rugueuses

Composant de banquette

Composant de béton bitumineux autre

Composant de béton bitumineux de base

Composant de béton bitumineux de base intermédiaire
Composant de béton bitumineux pour correction
Composant de béton bitumineux pour planage
Composant de béton bitumineux de surface
Composant de dalle de béton

Composant de bordure

Composant pour cléture

Composant de conduite

Composant de déblai de 2¢ classe Non-Récupérable
Composant de déblai de 2¢ classe Récupérable
Composant de drain

Composant de I'Eau du Jour

Composant d’écran de protection

Composant de protection d’érosion de berges
Composant d’épaulement (sol compactable)
Composant de fondation MG 20

Composant de fondation inférieure MG 56 ou de transition
Composant de fondation inférieure MG 56 ou de transition sur Roc
Composant de surlargeur de fondation MG 20
Composant de fondation MG 20 en condition de roc
Composant glissiere de sécurité
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Power InRoads (Conception)

(COMP) GlissiéreLisse

(COMP) Granul MG20

(COMP) Isolant

(COMP) MarquContinuBlanc
(COMP) MarquContinuitéBlanc
(COMP) MarquContinuitélaune
(COMP) MarquContinuJaune
(COMP) MarqubDiscontinuitéBlanc
(COMP) MarqubDiscontinuitéJaune
(COMP) MarquGuidageBlanc
(COMP) MarquGuidagelaune
(COMP) Muret

(COMP) PavéUni

(COMP) Poutre

(COMP) RembHorsStruct
(COMP) RembPier

(COMP) RocBrisé

(COMP) Sfond

(COMP) SolCompactable
(COMP) SurExc

(COMP) TerVeg

(COMP) TerVeg_D

(COMP) TerVeg_G

(COMP) TerVegTP_D

(COMP) TerVegTP_G

(COMP) Trottoir

(COMP) VoieCyclaBbSurf
(COMP) VoieCyclaFond

(COMP) VoieCyclaGra

(COMP) VoieFer

Composant de lisse pour glissiere

Composant de fondation MG 20

Composant de L’isolant

Composant pour marquage continu blanc

Composant pour marquage de continuité blanc
Composant pour marquage de continuité jaune
Composant pour marquage continu jaune
Composant pour marquage de discontinuité blanc
Composant pour marquage de discontinuité jaune
Composant pour marquage de guidage blanc
Composant pour marquage de guidage jaune
Composant muret

Composant de pavé uni

Composant pour poutre

Composant de remblai hors structure

Composant de remblai en pierre

Composant de roc brisé

Composant de sous-fondation MG 112

Composant de sol compactable

Composant de surépaisseur de sous fondation et/ou transition
Composant pour terre végétale

Composant pour terre végétale

Composant pour terre végétale

Composant pour terre végétale sur terre-plein central
Composant pour terre végétale sur terre-plein central
Composant de trottoir

Composant de béton bitumineux de surface pour voie cyclable
Composant de fondation MG 20 pour voie cyclable
Composant de gravier pour voie cyclable

Composant pour voie ferrée
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Power InRoads (Conception)

= Les styles pour les composants surfaciques sont utilisés pour définir le type des composants ouverts (ex. talus, fossé, etc.) d’un gabarit. Ils parameétrent I'apparence des lignes et du texte
dans la vue en section. lls sont également utilisés pour définir la propriété d’affichage en profil et en section d’une surface. Par exemple, (SURF) Tn pour représenter le terrain naturel.

= Dans Power InRoads, les styles permettent d’afficher les composants en plan sur des niveaux 3D, ce qui donne un rendu réaliste a la surface proposée.
= Ces styles sont utilisés avec les données d’une librairie de gabarits (/TL) et de fichiers de surfaces (DTM).

= La mention (SURF) est placée devant le type d’élément pour permettre de les identifier.

__— (SURF) Talveg
(SURF) Talveg —
//. )

(SURF) Fossé
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Power InRoads (Conception)

(SURF) Argile

(SURF) Autre

(SURF) BbBase

(SURF) BbSurface
(SURF) Berme

(SURF) Déb2eClasseRécup
(SURF) Eaulour

(SURF) EmpierFos
(SURF) Empierrement
(SURF) Engazonnement
(SURF) Engazonnement_D
(SURF) Engazonnement_G
(SURF) FinExe

(SURF) Fond

(SURF) FondExc

(SURF) FondInf

(SURF) Fossé

(SURF) Gabarit

(SURF) Gabarit_V1
(SURF) Gabarit_V2
(SURF) Gabarit_V3
(SURF) Gabarit_V4
(SURF) Gabarit_V5
(SURF) Infra

(SURF) PalierRoc
(SURF) PavExist

(SURF) Pont

(SURF) RocFin

(SURF) Roclni

(SURF) RocSond

(SURF) RocSurf

Couche d’argile

Couche autre

Couche de béton bitumineux de base
Couche de béton bitumineux de surface
Couche pour berme

Surface de déblai de 2° classe Récupérable
Surface d’eau du jour

Couche pour empierrement de fossé
Symbologie pour Surface de protection d’érosion de ponceaux/fossés
Engazonnement

Engazonnement

Engazonnement

Couche exécutée finale

Couche de 53oundation MG 20

Couche de 53oundation excavée
Couche de fondation inférieure MG 56 ou de transition
Couche pour fossé

Couche du gabarit

Couche du gabarit — Variante 1

Couche du gabarit — Variante 2

Couche du gabarit — Variante 3

Couche du gabarit - Variante 4

Couche du gabarit — Variante 5

Couche d’infrastructure

Couche pour palier de roc

Couche de pavage existant

Surface de pont

Couche de roc final

Couche de roc initial

Couche de roc sondé

Couche de roc en surface
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(SURF) RocThéo
(SURF) SectTrans
(SURF) Sfond
(SURF) SolDec
(SURF) SolGel
(SURF) SoINGel
(SURF) Surcharge
(SURF) SurExc

(SURF) SurflnitChargRed

(SURF) TalusEmpier
(SURF) TalusGra
(SURF) TalusRoc
(SURF) TalusVeg
(SURF) TerVeg
(SURF) Tn
(SURF) TnAero
(SURF) TnConv
(SURF) TnMNA
(SURF) TnMobile
(SURF) TnPhoto
(SURF) TnTQC

Couche de roc théorique

Sections transversales

Couche de sous-fondation MG 112

Couche de sol décapé

Couche de sol gélif

Couche de sol non gélif

Couche pour surchage 600mm au-dessus du revétement final
Couche en surépaisseur de sous fondation et/ou transition
Couche pour surface initiale en charge réduite 900mm
Couche pour empierrement de talus

Couche pour talus en gravier

Couche pour talus pour roc

Couche pour talus en végétation

Couche de terre végétale

Couche de terrain naturel

Couche de terrain naturel par relevé LIDAR aéroporté
Couche de terrain naturel par relevé conventionnel

Couche de terrain naturel d’'un modéle numérique altimétrique
Couche de terrain naturel par relevé LIDAR mobile

Couche de terrain naturel d’un relevé de photogrammeétrie
Couche de terrain naturel d’un relevé tel que construit
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Power InRoads (Conception)

= Les styles pour les éléments proposés sont utilisés pour définir les styles des points d’un gabarit. Antérieurement, ces styles étaient appelés Transition Control Point (TC). lls paramétrent
I"apparence des lignes et du texte dans la vue en plan et profil ainsi que les symboles dans la vue en section. lls sont utilisés avec les données d’une librairie de gabarits (/TL) et de fichiers
de surfaces (DTM).

= Une lettre majuscule suivie de lettres minuscules identifie ces styles. Par exemple, Rive pour définir un style de point représentant une ligne de marquage simple continu.

Centerline )
=H-entering F?rvei et V:Fav
entering Rive f - o3
Chey + gar
hay JFond
'F:enfﬂﬂfne
s FChay
.pFund
.p:enterline
.Iﬁhe\.r
_anra _F—HTH
o
—-I'J
&
&

Fosint == o 0SExt
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Power InRoads (Conception)

AccGra
AccPav

Arr

Arrint
Banqu
Berme

Bord
BordArr
BordHaut
BtTn
Centerline
Chev

CL

Conduite
ConduiteExi
ConduitePerpExi
ConduitePerpPro
Divers

Fond
Fondinf
FosCL_D
FosCL_G
FosExt
Fosint
FosTP_CL
Glis_D
Glis_G
GlisAci_D
GlisAci_G
GlisAciExi_D
GlisAciExi_G
GlisExi_D

(TC) Bord d’accotement en gravier

(TC) Bord d’accotement pavé

(TC) Bord d’arrondi

(TC) Bord intérieur d’arrondi

(TC) Bande engazonnée

(TC) Dégagement du roc sur 3m

(TC) Bordure

(TC) Arriére de bordure

(TC) Haut de bordure

(TC) Bas de talus de remblai (sans fossé)

(TC) Centerline

(TC) Cheville (limite d’application du dévers)

(TC) Ligne de centre

(TC) Conduite

(TC) Conduite existante

(TC) Conduite perpendiculaire existante

(TC) Conduite perpendiculaire proposée

(TC) Divers (pour les éléments proposés non catégorisés)
(TC) Rencontre entre surface Fondation et Gabarit

(TC) Rencontre entre surface Fondation inférieure et Gabarit
(TC) Centre du fossé droit

(TC) Centre du fossé gauche

(TC) Bord extérieur de fossé

(TC) Bord intérieur de fossé

(TC) Centre de fossé du terre-plein

(TC) Glissiére, tout type (Defaut=Profilé sur poteaux de bois)
(TC) Glissiére, tout type (Defaut=Profilé sur poteaux de bois)
(TC) Glissiére profilé sur poteaux d'acier, coté droit

(TC) Glissiére profilé sur poteaux d'acier, cété gauche

(TC) Glissiere profilé sur poteaux d'acier existante, cété droit
(TC) Glissiere profilé sur poteaux d'acier existante, c6té gauche

(TC) Glissiére existante, tout type (Défaut=Profilé sur poteaux de bois), c6té droit
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Power InRoads (Conception)

GlisExi_G
GlisNJ
GlisNJ-1F_D
GlisNJ-1F_G
GlisNJ-2F
HtArg
HtAutr
HtRoc

HtTn
HtTn-Inv
Infra

Marqu
Muret
Palier
Parapet
Pav
PisteCyc
Pont
RegExtExi
RegExtPro
RegIntExi
RegintPro
Rive

RtTn
RtTn-Inv
ServitudeExi
ServitudePro
Sfond
SurExc
TerVeg
TraitScie
Trans

Trot

56

(TC) Glissiere existante, tout type (Défaut=Profilé sur poteaux de bois), coté gauche

(TC) Glissiere rigide en béton (New Jersey)

(TC) Glissiere rigide en béton (New Jersey), coté droit

(TC) Glissiére rigide en béton (New Jersey), coté gauche

(TC) Glissiere rigide en béton (New Jersey), 2 faces
(TC) Haut de talus extérieur (rencontre de I'argile)
(TC) Haut de talus (autre)

(TC) Haut de talus (rencontre du roc)

(TC) Haut de talus de déblai

(TC) Haut de talus de déblai — style de trait inversé
(TC) Rencontre surface Infra et Gabarit

(TC) Ligne de Marquage

(TC) Muret

(TC) Palier de roc

(TC) Parapet sur structure

(TC) Bord de pavage

(TC) Piste cyclable

(TC) Pont

(TC) Parois extérieure de regard existant

(TC) Parois extérieure de regard proposé

(TC) Parois intérieure de regard existant

(TC) Parois intérieure de regard proposé

(TC) Ligne de Rive

(TC) Retour au terrain naturel

(TC) Retour au terrain naturel — style de trait inversé
(TC) Limite de servitude existante

(TC) Limite de servitude projetée

(TC) Sous-fondation

(TC) SurExcavation

(TC) Terre végétale

(TC) Trait de scie en plan

(TC) Transition

(TC) Trottoir
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Power InRoads (Conception)

TrotArr (TC) Arriére de trottoir
TrotHaut (TC) Haut de trottoir
Unc (TC) Uncontroled
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Power InRoads (Conception)

Les styles pour les éléments existants sont utilisés pour définir les styles des Features d’une surface. lls paraméetrent I'lapparence des lignes, des symboles et du texte dans la vue en plan,
en profil ou en section. lls sont utilisés avec les fichiers de surfaces (DTM).

= Trois lettres majuscules relatives au Pcode du Ministere définissent la nomenclature. Par exemple, POA pour définir un point coté altimétrique.

Randoms Breaklines
Point coté altimétrique
(POA) Bas de talus
(TAB)
Borne-fontaine Puisard circulaire | Haut de talus
(BOF) (PUC) : "7 (TAH)
Centre de pavage
Regard d'égout pluvial (PAC)
(REP)
Interiors
Contours
Eaux du jour
(EA))
Batiment divers
: (BAT)
Exterior

Frontiére de modélisation extérieure
(FME)
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Power InRoads (Conception)

ABA
ABR
ALA
ALP
ALR
ANB
APB
ARB
ARC
ARF
AVF
BAA
BAC
BAG
BAI
BAL
BAR
BAS
BAT
BBT
BCO
BEM
BIM
BIN
BJE
BJT
BOD
BOF
BOL
BOP
BOR

Abri d’auto

Abribus

Alignement d’arbres

Arbre/ligne plaquée

Alignement de roches

Bord d’accotement non pavé

Bord d’accotement pavé

Arbuste

Arbre conifere

Arbre feuillu

Aiguillage de voie ferrée

Batiment agricole

Batiment commercial

Barrage

Batiment industriel

Balise témoin de point géodésique
Batiment résidentiel

Batiment secondaire (autres)
Batiments divers

Bord de toiture

Batiment en construction

Banc d’emprunt

Borne d’injection de mousse carbonique
Batiment institutionnel

Boite de jonction / distribution électrique
Boite de jonction/distribution téléphonique
Boucle de détection
Borne-fontaine

Limite de boisé

Boite postale

Bord de bordure
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Power InRoads (Conception)

BPN Barriére de passage a niveau

BPR Borne de protection

BRE Batiment religieux

BRG Bande rugueuse

BRR Barriére de cloture (tous types)
BRS Bouche de réservoir souterrain
BRU Batiment en ruine

BUS Buse (extrémité de ponceau levé a sa partie supérieure)
CAM Caméra-vidéo

CAN Caniveau

CAT Cabine téléphonique

cc Code de contréle Vision

CEA Cable électrique aérien

CEC Centre de cours d’eau

CHE Champ d’épuration

CHP Changement de pente

CLI Limite de culture

CLM Cléture a mailles serrées

CLO Cloture (autre qu’a mailles serrées)
CLU Clou

CMR Compteur

CPA Changement de pente approximatif (photo : imprécision en élévation < 1 m)
CPH Controle photo horizontal

CPK Clou p.k.

CPT Controle photo tridimensionnel
CPV Contréle photo vertical

CTA Cable télécommunication aérien
CTR Capteur

CUL Culée de pont, de pont d’étagement, de passerelle
DAB Dalle de béton

DAL Dalot de drainage

DC Code de contréle Vision
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Power InRoads (Conception)

DEB Débarcadere

DEC Décrochement de terrain

DI Code de contréle Vision

DIV Divers

DRA Drainage agricole (drain filtre)

DTR Détecteur

EAE Eaux extrémes

EAJ Eaux du jour

ECG Entrée, chemin privé en gravier

ECP Entrée, chemin privé pavé

ELD Elément décoratif (statue, fontaine, rocaille)
EMP Empilement (éboulis, matériaux, etc.)

ENB Eaux normales basses

ENH Eaux normales hautes

EPR Empierrement anti-érosion

ESC Escalier

FC Code de controle Vision

FF Code de contréle Vision

FIN Ligne de fondation inférieure / couche de transition, tel que construit
FME Frontiere de modélisation extérieure

FMI Frontiere de modélisation intérieure (aire non modélisable)
FND Ligne de fondation ou fondation supérieure, tel que construit
FOB Bord de fossé (limite d’excavation)

FOC Centre de fossé

FOE Foyer extérieur

FOF Fond de fossé

FON Fondation de batiment

FOP Fosse a purin

FOS Fosse septique

FPP Fit de panneau publicitaire

FPS FOt de panneau de petite signalisation

FR Code de controle Vision
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Power InRoads (Conception)

FSA
FSL
GA
GAL
GAZ
GBD
GBU
GCA
GCB
GDC
GDF
GNI
GRB
GRC
GTA
GTB
GTU
HAC
HAU
INF
IPE
IPN
JC
IJNT
JP
LAC
LAD
LAH
LAL
LAM
LAP
LAS
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FOt de supersignalisation aérienne

Fit de supersignalisation latérale

Code de contréle Vision

Galerie

Gazoduc

Glissiére de béton a deux faces (centre)
Glissiére de béton a une face (bas)
Glissiere en cables, poteau d’acier (face)
Glissiére en cables, poteau de bois (face)
Glissiere a 2 cables, poteau d’acier
Glissiére a deux faces en tole ondulée, poteau d’acier
Glissiere de type non identifié (face)
Bord de gravier

Centre de gravier

Glissiére en tole, poteau d’acier
Glissiere en téle, poteau de bois
Glissiére en tube d’acier, poteau d’acier (face)
Centre de haie

Hauban

Ligne d’infrastructure, tel que construit
flot pour pompe a essence

Indicateur de passage a niveau

Code de controle Vision

Joint de dilatation

Code de controle Vision

Feux clignotants

Unité d’éclairage double

Feux horizontaux

Feux avec lampadaire

Unité d’éclairage multiple (haut-mat)
Lampadaire de promenade

Unité d’éclairage simple
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Power InRoads (Conception)

LAV Feux verticaux

LIR Ligne de référence, de centre, d’opération, etc.

LPI Feux pour piétons

LPN Feux de passage a niveau

LPO Lampadaire a potence (sur poteau de bois sans services publics)
MAA Massif d’ancrage (base de béton)

MAC Marquage simple continu / ligne de rive

MAD Marquage axial simple discontinu

MAG Marquage de guidage

MAP Mur d’aménagement paysager, écran acoustique, etc.

MAR Bord de marécage

MCO Marquage de continuité

MDC Marquage axial double continu
MDM Marquage axial double mixte
MGR Marque gravée

MOC Monument commémoratif

MOD Monument délimitatif

MPI Fléche directionnelle sur chaussée (symbole)
MTI Massif de tirage

MUM Axe de mur mitoyen
MUR Mur de téte de ponceau

MUS Mur de souténement

MVR Marquage de voie réservée

NO Code de contréle Vision (pas pour Multi-Carnet+)
Nz Code de controle Vision

0cCC Limite d’occupation

OLE Oléoduc

PAA Point coté altimétrique approximatif (photo : imprécision en élévation < 1 m)
PAB Bord de pavage (béton ou asphalte)

PAC Centre de pavage

PAE Palier limite extérieur

PAI Palier limite intérieur
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PAN
PAR
PAS
PAT
PBA
PCB
PCC
PCR
PCT
PDR
PEL
PEP
PET
PHA
PHT
PIB
PIC
PIL
PL
PLL
PLR
PLT
PNI
POA
POB
POE
POG
PON
POT
POU
PRG
PRO
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Bord de panneau de signalisation (routiére et autres)
Parapet sur structure

Passerelle (tablier)

Patio/terrasse

Ponceau rectangulaire en béton armé
Point calculé dans le bureau

Point calculé pour le cadastre

Piscine creusée

Point calculé sur le terrain
Prédécoupage roc

Poteau, électricité, lampadaire

Piece d’extrémité de ponceau
Poteau, électricité, téléphone

Phare

Piscine hors terre

Piquet de bois (repére)

Piquet de cl6ture

Pilier ou fat

Code de controle Vision

Limite de plantation

Poteau, électricité, téléphone, lampadaire, transformateur

Poteau, électricité, lampadaire, transformateur
Poteau non-identifié (levé photo)
Point coté altimétrique

Point coté bathymétrique
Poteau, électricité

Poteau guide

Pont (tablier)

Poteau, téléphone

Poteau utilitaire

Puisard rectangulaire 450 x 900
Prolongement
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PRP Puisard rectangulaire 350 x 600

PRR Puisard / regard fond

PTE Dessous des poutres

PTL Poteau, électricité, téléphone, lampadaire
PTR Poteau, électricité, transformateur

PTT Poteau, électricité, téléphone, transformateur
PUC Puisard circulaire

PUI Puits

PUV Puits de ventilation

PYL Massif d’ancrage de pylone électrique

QUA Quai

RAI Repeére altimétrique intégré (SCOPQ)

RAL Repere altimétrique

RAP Repeére d’arpentage primitif

RAQ Regard d’aqueduc

RAT Repeére d’arpentage trouvé

RBI Rail (bord intérieur)

RCE Repeére de cable électrique souterrain

RCS Repere de cheminement (station)

RCT Repére de cable de télécommunication souterrain
RE Code de contréle Vision

REB Dessous de revétement de base, tel que construit
REC Regard d’égout combiné

REE Regard de chambre électrique souterraine
REG Regard de service public non-identifié

REO Repere d’oléoduc

REP Regard d’égout pluvial

RER Dessous de revétement de roulement, tel que construit
RES Regard d’égout sanitaire

RET Regard de chambre téléphonique souterraine
REV Limite de réservoir

RGA Regard de gazoduc

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Conception)

RGI Repere géodésique intégré (SCOPQ)
RGN Repére GPS, non intégré
RGZ Repere de gazoduc
RIP Repeére identifié planté
RO Code de contrdle Vision
ROC Limite de roc en surface
ROF Roc final, tel que construit
ROI Roc initial
ROS Roc en surface
RPU Regard-puisard
SAV Savane
SEF Surface de conception finale, tel que construit
SEM Semelle
SFO Ligne de sous-fondation, tel que construit
SOF Sol final, tel que construit
SOl Sol initial
SON Sondage géotechnique
SPR Sous-profil, tel que construit
TAB Bas de talus
TAH Haut de talus
TBA Tuyau en béton armé
TES Transformateur de ligne électrique souterraine
TIF Tige de fer
TNA Terrain naturel a jour
TOU Tour, antenne, autres
TRO Bord de trottoir
TTO Tuyau en téle ondulée
TTP Tuyau en thermoplastique
TUF Tuyau de fer
TVG Terre végétale
VAQ Valve d’aqueduc
VFC Voie ferrée (centre)
66
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Les styles matériaux sont utilisés pour remplacer les styles (COMP) et (SURF) afin de spécifier le matériel exact d’'un composant. Ceci permet de générer des rapports de structure de
chaussée comportant des entétes de matériaux spécifiques plutot que général. Ceci permet de faciliter la compréhension des rapports. Par exemple, utiliser un matériau (MAT) ESG-10
au lieu de (COMP) BbSurf pour spécifier le type d’enrobé bitumineux.

(MAT)ESG-10

I (MAT) GB-20 (MAT)ESG-10
— - MAT] MG-20
‘ {(MAT) MG-20

ST

(MAT) MG-112
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(MAT) EC-10
(MAT) EC-5
(MAT) ECF
(MAT) EG-10
(MAT) EGA-10
(MAT) EGM-10
(MAT) Empier Type X
(MAT) Enroch Cal X
(MAT) ESG-10
(MAT) ESG-14
(MAT) ESG-5
(MAT) GB-20
(MAT) MG-112
(MAT) MG-20
(MAT) MG-20b
(MAT) MG-56
(MAT) MR1
(MAT) MR2
(MAT) MR3
(MAT) MR4
(MAT) MR5
(MAT) SMA-10
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Matériau de béton bitumineux autre

Matériau de béton bitumineux autre

Matériau de béton bitumineux de surface

Matériau de béton bitumineux de surface

Matériau de béton bitumineux de surface

Matériau de béton bitumineux de surface

Symbologie pour Surface de protection d’érosion de ponceaux/fossés de type X
Matériau de protection d’érosion de berges de calibre X
Matériau de béton bitumineux de surface

Matériau de béton bitumineux autre

Matériau de béton bitumineux de base

Matériau de béton bitumineux de base

Matériau de sous-fondation MG 112

Matériau de fondation MG 20

Matériau de fondation MG 20b

Matériau de fondation inférieure MG 56 ou de transition
Matériau recyclé de sous-fondation de type 1

Matériau recyclé de sous-fondation de type 2

Matériau recyclé de sous-fondation de type 3

Matériau recyclé de sous-fondation de type 4

Matériau recyclé de sous-fondation de type 5

Matériau de béton bitumineux de surface
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Ces symbologies sont utilisées pour définir les propriétés du texte et des lignes, des annotations du menu Drafting. Elles sont présentes dans le fichier DratingMTQ20189.dft.

H Place Plan Mote EII =] I@
File Edit
Horizontal Alignment: [Default -]ﬂ [ Pply I B Settings =] = ==
Surface: -
Ees [Default I Placement Maode: B v] [ 0K ]
Note File: R e~
5424 Plan 1500 - TEEEE 1475959.520 [ cencel |
o Scale By: 1.0000000 el
[Z] Ch_Off_EL{BlémGraphique) Format -
] Ch_Off_EL{BlémSurfacs) =| Dynamics )
m Chainage [] Rotate

] Coord_Ch'XZ (BlémGraphigus) )
™| Coord_ChYXZ (BlémSurface) Lenziray
; m Coord_YX [ Scale

"] Note (Fleche) S

guation Name

| - " s 7] Muttiple Leaders
- MNamed Symbalogy
iz Text: [{DRAFT) PlanProfi (1:500) -]
T "
Cohﬁ':‘{%?g%} = Fem [{DRAFT) PlanFrofil (1:500) -] :l
@ e | (DRAFT) PlanProfi (1:500) -] jﬂ
BEEE I (DRAFT) PlanProfil (1:500) |
L (]
1 b E] [:] E] Frame Size
- Shape: @ Auto
ol ] o] -
Inserts J J J ﬂ ﬁ 5 Fixed
- Computed Values P
Storm and Sanitary Structures i
i User Text 0.00
Leader Attachment
T © e
Teminator. Filed - Floating
Sort User Text

(DRAFT) PlanProfil (1:1000) Symbologie pour annotations sous le menu « DRAFTING »
(DRAFT) PlanProfil (1:500) Symbologie pour annotations sous le menu « DRAFTING »

(DRAFT) Section (1:100) Symbologie pour annotations sous le menu « DRAFTING »
(DRAFT) Section (1:200) Symbologie pour annotations sous le menu « DRAFTING »
(DRAFT) Temp Symbologie pour annotations sous le menu « DRAFTING »
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Fichier de gabarits GabMTQ2019.ITL

ITL (InRoads Template Library) représente une bibliothéque de gabarits (profils en travers types). Elle est utilisée dans Power InRoads a I'aide des outils Modeler > Create Template et Modeler >
Roadway Designer.

Cette bibliothéque ne prétend pas répondre a tous les besoins pour la modélisation de chaussée au Ministere. Il s’agit plutét d’'une base sur laquelle I'usager pourra utiliser et qu’il devra éditer
afin d’obtenir les caractéristiques de chaussées voulues et adapter selon des conditions de terrain plus variées.

Les gabarits proposés dans cette bibliotheque peuvent ne pas refléter exactement les normes de conception ou de construction en vigueur. lls sont plutot issus de compromis visant a concilier
ces normes avec la simplicité d’exécution compte tenu du mode de fonctionnement du logiciel de conception Power InRoads.

La structure de la bibliotheque est composée de catégories dans lesquelles sont contenus des gabarits (Template) regroupés par thématique :

= composants, définissant des matériaux ou des éléments surfaciques de chaussée ;
= conditions de raccordement, définissant des parametres de conditions de raccordement au sol ;
= profils en travers, définissant des profils en travers typiques constitués d’agencement entre des composants et des conditions de raccordement.

Template Library:
5 H:\BertleyNome 2015 Preferences GabMTMDET2015 4
EE Point Mame List
[ Composants
[ Conditions de raccordement

] Prfis n ravers

Chaque catégorie comporte des sous-catégories pour préciser soit le milieu d’affectation (rural ou urbain) ou le type d’élément (bordures, ouvrages d’art, etc.).
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On entend par le terme «bordures», tout élément représentant un muret adjacent a une voie de circulation ou a un accotement. Ceci inclut les trottoirs, les flots et les terre-pleins.
= Les gabarits de cette catégorie se positionnent généralement en correspondance avec le point AccPav.

= Puisqu’il s’agit des modeles spécifiques, les bordures ne possedent pas de contraintes paramétriques. Utilisez plut6t les gabarits Bordure (D) ou Bordure (G) de la sous-catégorie
Structure de chaussée — Rural pour modifier soit la hauteur (HautBord) et la largeur (LargBord) d’une bordure. Ces derniers possedent également un composant représentant le calcul du
remblai en arriére de la bordure.

=  Pour les gabarits représentant des trottoirs bordures ou monolithiques les contraintes paramétriques sont :
o épaisTrot, définissant I'épaisseur de la dalle du trottoir ;
o hautBord, définissant la hauteur du trottoir par rapport a I'accotement pavé (point AccPav) ;

o largTrot, définissant la largeur du trottoir.

TrotArr_D

BordHaut D BordArr_D

rotArrBas D

ccPay D TrolAued —  ——————

ordBas D ordArrBas_D.
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Abaissée Avec Acces (D)
Abaissée Avec Acces (G)
Abaissée Préfab (D)
Abaissée Préfab (G)
Abaissée Sans Acces (D)
Abaissée Sans Acces (G)
Arasée (D)

Arasée (G)

Arasée Préfab (D)
Arasée Préfab (G)
Bordure (Param) (D)

Bordure (Param) (D)

Caniveau (D)
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Bordure abaissée moulée ou coulée en béton droite
Bordure abaissée moulée ou coulée en béton gauche
Bordure abaissée préfabriquée en béton droite
Bordure abaissée préfabriquée en béton gauche
Bordure abaissée moulée ou coulée en béton droite
Bordure abaissée moulée ou coulée en béton gauche
Bordure arasée moulée ou coulée en béton droite
Bordure arasée moulée ou coulée en béton gauche
Bordure arasée préfabriquée en béton droite
Bordure arasée préfabriquée en béton gauche
Bordure 100mm de hauteur

= |e point d’insertion est AccPav_D.

= converger le point Arr_D1 ( ) du composant avec le point Arr_D du gabarit.
= contraintes paramétriques :

o hautBord D, larégle Bord D permet de faire apparaitre la bordure si la valeur de la
contrainte est supérieure a 0 ;

o penteBanquBordure D, détermine la pente de la banquette en arriére de la bordure.

Bordure 100mm de hauteur
= e point d’insertion est AccPav_G.
= converger le point Arr_ G1 ( ) du composant avec le point Arr_G du gabarit.
=  contraintes paramétriques :

o hautBord G, larégle Bord G permet de faire apparaitre la bordure si la valeur de la
contrainte est supérieure a0 ;

o penteBanquBordure G, détermine la pente de la banquette en arriere de la bordure.

Caniveau en béton droit
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Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.

4 - DN002, DNOO3
4 - DNO02, DNOO4
4 - DNOO1

4 -DNOO1

4 - DN0O02, DNOO3
4 - DN002, DNOO3
4 - DN0O02, DNOO3
4 - DN002, DNOO3

4 - DNOO1
4 -DNOO01
4 — DNOO6
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Caniveau (G)

Enrobée (D)

Enrobée (G)

Surélevée (D)

Surélevée (G)

Surélevée Préfab (D)
Surélevée Préfab (G)

Trottoir Bordure Contigus (D)
Trottoir Bordure Contigus (G)
Trottoir Monolithique (D)
Trottoir Monolthique (G)

Caniveau en béton gauche

Bordure en enrobée droite

Bordure en enrobée gauche

Bordure surélevée moulée ou coulée en béton droite
Bordure surélevée moulée ou coulée en béton gauche
Bordure surélevée préfabriquée en béton droite
Bordure surélevée préfabriquée en béton gauche
Trottoir et bordure contigus droits

Trottoir et bordure contigus gauches

Trottoir et bordure monolithiques droits

Trottoir et bordure monolithiques gauches
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Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.
Tome 2 — Chap.

4 — DN0OO6
4 — DNOO5
4 — DNOO5
4 — DNO0O2, DNOO3

4 — DN002, DNOO3

4 — DNOO1
4 - DNOO1
6 — DNOO5
6 — DNO0O05
6 — DN00O4
6 — DN00O4
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On entend par le terme «dispositifs de retenue», tout élément représentant des dispositifs de retenue latéraux, frontaux, de chantier. On y retrouve principalement les glissieres de sécurité
rigides (Jerseys), semi-rigides ou flexibles.

= Les noms techniques des détails normalisés (DN) ont été utilisés pour la nomenclature des gabarits de cette catégorie.
= Les gabarits de glissiere de sécurité rigide commencant par BC, se positionnent en correspondance avec le point AccPav.

= Les gabarits de glissiére de sécurité rigide médiane commencant par V/BC, s’insérent entre deux chaussées. En dessous de la glissiére, on retrouve la structure de chaussée venant
s’agencer avec les épaisseurs de chaussées droite et gauche normalisées.

= Le point Glis sert de point d’insertion pour les gabarits représentant des glissieres semi-rigides et flexibles a I’exception de ceux avec la mention (Param).

= La mention (Param) a la fin d’'un nom de gabarit indique que celui-ci contient une regle associée a une contrainte paramétrique (DégagGlis) qui fait en sorte que lorsque la valeur est
définie a 0, la glissiére de sécurité semi-rigide ne sera pas affichée. Une valeur plus grande (droite) ou plus petite (gauche) que 0 permettra de faire apparaitre une glissiere. Ceci permet
de gérer les endroits ol I'on désire afficher une glissiére en conservant le méme gabarit. Le point d’insertion est le point AccPav.

= Pour les gabarits semi-rigides et flexibles, seul le composant représentant la lisse est modélisé. Le poteau et I'écarteur sont sur le style (COMP) NonModel.

= Le point Glisimpl sert de point de référence pour I'implantation de la hauteur de glissiere en chantier. La hauteur par défaut est établie a 0,555m par rapport au point Glis et elle peut
étre modifiée par la contrainte paramétrique HautGlisImpl. La distance est variable selon le type de poteau et peut étre par la contrainte paramétrique Glis/mpl.

BC/1070-240 (D) Glissiere rigide latérale en béton droite Tome 8 — Chap. 3 - DN GR 001
Hauteur de 1070 mm, Largeur du dessus 240 mm

BC/1070-240 (G) Glissiere rigide latérale en béton gauche Tome 8 — Chap. 3— DN GR 001
Hauteur de 1070 mm, Largeur du dessus 240 mm

BC/810-190 (D) Glissiere rigide latérale en béton droite Tome 8 — Chap. 3— DN GR 001
Hauteur de 810 mm, Largeur du dessus 190 mm
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BC/810-190 (G)

M-BC/1070-305

M-BC/1070-380

M-BC/810-230

M-BC/810-380

glissiere rigide latérale en béton gauche
Hauteur de 810 mm, Largeur du dessus 190 mm

glissiére rigide médiane en béton
hauteur de 1070 mm, Largeur du dessus 305 mm

glissiére rigide médiane en béton
hauteur de 1070 mm, Largeur du dessus 380 mm

glissiere rigide médiane en béton
hauteur de 810 mm, Largeur du dessus 230 mm

glissiere rigide médiane en béton
hauteur de 810 mm, Largeur du dessus 380 mm
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Tome 8 — Chap. 3—- DN GR 001

Tome 8 — Chap. 3—- DN GR 003A

Tome 8 — Chap. 3—-DN GR 003A

Tome 8 — Chap. 3— DN GR 002A

Tome 8 — Chap. 3—-DN GR 002A
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M-W/BE/1905

W/A/3810 (D)

W/A/3810 (G)

W/AE/1905 (D)
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glissieére semi-rigide médiane avec profilé d’acier a double ondulation sur
poteaux de bois (1905 mm d’espacement)

glissiere flexible droite avec profilé d’acier a double ondulation sur
poteaux d’acier (3810 mm d’espacement)

glissiere flexible gauche avec profilé d’acier a double ondulation sur
poteaux d’acier (3810 mm d’espacement)

glissiere semi-rigide droite avec profilé d’acier a double ondulation sur
poteaux d’acier (1905 mm d’espacement)

Tome 8 — Chap. 3 — DN GSR 007

Tome 8 — Chap. 3 - DN GF 009

Tome 8 — Chap. 3 — DN GF 009

Tome 8 — Chap. 3—DN GSR 003

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Conception)

W/AE/1905 (G)

W/BE/1905 (D)

W/BE/1905 (G)

W/BE/1905 (Param) (D)

glissieére semi-rigide gauche avec profilé d’acier a double ondulation sur
poteaux d’acier (1905 mm d’espacement)

glissiere semi-rigide droite avec profilé d’acier a double ondulation sur
poteaux de bois (1905 mm d’espacement)

glissieére semi-rigide gauche avec profilé d’acier a double ondulation sur
poteaux de bois (1905 mm d’espacement)

glissiere semi-rigide droite avec profilé d’acier a double ondulation sur
poteaux de bois (1905 mm d’espacement)
= contrainte paramétrique pour I'affichage (DégagGlis D > 0)
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Tome 8 — Chap. 3 - DN GSR 003

Tome 8 — Chap. 3 - DN GSR 001

Tome 8 — Chap. 3 - DN GSR 001

Tome 8 — Chap. 3 - DN GSR 001
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Nom Description Référence(s) Image(s)
W/BE/1905 (Param) (G) glissiere semi-rigide gauche avec profilé d’acier a double ondulation sur Tome 8 — Chap. 3 — DN GSR 001
poteaux de bois (1905 mm d’espacement) j
= contrainte paramétrique pour I'affichage (DégagGlis G <0)
I
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On entend par le terme «divers» tout élément qui n’est pas catégorisé. On peut retrouver entre autres des éléments naturels, des éléments de repéres, des dispositifs d’alerte ou des gabarits

expliquant des méthodes de travail.

Banc de neige (D)

Banc de neige (G)

Bandes rugueuses (D)

Bandes rugueuses (G)

Banc de neige droit servant a la simulation
d’un obstacle en marge de I’'accotement
pour valider les distances de visibilités d’un
corridor de chaussée

Banc de neige gauche servant a la
simulation d’un obstacle en marge de
I"accotement pour valider les distances de
visibilités d’un corridor de chaussée

Bandes rugueuses droites placées dans
I’accotement servant a attirer I'attention du
conducteur quittant partiellement la voie
par des vibrations inconfortables et
bruyantes

Bandes rugueuses gauches placées dans
I’accotement servant a attirer I'attention du
conducteur quittant partiellement la voie
par des vibrations inconfortables et
bruyantes
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Contraintes paramétriques pour la hauteur
(HautBancNeige D) et la largeur du dessus
(LargBancNeige D).

Contraintes paramétriques pour la hauteur
(HautBancNeige G) et la largeur du dessus
(LargBancNeige _G).

L'insertion du composant s’effectue sur le
point Rive_D.

L'insertion du composant s’effectue sur le
point Rive_G.

Tome 2 — Chap. 10 — DN004

Tome 2 — Chap. 10 - DN004
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Ecran de protection

Isolation polystyréne

80

Ecran anti éblouissement a ailerons L'insertion du composant s’effectue sur le Tome 2 — Chap. 8 - DN012
verticaux dessus d’une glissiere de sécurité rigide
médiane.
Isolation en polystyréne pour le c 3l | CCDG 2016
terrassement en remblai léger e composant sert a iffustrer e 11.7.13.1

canevas pour la mise-en-place de
blocs en polystyréne pour un
remblai léger.

L'insertion du composant s’effectue
sur le point Infra_CL.

Contraintes paramétriques :

o EpaisDalleBéton, détermine
I’épaisseur de la dalle de
béton sous l'infra ;

o Larg, permet de spécifier la
largeur du vide intérieur
pour le chevauchement
d’une route existante ;

o NbRangéeBloc, spécifie le
nombre de rangée de blocs
désirées selon la hauteur
du talus de la route
existante ;

o Prof, ajuste le nombre de
rangée de blocs soit a
gauche ou a droite.
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Nom Description Remarque(s) Référence(s)
Parabole Représentation d’une parabole Ce composant montre comment reproduire
une parabole a partir d’opérations
mathématiques placées aux valeurs de
contraintes.

Piste cyclable (D) Structure pour une piste cyclable droite L'insertion s’effectue sur le point Tome 1 - Chap. 15-P. 22
TrotBordArr_D.

Piste cyclable (G) Structure pour une piste cyclable gauche L'insertion s’effectue sur le point Tome 1—Chap. 15-P. 22
TrotBordArr_D.

Point milieu Composant point milieu Ce composant montre comment trouver un
point milieu a partir d’opérations T
mathématiques placées aux valeurs de
contraintes.
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On entend par le terme «drainage» tout élément relatif au drainage d’une chaussée.

Conduite Centre (D)

Conduite Centre (G)

Conduite Radier (D)

Conduite Radier (G)
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Conduite droite générique
pour tout type

Conduite gauche générique
pour tout type

Conduite droite générique
pour tout type

Conduite gauche générique
pour tout type

L'insertion s’effectue au centre de la conduite.

Une contrainte paramétrique permet de modifier le rayon de la
conduite (RayonConduite_D).

L'insertion s’effectue au centre de la conduite.

Une contrainte paramétrique permet de modifier le rayon de la
conduite (RayonConduite G).

L'insertion s’effectue au radier de la conduite.

Une contrainte paramétrique permet de modifier le rayon de la
conduite (RayonConduite_D).

L'insertion s’effectue au centre de la conduite.

Une contrainte paramétrique permet de modifier le rayon de la
conduite (RayonConduite G).
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Drain (D) Drain droit en tuyau rigide,
semi-rigide, flexible tout type
d’excavation
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Le matériel filtrant représente le matériel entourant le tuyau.

On insere le drain en correspondance avec le point Infra_Infra_D d’un
gabarit. On déplace le point Infra Chev D en correspondance avec le
point du méme nom dans le gabarit. On converge le point par la suite.

Contraintes paramétriques :

o DistRadierBas D, distance verticale entre la base du matériel
filtrant et le radier du tuyau;

o EpaisMatFiltrant D, épaisseur du matériel filtrant en partant

du point Infra_Infra_D,;

o LargMatFiltrant_D, largeur du matériel filtrant en partant du
point ZDrainBas_D. Le tuyau se positionne automatiquement
au centre, a la moitié de cette valeur.

o RayonConduite D, défini le rayon du tuyau ou de la conduite. -

Une regle établit que si la différence de pente entre le point
Infra_Infra_D et Infra_Chev_D est plus grande que 0 % le drain ne
s’affiche pas dans le gabarit.

Tome 2 — Chap. 3 —
DNO004, DN0O5, DN006

9,
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Nom Description Remarque(s) Référence(s) Image(s)
Drain (G) Drain gauche en tuyau rigide, L <riel fil i | friel | Tome 2 — Chap. 3 -
semi-rigide, flexible tout type e matériel filtrant représente le matériel entourant le tuyau. DN004, DN0OS, DNOOG

d’excavation = Oninsére le drain en correspondance avec le point /nfra_Infra_G d’un Q
gabarit. On déplace le point /Infra_Chev G en correspondance avec le
point du méme nom dans le gabarit. On converge le point par la suite.

= Contraintes paramétriques :

o DistRadierBas_G, distance verticale entre la base du matériel
filtrant et le radier du tuyau ;

o EpaisMatFiltrant G, épaisseur du matériel filtrant en partant
du point Infra_Infra_G;

o LargMatFiltrant_G, largeur du matériel filtrant en partant du
point ZDrainBas_G. Le tuyau se positionne automatiquement
au centre, a la moitié de cette valeur.

o RayonConduite G, défini le rayon du tuyau ou de la conduite.

= Une reégle établit que si la différence de pente entre le point
Infra_Infra_G et Infra_Chev_G est plus grande que 0 % le drain ne
s’affiche pas dans le gabarit.
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On entend par le terme «marquage» la représentation de tout type de ligne de marquage de chaussée.
= Les composants représentant les lignes doubles s’insérent en correspondance avec le point CL.

= Les composants représentant les lignes simples s’inserent en correspondance avec les points Rive ou Marqu.

Blanc - Double Continu Ligne blanche de marquage double continu Tome 5 — Chap. 6 — Annexe A—P.15
Blanc - Double Continu-discontinuité Ligne blanche de marquage double continu-discontinuité Tome 5 — Chap. 6 — Annexe A —P.15
Blanc - Double Discontinuité-continu Ligne blanche de marquage double discontinuité-continu Tome 5 — Chap. 6 — Annexe A —P.15
Blanc - Simple Continu Ligne blanche de marquage simple continu Tome 5 — Chap. 6 — Annexe A —P.15
Blanc - Simple Continuité Ligne blanche de marquage simple de continuité Tome 5 — Chap. 6 — Annexe A—P.15
Blanc - Simple Discontinuité Ligne blanche de marquage simple de discontinuité Tome 5 —Chap. 6 — Annexe A—P.15
Blanc - Simple Guidage Ligne blanche de marquage simple de guidage Tome 5 — Chap. 6 — Annexe A—P.15
Jaune - Double Continu Ligne jaune de marquage double continu Tome 5 — Chap. 6 — Annexe A —P.15
Jaune - Double Continu-discontinuité Ligne jaune de marquage double continu-discontinuité Tome 5 — Chap. 6 — Annexe A —P.15
Jaune - Double Discontinuité-continu Ligne jaune de marquage double discontinuité-continu Tome 5 —Chap. 6 — Annexe A—P.15
Jaune - Simple Continu Ligne jaune de marquage simple continu Tome 5 — Chap. 6 — Annexe A —P.15
Jaune - Simple Continuité Ligne jaune de marquage simple de continuité Tome 5 — Chap. 6 — Annexe A —P.15
Jaune - Simple Discontinuité Ligne jaune de marquage simple de discontinuité Tome 5 — Chap. 6 — Annexe A—P.15
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On entend par le terme «ouvrages d’art» les éléments relatifs aux ponts, ponceaux, murs, murets, structures de signalisation, d’éclairage et de signaux lumineux.

Muret (D) Mur en porte-a-faux droit _ ) o Tome 3 — Chap. 5— DN006, DNOO7, DNO08
} . . = Le gabarit montré est a titre indicatif. Par
en béton armé, coulé en

place défaut, en modifiant la hauteur du muret, la
valeur arriére de la semelle est établie a 1.4
fois la valeur de la différence verticale entre
le point MuretHaut_D et MuretBas_D. La
valeur de la semelle avant est de 0.2 fois.

= On devra utiliser les valeurs du tableau
indiqué dans la norme pour les hauteurs,
épaisseurs et largeurs pour définir
précisément les criteres de conception.

= L’insertion du composant s’effectue sur le
point AccPav_D.

= Une contrainte paramétrique permet de
modifier la profondeur du muret par la
différence entre le point AccPav_D et
MuretBas_D (ProfMuret D).

= Une contrainte paramétrique permet de
modifier la largeur du dessus du muret
(LargMuret_D).
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Nom Description Remarque(s)

Muret (G) Mur en porte-a-faux
gauche en béton armé,
coulé en place

Le gabarit montré est a titre indicatif. Par
défaut, en modifiant la hauteur du muret, la
valeur arriere de la semelle est établie a 1.4
fois la valeur de la différence verticale entre
le point MuretHaut G et MuretBas_G. La
valeur de la semelle avant est de 0.2 fois.

On devra utiliser les valeurs du tableau
indiquées dans la norme pour les hauteurs,
épaisseurs et largeurs pour définir
précisément les criteres de conception.

L'insertion du composant s’effectue sur le
point AccPav_G.

Une contrainte paramétrique permet de
modifier la profondeur du muret par la
différence entre le point AccPav G et
MuretBas_G (ProfMuret_G).

Une contrainte paramétrique permet de
modifier la largeur du dessus du muret
(LargMuret_G).

Référence(s)
Tome 3 — Chap. 5 - DNO006, DNOO7, DNO0O8
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Nom

Ponceau rectangulaire

Poutre ACIER

Description

Ponceau rectangulaire en
béton armée (PBA)

Poutre standard en acier

Remarque(s)

L'insertion du ponceau s’effectue a partir du
radier (point CL).

Contraintes paramétriques :

O

EpaisPonceau, détermine I'épaisseur
de la paroi du ponceau;

HautPonceau, établit la hauteur du
ponceau c’est-a-dire la hauteur
intérieure;

LargPortée, parameétre la largeur de
la portée du ponceau, distance
entre les extrémités gauche-droite
de la paroi intérieure.

L'insertion de la poutre s’effectue par le
point Poutre CL.

Contraintes paramétriques :

O

EpaisPoutre, détermine I'épaisseur
de I'acier;

HautPoutre, établit la hauteur de la
poutre;

LargDemiPoutre, détermine la
moitié de la largeur de poutre.

Référence(s) Image(s)
Tome 3 - Chap. 4 — P.2 et DNOO1

Tome 3 - Chap. 2-P.33 )
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Nom Description Remarque(s) Référence(s) Image(s)
Poutre NEBT Poutre standard de type . . , Tome 3 - Chap. 2 - P.32
NEBT = L’insertion de la poutre s’effectue par le [

point Poutre CL.

= Une contrainte paramétrique (HautPoutre)
permet de modifier la hauteur de poutre
selon le type désiré (1000, 1200, 1400, 1600

ou 1800).
= Par défaut, le type NEBT 1600 est
représenté.
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On entend par le terme «structures de chaussée — rural» tout élément en milieu rural représentant les revétements, les accotements, les fondations ou sous-fondations d’un profil en travers
typique.

90

=  Procédure d’agencement pour générer une structure de chaussée :

1.

vk wnN

6.

BbSurf

AccPav (D), AccPav (G)
BbBase

AccGra (D), AccGra (G)
Fond

SFond

= ||l est recommandé de modifier les paramétres de contraintes uniquement lorsque tous les composants seront agencés ensemble.

= Lorsque la structure de chaussée est complétée, on devra s’assurer que les points Fond Fond soient attribués par le parent Rollover pour la contrainte de pente, par rapport au point
Fond_Cheuv.

= Pour le descriptif des contraintes paramétriques, se référer aux profils en travers.

AccGra (D)

AccGra (G)

AccPav (D)

AccPav (G)

BbBase

Accotement en gravier droit L'insertion s’effectue par le point AccPav_D.

%
Accotement en gravier gauche L'insertion s’effectue par le point AccPav_G.

ﬁ
Accotement pavé droit L'insertion s’effectue par le point Rive D. z
Accotement pavé gauche L'insertion s’effectue par le point Rive_G. j

Revétement en béton bitumineux de la couche L'insertion s’effectue par le point BbBase CL.
de base

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Conception)

BbBaselnt

BbSurf

Bordure (D)

Bordure (G)

Fond

FondInf

FondRoc

RembPier

SFond

Revétement en béton bitumineux de la couche
de base intermédiaire (3 couches de pavage)

Revétement en béton bitumineux de la couche
de surface

Bordure générique droite avec remblai hors
structure

Bordure générique gauche avec remblai hors
structure

Fondation

Fondation intérieure

Fondation sur roc

Remblai en pierre

Sous-fondation

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

= L’insertion s’effectue par le point CL a la coordonnée
XY @ 0,0.

= Ce gabarit inclut toutes les couches de revétement
en béton bitumineux ainsi que les accotements
pavés et en gravier.

L'insertion s’effectue par le point CL a la coordonnée XY @
0,0.
L'insertion s’effectue par le point AccPav_D.

L'insertion s’effectue par le point AccPav_G.

L'insertion s’effectue par le point Fond CL.

L'insertion s’effectue par le point Fond CL.

L'insertion s’effectue par le point Fond CL.

L'insertion s’effectue par le point Fond CL.

L'insertion s’effectue par le point SFond CL.

R
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SurExc

Transition Sol-Roc (D)

Transition Sol-Roc (G)

Sur excavation

Composant pour le calcul du paiement de la
ligne SFond-Infra en présence partielle de roc a
droite de la chaussée.

Composant pour le calcul du paiement de la
ligne SFond-Infra en présence partielle de roc a
gauche de la chaussée.

L'insertion s’effectue par le point Infra_CL.

= Voir gabarit Profils en travers > Ruraux - 1ére et 2e
classe > Type B,C,D,E,F - Transition Sol-Roc (D) pour
un exemple d’application.

= Voir gabarit Profils en travers > Ruraux - 1ére et 2e
classe > Type B,C,D,E,F - Transition Sol-Roc (G) pour
un exemple d’application.
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On entend par le terme «structures de chaussée — urbain» tout élément en milieu urbain représentant les revétements, les accotements, les fondations ou sous-fondations d’un profil en travers
typique.
=  Procédure d’agencement pour générer une structure de chaussée :
1. BbSurf
2. AccPav (D), AccPav (G)
3. BbBase
4. AccGra (D), AccGra (G)
5. Fond
6. SFond
= |l est recommandé de modifier les parametres de contraintes uniquement lorsque tous les composants seront agencés ensemble.

= Pour le descriptif des contraintes paramétriques, se référer aux profils en travers.

AccPav (D) Accotement pavé droit L'insertion s’effectue par le point Rive D.
AccPav (G) Accotement pavé gauche L'insertion s’effectue par le point Rive G.
BbBase Revétement en béton bitumineux de la couche de L'insertion s’effectue par le point BbBase CL.
base
BbSurf Revétement en béton bitumineux de la couche de L'insertion s’effectue par le point CL a la coordonnée XY @

surface 0,0. %%
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Nom

Fond + SFond

Description
Fondation et sous-fondation

Remarque(s)
L'insertion s’effectue par le point Fond CL.

Image(s)
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On entend par le terme «rurales» toutes les conditions de raccordement se retrouvant principalement en milieu rural; en situation de drainage a ciel ouvert mais non exclusif.

Berge (D) Berge droite . . . Tome 2 — Chap. 2 - DN0O1
= La berge est le terme utilisé pour définir la distance entre le

haut du talus de déblai du fossé et la limite d’emprise.

= Ce composant sert a déterminer la limite d’emprise
proposée.

= L'insertion s’effectue sur le point HtTn_D.

= Une contrainte paramétrique (LargBerge D) permet de
modifier la largeur de berge désirée.

Berge (G) Berge gauche e o . Tome 2 — Chap. 2 — DN0O1
= La berge est le terme utilisé pour définir la distance entre le

haut du talus de déblai du fossé et la limite d’emprise.

= Ce composant sert a déterminer la limite d’emprise
proposée.

= L’insertion s’effectue sur le point HtTn G.

= Une contrainte paramétrique (LargBerge G) permet de
modifier la largeur de berge désirée.
Condition Complexe Condition de » ) o » . Tome 2 — Chap. 1 — DN025
. N = Cette condition représente une combinaison des conditions suivantes :
Remblai - Déblai (D) raccordement

complexe en remblai et o Talus extérieur avec fossé en remblai;

en déblai droite - , P L
o Talus extérieur avec fossé en déblai; o Talus extérieur avec

fossé de berme;

o Raccordement rapproché au talus extérieur existant
(TalExt2_D);

o Prolongement du fossé pour raccordement rapproché au
terrain naturel ou talus extérieur (FosHor D).
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96

Condition Complexe
Remblai - Déblai (G)

Condition de
raccordement
complexe en remblai et
en déblai gauche

L'insertion s’effectue sur le point Infra_Infra_D.

Le point RtTn_D permet de localiser la rencontre avec la pente de talus
extérieur et le terrain naturel. Ce point peut étre ensuite affiché en
profil pour effectuer I'analyse du drainage du fossé droit.

Contraintes paramétriques :

o

DrainMinInfra_D, détermine la profondeur minimum du
fossé par rapport au point Infra_Infra_D;

HautMaxTalBerme_D, établit une hauteur de talus de berme
pour faire apparaitre un fossé de berme en condition de
remblai;

LargBerme_D, parametre la largeur de berme;
LargDemiFos_D, parametre la largeur de la moitié du fossé;
PenteTalDeb D, détermine la pente de talus de déblai;

PenteTalExtSansFos D, détermine la pente de talus pour le
raccordement rapproché au talus extérieur existant (aucun
fossé affiché);

PenteTalExt D, détermine la pente de talus extérieure.

Cette condition représente une combinaison des conditions suivantes :

(¢]

(0]

Talus extérieur avec fossé en remblai;
Talus extérieur avec fossé en déblai;
Talus extérieur avec fossé de berme;

Raccordement rapproché au talus extérieur existant
(TalExt2_G);

Prolongement du fossé pour raccordement rapproché au
terrain naturel ou talus extérieur (FosHor_G).

L'insertion s’effectue sur le point Infra_Infra_G.

Tome 2 — Chap. 1 - DN025
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Description Remarque(s)

Référence(s)

Le point RtTn_G permet de localiser la rencontre avec la pente de talus
extérieur et le terrain naturel. Ce point peut étre ensuite affiché en
profil pour effectuer I'analyse du drainage du fossé gauche.

= Contraintes paramétriques :

(o]

DrainMininfra_G, détermine la profondeur minimum du
fossé par rapport au point Infra_Infra_G;

HautMaxTalBerme G, établit une hauteur de talus de berme
pour faire apparaitre un fossé de berme en condition de
remblai;

LargBerme_G, parametre la largeur de berme;
LargDemiFos_G, parameétre la largeur de la moitié du fossé;
PenteTalDeb_ G, détermine la pente de talus de déblai;

PenteTalExtSansFos_G, détermine la pente de talus pour le
raccordement rapproché au talus extérieur existant (aucun
fossé affiché);

PenteTalExt_G, détermine la pente de talus extérieure.
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Condition Simple
Remblai - Déblai (D)

98

Condition de
raccordement simple
en remblai et en déblai
droite

Cette condition représente une combinaison des conditions
suivantes :

o Talus extérieur avec fossé en remblai;
o Talus extérieur avec fossé en déblai;
L'insertion s’effectue sur le point Infra_Infra_D.

Le point RtTn_D permet de localiser la rencontre avec la
pente de talus extérieur et le terrain naturel. Ce point peut
étre ensuite affiché en profil pour effectuer I'analyse du
drainage du fossé droit.

Contraintes paramétriques :

o DrainMininfra_D, détermine la profondeur minimum
du fossé par rapport au point /nfra_Infra_D;

o LargDemiFos D, parametre la largeur de la moitié du
fossé;

o PenteTalDeb D, détermine la pente de talus de
déblai;

o PenteTalExt D, détermine la pente de talus
extérieure.

Tome 2 — Chap. 1 — DN025
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Nom Description Remarque(s)
Condition Simple Condition de . , L .
Remblai - Déblai (G) raccordement simple = Ce‘tte condition représente une combinaison des conditions
en remblai et en déblai sulvantes :
gauche o Talus extérieur avec fossé en remblai;

o Talus extérieur avec fossé en déblai;
= Linsertion s’effectue sur le point Infra_Infra_G.

= Le point RtTn_G permet de localiser la rencontre avec la
pente de talus extérieur et le terrain naturel. Ce point peut
étre ensuite affiché en profil pour effectuer I'analyse du
drainage du fossé gauche.

=  Contraintes paramétriques :

o DrainMininfra_G, détermine la profondeur minimum
du fossé par rapport au point Infra_Infra_G;

o LargDemiFos_G, paramétre la largeur de la moitié du
fossé;

o PenteTalDeb G, détermine la pente de talus de
déblai;

o PenteTalExt G, détermine la pente de talus
extérieure.

Référence(s)
Tome 2 — Chap. 1 — DN025

Image(s)
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Coupe Roc (D)

Condition de
raccordement en
présence de roc droite

Cette condition est utilisée principalement au stade de

Tome 2 — Chap. 1 - DNO0O01,

DNO002, DNOO3

conception.

Elle propose I'ajout d’un fossé de créte (Fossé Créte (D)) a la
suite du raccordement au terrain naturel dans le cas ou la
pente naturelle coule en direction du palier de roc et une
pente de talus en remblai pour une direction opposée.

L'insertion s’effectue sur le point FosExt D.

Contraintes paramétriques :

O

DégagFosExt D, détermine le dégagement de la
berme inférieure par rapport au fossé extérieur;

DrainMinFosCréte D, hauteur du talus extérieur du
fossé de créte.

HautPalRoc D, parametre la hauteur du palier de roc
par rapport au fossé extérieur;

LargPalRoc D, détermine la largeur du palier de roc;

PenteBermelnf D, parametre la pente de la berme
inférieure;

PentePalRoc D, parameétre la pente du palier de roc;

PenteTalDeb D, parametre la pente de talus de
déblai;

PenteTalRoc D, paramétre la pente de talus de roc.
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Nom Description Remarque(s)
Coupe Roc (G) Condition de
raccordement en
présence de roc gauche

= Cette condition est utilisée principalement au stade de
conception.

= Elle propose I'ajout d’un fossé de créte (Fossé Créte (G)) ala
suite du raccordement au terrain naturel dans le cas ou la
pente naturelle coule en direction du palier de roc et une
pente de talus en remblai pour une direction opposée.

= L’insertion s’effectue sur le point FosExt _G.

= Contraintes paramétriques :

(0]

DégagFosExt G, détermine le dégagement de la
berme inférieure par rapport au fossé extérieur;

DrainMinFosCréte G, hauteur du talus extérieur du
fossé de créte.

HautPalRoc G, paramétre la hauteur du palier de roc
par rapport au fossé extérieur;

LargPalRoc G, détermine la largeur du palier de rog;

PenteBermelnf G, paramétre la pente de la berme
inférieure;

PentePalRoc G, paramétre la pente du palier de rog;

PenteTalDeb G, parametre la pente de talus de
déblai;

PenteTalRoc G, parametre la pente de talus de roc.

Référence(s)
Tome 2 — Chap. 1 - DNO0O01,
DNO00O2, DNOO3

A

Image(s)
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Condition Roc
Bermelnf (D)

102

Condition de
raccordement en
présence de roc droite
avec possibilité
d’attribution d’un
dégagement

Tome 2 — Chap. 1 - DNO0O01,

Cette condition est utilisée principalement en avant-projet. DN002, DNOO3

Elle propose I'ajout d’un fossé de créte (Fossé Créte (D)) a la
suite du raccordement au terrain naturel dans le cas ou la
pente naturelle coule en direction du palier de roc et une
pente de talus en remblai pour une direction opposée.

L'insertion s’effectue sur le point Fos/nt_D.

La largeur de berme inférieure est établie en fonction du
point Rive_D. Ce point doit étre fusionné ( )
avec le point Rive_D du gabarit.

Contraintes paramétriques :

o DégaglaterRoc D, détermine de dégagement latéral
par rapport au point Rive D.

o LargBermeSup D, détermine la largeur de la berme
supérieure;

o HautPalRoc D, paramétre la hauteur du palier de roc
par rapport au fossé extérieur;

o LargPalRoc D, détermine la largeur du palier de roc;

o PenteBermelnf D, parameétre la pente de la berme
inférieure;

o PentePalRoc D, parameétre la pente du palier de roc;

o PenteTalDeb D, paramétre la pente de talus de
déblai;

o PenteTalRoc D, parametre la pente de talus de roc.
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Condition Roc Condition de

Bermelnf (G) raccordement en
présence de roc gauche
avec possibilité
d’attribution d’un
dégagement

Tome 2 — Chap. 1 - DNO0O01,

Cette condition est utilisée principalement en avant-projet. DN002, DNOO3

Elle propose I'ajout d’un fossé de créte (Fossé Créte (G)) ala
suite du raccordement au terrain naturel dans le cas ou la
pente naturelle coule en direction du palier de roc et une
pente de talus en remblai pour une direction opposée.

L'insertion s’effectue sur le point Fos/nt_G.

La largeur de berme inférieure est établie en fonction du
point Rive_G. Ce point doit étre fusionné ( )
avec le point Rive_G du gabarit.

Contraintes paramétriques :

o DégaglaterRoc_G, détermine de dégagement latéral
par rapport au point Rive_G.

o LargBermeSup_G, détermine la largeur de la berme
supérieure;

o HautPalRoc G, parameétre la hauteur du palier de roc
par rapport au fossé extérieur;

o LargPalRoc G, détermine la largeur du palier de roc;

o PenteBermelnf G, paramétre la pente de la berme
inférieure;

o PentePalRoc G, parameétre la pente du palier de roc;

o PenteTalDeb G, parametre la pente de talus de
déblai;

o PenteTalRoc_G, parametre la pente de talus de roc.
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Condition Roc
SansBermelnf (D)

104

Condition de
raccordement en
présence de roc droite
avec possibilité
d’attribution d’un
dégagement

Cette condition est utilisée principalement en avant-projet.

Tome 2 — Chap. 1 - DNO0O01,

DNO002, DNOO3

Elle propose I'ajout d’un fossé de créte (Fossé Créte (D)) a la
suite du raccordement au terrain naturel dans le cas ou la
pente naturelle coule en direction du palier de roc et une
pente de talus en remblai pour une direction opposée.

L'insertion s’effectue sur le point FosExt D.

Contraintes paramétriques :

o

DégaglaterRoc D, détermine de dégagement latéral
par rapport au point Rive_D.

LargBermeSup D, détermine la largeur de la berme
supérieure;

HautPalRoc D, parametre la hauteur du palier de roc
par rapport au fossé extérieur;

LargPalRoc D, détermine la largeur du palier de roc;

PenteBermelnf D, parametre la pente de la berme
inférieure;

PentePalRoc D, parameétre la pente du palier de roc;

PenteTalDeb D, parametre la pente de talus de
déblai;

PenteTalRoc D, paramétre la pente de talus de roc.
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Cette condition est utilisée principalement en avant-projet.

Nom Description Remarque(s)
Condition Roc Condition de
SansBermelnf (G) raccordement en :
présence de roc gauche .

avec possibilité
d’attribution d’un
dégagement

Elle propose I'ajout d’un fossé de créte (Fossé Créte (G)) ala
suite du raccordement au terrain naturel dans le cas ou la
pente naturelle coule en direction du palier de roc et une
pente de talus en remblai pour une direction opposée.

L'insertion s’effectue sur le point FosExt G.

Contraintes paramétriques :

o

DégaglaterRoc_G, détermine de dégagement latéral
par rapport au point Rive_G.

LargBermeSup G, détermine la largeur de la berme
supérieure;

HautPalRoc G, parameétre la hauteur du palier de roc
par rapport au fossé extérieur;

LargPalRoc G, détermine la largeur du palier de roc;

PenteBermelnf G, parametre la pente de la berme
inférieure;

PentePalRoc G, paramétre la pente du palier de roc;

PenteTalDeb_G, paramétre la pente de talus de
déblai;

PenteTalRoc G, parametre la pente de talus de roc.

Référence(s)
Tome 2 — Chap. 1 - DNO0O01,
DNO0O02, DNOO3

Image(s)
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Nom

Fossé Créte (G)

Description
Fossé de créte gauche

Remarque(s)

Le fossé de créte est utilisé pour drainer I'’eau de pluie a
I’extérieur des paliers de roc.

L'insertion s’effectue sur le point HtTn G.

Contraintes paramétriques :

o

DrainMinFosCréte G, parametre le drainage
minimum du fossé;

LargBermeCréte G, détermine la largeur de la berme
du fossé;

LargDemiFosCréte G. détermine la moitié de la
valeur de la largeur du fossé;

PenteBermeCréte G, parametre la pente de la berme
de fossé;

PenteTalCréteDeb G, parametre la pente du talus de
déblai du fossé;

PenteTalCréteDeb G, paramétre la pente du talus
extérieur du fossé;

PenteTalExtCréte G, assigne la pente de talus
extérieur du fossé de créte gauche.

Référence(s) Image(s)
Tome 2 — Chap. 1 - DNO0O01,
DNO002, DNOO3
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Nom Description Remarque(s)

Talus Fossé Berme (D) Talus extérieur de
chaussée et fossé de
berme droit

Cette condition est utilisée principalement au stade de
conception.

Le fossé de berme est utilisé pour drainer un profil de fossé
dont I'élévation du profil est supérieure a I'élévation du
terrain naturel. A I'inverse, un fossé standard est affiché.

L'insertion s’effectue sur le point Infra_Infra_D.

L'élévation du style (GEO) FosseDroit est utilisée pour définir
la profondeur du fossé. Il est également possible d’utiliser un
point de contrdle dans le Roadway Designer.

Contraintes paramétriques :

o LargBerme_D, parametre la largeur de berme du
fossé;

o LargDemifFos_D, détermine la moitié de la valeur de
la largeur du fossé;

o PenteTalDeb D, parameétre la pente du talus de
déblai du fossé;

o PenteTalExt_D, détermine la pente du talus extérieur
de la chaussée.

Référence(s)
Tome 2 — Chap. 1 — DN025

Image(s)
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Talus Fossé Berme (G)

108

Talus extérieur de
chaussée et fossé de
berme gauche

Cette condition est utilisée principalement au stade de
conception.

Le fossé de berme est utilisé pour drainer un profil de fossé
dont I'élévation du profil est supérieure a I'élévation du
terrain naturel. A I'inverse, un fossé standard est affiché.

L'insertion s’effectue sur le point Infra_Infra_G.

L'élévation du style (GEO) FosseGauche est utilisée pour
définir la profondeur du fossé. Il est également possible
d’utiliser un point de contréle dans le

Contraintes paramétriques :

o LargBerme G, parametre la largeur de berme du
fossé;

o LargDemiFos G, détermine la moitié de la valeur de
la largeur du fossé;

o PenteTalDeb G, parametre la pente du talus de
déblai du fossé;

o PenteTalExt G, détermine la pente du talus extérieur
de la chaussée.

Tome 2 — Chap. 1 — DN025
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Description Remarque(s) Référence(s)
Talus Fossé Déblai (D) Talus extérieur de ¢ utilisé i dition de fossé Tome 2 — Chap. 1 - DN025
chaussée et fossé droit zc?.;sle'un isé pour représenter une condition de fossé en
éblai.

normalisé en déblai

= Le fossé peut s’ajouter a la condition Talus Remblai (D) pour
représenter une condition normalisée en remblai. Ceci
permet de localiser la rencontre du talus extérieur de
chaussée avec le terrain naturel (point RtTn_D).

= Linsertion s’effectue sur le point Infra_Infra_D.
= Contraintes paramétriques :

o DrainMininfra_D, paramétre la profondeur minimale
de fossé;

o LargDemiFos_D, détermine la moitié de la valeur de
la largeur du fossé;

o PenteTalDeb D, parameétre la pente du talus de
déblai du fossé;

o PenteTalExt D, détermine la pente du talus extérieur
de la chaussée.
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Talus Fossé Déblai (G)

110

Talus extérieur de
chaussée et fossé
gauche normalisé en
déblai

Fossé utilisé pour représenter une condition de fossé en
déblai.

Le fossé peut s’ajouter a la condition Talus Remblai (G) pour
représenter une condition normalisée en remblai. Ceci
permet de localiser la rencontre du talus extérieur de
chaussée avec le terrain naturel (point Rt7n_G).

L'insertion s’effectue sur le point Infra_Infra_G.
Contraintes paramétriques :

o DrainMininfra_G, paramétre la profondeur minimale
de fossé;

o LargDemiFos G, détermine la moitié de la valeur de
la largeur du fossé;

o PenteTalDeb G, parametre la pente du talus de
déblai du fossé;

o PenteTalExt G, détermine la pente du talus extérieur
de la chaussée.

Tome 2 — Chap. 1 — DN025

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Conception)

Nom Description Remarque(s) Référence(s) Image(s)
Talus Fossé Remblai (D) Talus extérieur de . . Tome 2 — Chap. 1 - DN025
chaussée et fossé = Fossé u.tI|ISé pour représenter une condition de fossé en
droits normalisé en remblai.
remblai = Cette condition ne permet pas de localiser la rencontre du

talus extérieur de chaussée avec le terrain naturel. Utiliser la
combinaison Talus Remblai (D) et Talus Fossé Déblai (D) pour
obtenir cette condition.

= L’insertion s’effectue sur le point Infra_Infra_D.
= Contraintes paramétriques :

o LargDemiFos_D, détermine la moitié de la valeur de
la largeur du fossé;

o PenteTalDeb_D, parametre la pente du talus de
déblai du fossé;

o PenteTalExt D, détermine la pente du talus extérieur
de la chaussée.
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Talus Fossé Remblai (G)

Talus Remblai (D)

112

Talus extérieur de
chaussée et fossé
gauches normalisé en
remblai

Talus extérieur de
chaussée droit en
remblai

Fossé utilisé pour représenter une condition de fossé en
remblai.

Cette condition ne permet pas de localiser la rencontre du
talus extérieur de chaussée avec le terrain naturel. Utiliser la
combinaison Talus Remblai (G) et Talus Fossé Déblai (G) pour
obtenir cette condition.

L'insertion s’effectue sur le point Infra_Infra_G.
Contraintes paramétriques :

o LargDemiFos G, détermine la moitié de la valeur de
la largeur du fossé;

o PenteTalDeb G, parametre la pente du talus de
déblai du fossé;

o PenteTalExt G, détermine la pente du talus extérieur
de la chaussée.

La pente de talus extérieur de chaussée permet de localiser
la rencontre avec le terrain naturel (point RtTn_D). On peut y
ajouter la condition Talus Fossé Déblai (D) pour former une
condition compléete en remblai.

Peut étre utilisé lorsque le drainage ne nécessite pas de
fossé, c’est-a-dire que le drainage s’effectue naturellement
selon la pente existante du terrain.

L'insertion s’effectue sur le point Infra_Infra_D.

La contrainte paramétrique PenteTalExt_D détermine la
pente du talus extérieur de la chaussée.

Tome 2 — Chap. 1 — DN025
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Talus Remblai (G) Talus extérieur de
chaussée gauche en
remblai

Tranchée (D) Condition pour

tranchée transversale
de conduites droite

La pente de talus extérieur de chaussée permet de localiser
la rencontre avec le terrain naturel (point Rt7n_G). On peut y
ajouter la condition Talus Fossé Déblai (G) pour former une
condition compléete en remblai.

Peut étre utilisé lorsque le drainage ne nécessite pas de
fossé, c’est-a-dire que le drainage s’effectue naturellement
selon la pente existante du terrain.

L'insertion s’effectue sur le point Infra_Infra_G.

La contrainte paramétrique PenteTalExt_G détermine la
pente du talus extérieur de la chaussée.

Condition pour le calcul des tranchées de conduites pour le
terrassement.

Agencement de trois scénarios en présence de trois surfaces
(Target) :

o Roc—Infra —Surface Active (TN)
o Infra—Roc - Surface Active (TN)
o Infra —Surface Active (TN)

On détermine la position P par rapport aux cibles de la surface
Infra :

o Tallnfra_D1
o Tallnfra_D2
Par défaut, la valeur Offset est de -1.25.

L'insertion s’effectue sur le point représentant la limite extérieure
droite du fond de la tranchée (FondTranch_D).
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Nom
Tranchée (G)

Description
Condition pour
tranchée transversale
de conduites gauche

Remarque(s)

Condition pour le calcul des tranchées de conduites pour le
terrassement.

Agencement de trois scénarios en présence de trois surfaces

(Target) :
o Roc - Infra —Surface Active (TN)
o Infra—Roc — Surface Active (TN)
o Infra—Surface Active (TN)

On détermine la position P par rapport aux cibles de la
surface Infra :

o Tallnfra_G1
o Tallnfra_G2
Par défaut, la valeur Offset est de -1.25.

L'insertion s’effectue sur le point représentant la limite
extérieure gauche du fond de la tranchée (FondTranch_G).

Référence(s) Image(s)

Tome 2 — Chap. 1 - DN021

114

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Conception)

On entend par le terme «urbaines», toutes les conditions de raccordement se retrouvant principalement en milieu urbain; en situation de drainage fermé mais non exclusif.

Talus (D) Talus en déblai et . ) , )
S = L’insertion s’effectue sur le point TrotBordArr D.
remblai droit,
incluant une = Contraintes paramétriques :
banquette
o LargBanqu_D, détermine la largeur de la banquette, le
dégagement de la pente de talus par rapport a I'arriere bordure
ou trottoir;
o PenteBanqu_D, parametre la pente de la banquette;
o PenteTalDeb D, détermine la pente du talus en condition de
déblai;
o PenteTalRemb D, détermine la pente du talus en condition de

Talus (G) Talus en déblai et

remblai gauche,

incluant une .

banquette
o)
o
O
o)
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remblai.

= L’insertion s’effectue sur le point TrotBordArr G.

Contraintes paramétriques :

LargBanqu_G, détermine la largeur de la banquette, le
dégagement de la pente de talus par rapport a I'arriére bordure
ou trottoir;

PenteBanqu_G, paramétre la pente de la banquette;

PenteTalDeb G, détermine la pente du talus en condition de
déblai;

PenteTalRemb_ G, détermine la pente du talus en condition de
remblai.

Tome 2 — Chap. 1 — DN025

Tome 2 — Chap. 1 — DN025
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116

Talus emprise (D)

Talus a pente variable
droit selon I'emprise

. . ) Tome 2 — Chap. 1 — DN0O25
L'insertion s’effectue sur le point TrotBordArr D.

La pente de talus est variable et réagit en fonction d’un dégagement par
rapport a une emprise droite. L'emprise peut étre controlée dans le
ou avec une contrainte paramétrique (Emp_D).

Contraintes paramétriques :

o DégagEmp D, détermine le dégagement du raccord au terrain
naturel par rapport a 'emprise. Une valeur 0 permet de
raccorder le point RtTn_D directement sur I'emprise;

o Emp D, positionne I'emprise droite par rapport a I'arriere
trottoir ou bordure;

o LargBanqu_D, détermine la largeur de la banquette, le
dégagement de la pente de talus par rapport a I'arriére bordure
ou trottoir;

o PenteBanqu_D, paramétre la pente de la banquette.
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Nom Description Remarque(s) Référence(s) Image(s)

Talus emprise (G) Talus a pente variable . . . Tome 2 — Chap. 1 — DN025
= L’insertion s’effectue sur le point TrotBordArr G.
gauche selon

Femprise = La pente de talus est variable et réagit en fonction d’un dégagement par T

rapport a une emprise gauche. L'emprise peut étre contrélée dans le
Roadway Designer ou avec une contrainte paramétrique (Emp_G).

= Contraintes paramétriques :
o PenteBanqu_G, paramétre la pente de la banquette.

o DégagEmp_G, détermine le dégagement du raccord au terrain
naturel par rapport a I'emprise. Une valeur 0 permet de
raccorder le point RtTn_G directement sur I'emprise;

o Emp_ G, positionne I'emprise gauche par rapport a 'arriére
trottoir ou bordure;

o LargBanqu_G, détermine la largeur de la banquette, le
dégagement de la pente de talus par rapport a I'arriere bordure
ou trottoir;
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Talus multiple (D) Talus a pente variable . L, . Tome 2 — Chap. 1 — DN025
droit selon Ia = Condition utilisée généralement en avant-projet.
profondeur du = Pente de déblai selon la profondeur par rapport au point Bangu D :
raccordement au
terrain naturel o Entre0et0,5m=10%o0

o Entre0,5et1m=25%
o Entrelet2m=33%

o >2m=50%

Pente de remblai selon la profondeur par rapport au point Banqu_D :
o EntreOet-0,5m=-10%
o Entre-0,5et-1m=-25%
o Entre-let-2m=-33%
o >-2m=-50%

= L’insertion s’effectue sur le point TrotBordArr D. -

Contraintes paramétriques :

o LargBanqu_D, détermine la largeur de la banquette, le
dégagement de la pente de talus par rapport a I'arriere bordure
ou trottoir;

o PenteBanqu_D, parametre la pente de la banquette.
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Nom Description Remarque(s) Référence(s) Image(s)
Talus multiple (G) Talus a pente variable conditi ilisée eénéral . Tome 2 — Chap. 1 - DNO025
gauche selon Ia ondition utilisée généralement en avant-projet.
profondeur du = Pente de déblai selon la profondeur par rapport au point Bangu G :
raccordement au

o Entre0,5et1lm=-25%
o Entrelet2m=-33%
o >2m=-50%
= Pente de remblai selon la profondeur par rapport au point Banqu G :
o EntreOet-0,5m=10%
o Entre-0,5et-1m=25%
o Entre-let-2m=33%
o >-2m=50%
= L’insertion s’effectue sur le point TrotBordArr_G.
= Contraintes paramétriques :

o LargBanqu_G, détermine la largeur de la banquette, le
dégagement de la pente de talus par rapport a I'arriere bordure
ou trottoir;

o PenteBanqu_G, paramétre la pente de la banquette.
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Une contrainte paramétrique permet de modifier les propriétés les parameétres par défaut des largeurs, des épaisseurs et des valeurs de pente d’un gabarit.

DégagAccPav
DrainMininfra_D
EpaisBbBase
EpaisBbSurf
EpaisFond
EpaisSFond
HautBord
LargBanqu
LargBord
LargChev
LargDemiFos
LardDemiArr
LargVoie
PenteBanqu
PenteExc
PenteTalDéb
PenteTalDéb
PenteVoie

120

Distance entre le bas de bordure (ou trottoir) et le début de pente d’excavation a partir du point Exc_Infra_Infra

Distance verticale entre le point Infra_Infra et le Fos_Int
Epaisseur de la couche de base de béton bitumineux
Epaisseur de la couche de surface de béton bitumineux
Epaisseur de fondation

Epaisseur de sous-fondation

Hauteur de la bordure

Largeur de la banquette en arriére de la bordure

Largeur de la bordure

Largeur de la cheville (point d’accrochage au dévers)

Largeur du demi-fossé

Largeur du demi-arrondi (situé dans le haut du talus extérieur)
Largeur de voie

Pente de la banquette en arriere de la bordure

Pente d’excavation pour la fondation et la sous-fondation
Pente de talus pour la condition de raccordement en déblai
Pente de talus pour la condition de raccordement en remblai
Pente de voie ou de la zone de circulation
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Les épaisseurs de composants représentant la structure de chaussée ont été normalisées dans chaque gabarit afin d’harmoniser I'agencement des gabarits gauche (G) et droit (D).
= Définition des termes employés :
o Roc représente un gabarit en présence d’une surface de roc. La structure de chaussée differe de la structure en présence du terrain naturel;
o Bord représente un gabarit contenant une bordure;
o Glis représente un gabarit contenant un dispositif de retenu de type W/BE/1905;
o Bermelnfindique la présence d’un parametre permettant I'affichage d’un dégagement entre le point de rive (Rive_D ou Rive_G) et le début de la paroi de roc;
o Fondinf représente un gabarit possédant une couche de fondation inférieure, généralement un matériau granulaire de type MG-56;

o Projection sert a identifier un gabarit a condition de raccordements variables dont le point d’arrondi (Arr_D ou Arr_G) est utilisé pour définir le point de départ. Ce gabarit est
utilisé généralement au stade préliminaire d’un projet;

o Structure Typique indique les gabarits dont seule la structure de chaussée (communément appelé Backbone) est représenté;

o Carrefour représente un profil en travers utilisé pour la modélisation d’un carrefour en « T » ou en angle.
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Profils en travers servant aux infrastructures aéroportuaires.

122

Rechargement Piste

Profil en travers pour le
rapiécage ou
rechargement de I'aire de
mouvement et des
accotements

=  Contraintes paramétriques :

O

EpaisMG56, établit I'épaisseur du matériel
granulaire 0-56mm ;

EpaisMinMG20, paramétre I'épaisseur du
matériel granulaire 0-20mm. Un
composant de type Overlay est positionné
en dessous du MG20 et permet d’évaluer la
qguantité supplémentaire requise. Pour une
validation préliminaire, établir la valeur a
1Imm;

LargAccGra_D et LargAccGra_G,
déterminent les largeurs d’accotement
droite et gauche de la piste;

LargPiste D et LargPiste G, définissent les
largeurs droite et gauche de la piste;

PenteAccGra_D et PenteAccGra_G,
déterminent les pentes droite et gauche de
la piste;

PentePiste_D et PentePiste_D, définissent
les pentes droite et gauche de la piste;

PenteTalExt_D et PenteTalExt_G, assignent
les pentes extérieures droite et gauche de

la piste. Il est possible de mettre une pente
de 1000 % pour une validation préliminaire.

= Norme d’aéroports —
Partie 1 — Entretien —
Entretien des surfaces
et du systeme de
drainage
Chap. 1—Norme
A1108
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Nom Description Remarque(s) Référence(s) Image(s)

Tumulus Amas de terre en forme . . = Structure de
= Contraintes paramétriques :

de pyramide tronquée sur signalisation
lequel est installée la o EpaisMG56, établit I'épaisseur du matériel Tome 3 - Chap.6 -
structure de granulaire 0-56mm ; P.15

signalisation ;
o EpaisMinMG20, parametre |'épaisseur du

matériel granulaire 0-20mm.

o LargTumulus_D et LargTumulus_G,
déterminent les largeurs droite et gauche
du tumulus par rapport au point CL;

o PenteTalExt_D et PenteTalExt_G, assignent
les pentes extérieures droite et gauche du
tumulus.
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Power InRoads (Conception)

Les gabarits de cette catégorie servent a modéliser une bretelle d’entrée ou de sortie d’autoroute.

Autoroute

Bretolle de-cortie Bretelle d'entrée

= Dans chaque profil en travers de cette catégorie, il est possible d’ajouter un dispositif de retenu de type W/BE/1905 en correspondance avec le point Chev.
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Bretelle (Bord) (D)

Bretelle (Bord) (G)

Bretelle (D)

Bretelle (G)

Description
Bretelle avec bordure droit

Bretelle avec bordure gauche

Bretelle droite avec
accotement en gravier
seulement

Bretelle gauche avec
accotement en gravier
seulement

Remarque(s)

= (L estle point d’insertion de ce gabarit.

= (L estle point d’insertion de ce gabarit.

= (L estle point d’insertion de ce gabarit.

= (L estle point d’insertion de ce gabarit.

Référence(s)
Tome 1 —Chap.9-P. 22

Tome 1—Chap.9—-P. 22

Tome 1—Chap.9—P. 22

Tome 1 —Chap.9—-P. 22
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Power InRoads (Conception)

Les gabarits contenus dans cette catégorie sont utilisés pour définir la modélisation d’un carrefour giratoire.

= |Is peuvent étre utilisés ou non avec les outils de I'application Roundabout de Power InRoads. En utilisant les outils, I'usager n’aura pas a se soucier de |'orientation (gauche-droite) des

gabarits.

= Labordure peut étre remplacée par un trottoir dans les gabarits d’approche. Il suffit de la supprimer, de supprimer également la banquette et les conditions de raccordement puis d’insérer
au point AccPav le composant Trottoir Monolithique(D). On insére ensuite une condition de raccordement en condition urbaine.

= |’image de gauche représente le carrefour giratoire avant d’étre modélisé. L'image de droite représente le carrefour giratoire modélisé, avec les gabarits de la catégorie.

Entrée-Sortie

= Leterme « Entrée-Sortie » tel que montré dans I'image ci-dessus définit un alignement sur lequel on assignera les gabarits Giratoire (Entrée-Sortie) et Giratoire (Entrée-Sortie avec llot).

= |l n’est pas nécessaire au préalable de définir des alignements verticaux pour les alignements Entrée-Sortie. Les points de contrdles détermineront cet aspect.

= Le gabarit Giratoire (Entrée-Sortie) est assigné du début de I'alignement Entrée-Sortie jusqu’au début de I'llot séparateur de I'entrée, a la fin de I'llot séparateur de I'entrée jusqu’au début
de I'llot séparateur de sortie et de la fin I'llot séparateur de sortie jusqu’a la fin de I'alignement.

= Le gabarit Giratoire (Entrée-Sortie avec Ilot) est utilisé entre les débuts et fins d’flots séparateurs d’entrée et de sortie.
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= Les points de contréle :

o Le point AccPav suit horizontalement seulement I'alignement Entrée-Sortie.

o Le point CL suit horizontalement et verticalement :

= |’alignement d’approche au centre de I'entrée du début de I'alignement Entrée-Sortie jusqu’a l'intersection avec le rayon extérieur du giratoire;

= Le point de corridor RayonExt de I'intersection entre le centre de I'alignement d’approche d’entrée et le rayon extérieur du giratoire jusqu’au centre de I'approche de
sortie et le rayon extérieur du giratoire. Si le point de corridor chevauche la localisation du point de départ-fin de I'alignement du giratoire, la solution d’alignement
inverse sera alors appliquée. Pour corriger ce probléme, séparer en deux points de contrdle soit de I'intersection jusqu’au chainage de départ-fin de I’alignement du

giratoire et du chainage début-fin jusqu’a I'intersection;
= L’alignement d’approche au centre de la sortie a I'intersection du rayon extérieur du giratoire jusqu’a la fin de I'alignement Entrée-Sortie.
o Le point AccPav_llot suit horizontalement les deux ilots séparateurs soit d’entrée et de sortie.
= Des chafnages clés peuvent étre placés aux intersections des alignements d’approche au centre d’entrée et de sortie et du rayon extérieur du giratoire pour améliorer la modélisation.

= Lors de la création de la surface finale, il est possible de jumeler toutes les surfaces pour n’en former qu’une seule. Il est alors recommandé d’enlever les options d’attaches (Clipping

options) sur les surfaces.
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Giratoire - Roc Approche de giratoire
(Entrée-Sortie avec flot) avec ilot en présence de
roc
Giratoire - Roc Approche de giratoire en
(Entrée-Sortie) présence de roc
128

Tel que montré dans I'image en bas a droite, ce
gabarit est utilisé pour modéliser la partie contenant
un flot séparateur en entrée et en sortie d’un
giratoire.

Agencement d’un gabarit de giratoire en milieu rural
et de la condition de raccordement Coupe Roc
Bermelnf (D).

Fondation inférieure sur roc.
Contraintes paramétriques :

o HautBordllot, détermine la hauteur de la
bordure de I'ilot séparateur;

o LargBordllot, détermine la largeur de la
bordure de I'llot séparateur.

Tel que montré dans I'image en bas a droite, ce
gabarit est utilisé pour modéliser la partie contenant
un flot séparateur en entrée et en sortie d’un
giratoire.

Agencement d’un gabarit de giratoire en milieu rural
et de la condition de raccordement Coupe Roc
Bermelnf (D).

Fondation inférieure sur roc.

Carrefour giratoire,
un mode de gestion
différent, chap.7

Py

Carrefour giratoire,
un mode de gestion
différent, chap.7
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Giratoire — Roc Zone de circulation d’un
(Zone de circulation) giratoire sur fond de roc

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

Tel que montré dans I'image en bas a droite, ce gabarit est
utilisé pour modélisé la partie carrossable, la bande
franchissable ainsi que I'ilot central.

Fondation inférieure sur roc.

Contraintes paramétriques :

(@]

DégagBordllot, détermine la distance entre le bas
de bordure de I'llot central et le début de pente
d’excavation a partir du point Exc_Infra_Infra;
LargBordllot, détermine la largeur de la bordure de
I'llot séparateur;

EpaisBbBaseBandeFranch, assigne I'épaisseur de la
couche de base de béton bitumineux;
EpaisBbSurfBandeFranch, assigne I'épaisseur de la
couche de base de béton bitumineux ou des blocs
de pavé-unis (défaut);

HautBordllot, détermine la hauteur de la bordure
d’tlot central;

HautBordRayonint, détermine la hauteur de la
bordure entre I'anneau et la bande franchissable;
LargAnneau, spécifie la largeur de la partie
carrossable, la distance entre le rayon intérieur et
extérieur du giratoire;

LargBandeFranch, spécifie la largeur de la bande
franchissable;

LargBordllot, détermine la largeur de la bordure
d’llot central;

LargBordRayonint, parametre la largeur de la
bordure entre I'anneau et la bande franchissable;
PenteAnneau, parametre la pente de I'anneau;
PenteBandeFranch, parameétre la pente de la bande
franchissable;

Pentellot, détermine la pente de I'llot central
servant a 'aménagement paysager;

RayonExt, spécifie le rayon extérieur permettant de
modéliser I'flot central jusqu’a son centre.

Carrefour giratoire,
un mode de gestion
différent, chap.7,
P.83
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Giratoire — Rural
(Entrée-Sortie avec flot)

Approche de giratoire
avec ilot en milieu rural

Giratoire — Rural
(Entrée-Sortie)

Approche de giratoire en
milieu urbain

130

) . . . Carrefour giratoire, e
Tel que montré dans I'image en bas a droite, ce | .

bari ilisé déliser | ) un mode de gestion
ga Aar|t elst utilisé pour mo/ éliser la partle’contenant différent, chap.7
un ilot séparateur en entrée et en sortie d’un
giratoire.

Utilisation de la condition de raccordement <
Condition Simple Remblai - Déblai (D).

Contraintes paramétriques :

Py

o HautBordllot, détermine la hauteur de la
bordure de I'llot séparateur;

o LargBordllot, détermine la largeur de la
bordure de I'llot séparateur.

Carrefour giratoire,
un mode de gestion
différent, chap.7

Tel que montré dans I'image en bas a droite, ce
gabarit est utilisé pour modélisé la partie Entrée-
sortie excluant les flots séparateurs.

Utilisation de la condition de raccordement
Condition Simple Remblai - Déblai (D). N
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Nom Description Remarque(s) Référence(s) Image(s)
Giratoire — Urbain Approche de giratoire Tel ‘ d o bas 3 droi Carrefour giratoire,
o~ A oy . L .

(Entrée-Sortie avec llot) avec ilot en milieu urbain ebqt{e mont'rlc'a Ians |ma§e,|('an ?S a r9|te, ce un mode de gestion /
ga Aant elst utilisé pour mol éliser la pa_rtle'contenant différent, chap.7
un ilot séparateur en entrée et en sortie d’un /
giratoire. ' S

:‘-_:_1*—@: \\\

= Contraintes paramétriques :

o HautBordllot, détermine la hauteur de la
bordure de I'llot séparateur;

o LargBordllot, détermine la largeur de la
bordure de I'llot séparateur.
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Nom Description Remarque(s) Référence(s) Image(s)
Giratoire — Urbain Approche de giratoire en Carrefour giratoire,

(Entrée-Sortie) milieu urbain : TeLqu'e mont'rlt'a c’ians ! |maie,|(.enltl>as a d'r0|I'Ece, cle un mode de gestion /
gabarit est utilisé pour modélisé la partie Entrée- différent, chap.7

sortie excluant les ilots séparateurs.

T
o
N
]

/
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Giratoire Zone de circulation d’un
(Zone de circulation) giratoire

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

Tel que montré dans I'image en bas a droite, ce gabarit est
utilisé pour modélisé la partie carrossable, la bande
franchissable ainsi que I'ilot central.

Contraintes paramétriques :

(¢]

DégagBordllot, détermine la distance entre le bas
de bordure de I'llot central et le début de pente
d’excavation a partir du point Exc_Infra_Infra;
LargBordllot, détermine la largeur de la bordure de
I'llot séparateur;

EpaisBbBaseBandeFranch, assigne I'épaisseur de la
couche de base de béton bitumineux;
EpaisBbSurfBandeFranch, assigne I'épaisseur de la
couche de base de béton bitumineux ou des blocs
de pavé unis (défaut);

HautBordllot, détermine la hauteur de la bordure
d’flot central;

HautBordRayonint, détermine la hauteur de la
bordure entre I'anneau et la bande franchissable;
LargAnneau, spécifie la largeur de la partie
carrossable, la distance entre le rayon intérieur et
extérieur du giratoire;

LargBandeFranch, spécifie la largeur de la bande
franchissable;

LargBordllot, détermine la largeur de la bordure
d’llot central;

LargBordRayonint, parametre la largeur de la
bordure entre I'anneau et la bande franchissable;
PenteAnneau, parameétre la pente de I'anneau;
PenteBandeFranch, parameétre la pente de la bande
franchissable;

Pentellot, détermine la pente de I'llot central
servant a 'aménagement paysager;

RayonExt, spécifie le rayon extérieur permettant de
modéliser I'flot central jusqu’a son centre.

Carrefour giratoire,
un mode de gestion
différent, chap.7,
P.83
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Les gabarits de cette catégorie servent a I’élargissement de chaussée ou a la stabilisation des berges.

Elarg (D)

134

Elargissement de
chaussée en
conservant la
structure existante
coté droit

Le point AccGra_D est associé avec une contrainte
Vector-Offset faisant varier la pente de I'élargissement
en fonction de la pente de chaussée existante.
Points de contréle :
o CL_Exist, se positionne sur le centre ligne
existant de la chaussée;
o AccPav_D, se positionne sur le trait de scie
proposeé.
La condition de raccordement Condition Complexe
Remblai - Déblai (D) est appliquée au point
Infra_Infra_D.

Tome 2 — Chap. 1 — DN0OO6
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Elarg (G)

Elarg (D) (G)

Elargissement de
chaussée en
conservant la
structure existante
cOté gauche

Elargissement de
chaussée en
conservant la
structure existante
coté droit et gauche

Le point AccGra_G est associé avec une contrainte
Vector-Offset faisant varier la pente de I'élargissement
en fonction de la pente de chaussée existante.
Points de contréle :
o CL_Exist, se positionne sur le centre ligne
existant de la chaussée;
o AccPav_G, se positionne sur le trait de scie
proposé.
La condition de raccordement Condition Complexe
Remblai - Déblai (G) est appliquée au point
Infra_Infra_G.

Les points Rive Exist contrdlent la position de départ
des excavations.

Insertion au CL existant de la chaussée.

Resurfagage de I'enrobée bitumineux au centre
(conservation de la structure existante).
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Elarg (D) (G) (Terre-
plein Bord)

Elarg (D) (G) (Terre-
plein Trot)

136

Elargissement de
chaussée en
conservant la
structure existante
cOté droit et gauche

Elargissement de
chaussée en
conservant la
structure existante
coOté droit et gauche

Les points Rive_Exist contrdlent la position de départ
des excavations.

Insertion au CL existant de la chaussée.

Resurfagage de I'enrobée bitumineux au centre
(conservation de la structure existante).

Présence d’un terre-plein au centre.

Utilisation d’une bordure a gauche et a droite de la
chaussée.

Les points Rive_Exist controlent la position de départ
des excavations.

Insertion au CL existant de la chaussée.

Resurfagage de I'enrobée bitumineux au centre
(conservation de la structure existante).

Présence d’un terre-plein au centre.

Utilisation d’un trottoir a gauche et a droite de la
chaussée.

Tome 2 — Chap. 1 — DN0OO6

Tome 2 — Chap. 1 — DN0O06
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Elarg (D) (G) (Terre- Elargissement de ] _ _ _ slent | ion de dé Tome 2 — Chap. 1 — DN006
plein) chaussée en es points Rive_Exist controlent la position de depart

conservant la des egcavations. . ’
structure existante = Insertion au CL e,><|stant’de I'a chéussee.
coté droit et gauche u Resurfagage de I'enrobée bltum'meux au centre
(conservation de la structure existante).
= Présence d’un terre-plein au centre.
=  Utilisation d’'un accotement en gravier a gauche et a
droite de la chaussée.

Elarg (D) (Tranchée) Elargissement de o , o Tome 2 — Chap. 1 — DNOO6
chaussée en - Comblr)alson d’un ga.barlt d’élargissement avec une
conservant la tranchée avec conduite. Tome 3 — Chap.4 —
structure existante DNO002@005B, DNOO7A et
coté droit ¢ DNOO078B
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Elarg (G) (Tranchée)

Type B,C,D,E,F - Elarg

(Racc RiveExist -
Fondinf)

138

Elargissement de
chaussée en
conservant la
structure existante
cOté gauche ¢

Elargissement de
chaussée en
conservant une
partie de la
structure de
chaussée existante
— Raccordement a la
rive existante avec
fondation inférieure

Combinaison d’un gabarit d’élargissement avec une
tranchée avec conduite.

Ce gabarit est utilisé afin d’élargir les deux c6tés d’une
route existante.
Une sous-fondation compléte apparait lorsque les rives
droites et gauches existantes sont situées plus basse
que la ligne d’infrastructure.
Des conditions de raccordement sont positionnées dans
le gabarit en sourdine pour permettre la détection des
pentes transversales de la chaussée existante. Pour
permettre de faire apparaitre adéquatement une sous-
fondation, il est possible que I'utilisateur ait a modifier
la hauteur des points PtConst G et PtConstr D a I'aide
des contraintes paramétriques HautPtConst G et
HautPtConst_D.
Points de controles :
o _Rive Exist D, se positionne avec la rive droite
de la chaussée existante.
o _Rive Exist G, se positionne avec la rive gauche
de la chaussée existante.
Contraintes paramétriques :
o PenteExc D, parameétre la pente d’excavation,
c’est-a-dire la pente entre les points

Tome 2 — Chap. 1 — DNOO6

Tome 3 —Chap.4 -

DN0OO2@005B , DNOO7A et

DNOO7B

Tome 2 — Chap. 1 — DN0O06
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Type B,C,D,E,F - Elarg Elargissement de

(Racc RiveExist) chaussée en
conservant une
partie de la
structure de
chaussée existante
—Raccordement a la
rive existante

_Rive Exist D et Exc_Infra_D. Par défaut, une
pente de -1:3.

o PenteExc G, paramétre la pente d’excavation,
c’est-a-dire la pente entre les points
_Rive_Exist_G et Exc_Infra_G. Par défaut, une
pente de 1:3.

Les conditions de raccordement Condition Complexe
Remblai - Déblai (G) et Condition Complexe Remblai -
Déblai (D) sont appliquées aux points Infra_Infra_G et
Infra_Infra_D.

Ce gabarit est utilisé afin d’élargir les deux cotés d’une
route existante.

Une sous-fondation compléte apparait lorsque les rives
droites et gauches existantes sont situées plus basse
que la ligne d’infrastructure.

Des conditions de raccordement sont positionnées dans
le gabarit en sourdine pour permettre la détection des
pentes transversales de la chaussée existante. Pour
permettre de faire apparaitre adéquatement une sous-
fondation, il est possible que I'utilisateur ait a modifier
la hauteur des points PtConst G et PtConstr D a l'aide
des contraintes paramétriques HautPtConst G et
HautPtConst_D.
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Type B,C,D,E,F - Elarg
(Racc TN - Fondinf)

140

Elargissement de
chaussée en
conservant une
partie de la
structure de
chaussée existante
— Raccordement au
terrain naturel
existant

Points de controles :
o _Rive Exist D, se positionne avec la rive droite
de la chaussée existante;
o _Rive Exist G, se positionne avec la rive gauche
de la chaussée existante.
Contraintes paramétriques :
o PenteExc D, parameétre la pente d’excavation,
c’est-a-dire la pente entre les points
_Rive Exist D et Exc_Infra_D. Par défaut, une
pente de -1:3;
o PenteExc_G, paramétre la pente d’excavation,
c’est-a-dire la pente entre les points
_Rive Exist G et Exc_Infra_G. Par défaut, une
pente de 1:3.

Ce gabarit est utilisé afin d’élargir les deux cotés d’une
route existante.
Une sous-fondation compléete apparait lorsque les rives
droites et gauches existantes sont situées plus basse
que la ligne d’infrastructure.
Le raccordement s’effectue a la rencontre entre la ligne
d’infrastructure et du terrain naturel (Tn).
Points de controles :
o _FosintExist D, se positionne avec le bord
intérieur du fossé droit de la chaussée;
o _FosintExist G, se positionne avec le bord
intérieur du fossé gauche de la chaussée.
Les points de controdles cités plus haut permettent de
positionner le raccordement au terrain naturel
correctement dans le cas ou I'élargissement dépasse le
fossé existant.
Contraintes paramétriques :
o PenteExc D, parameétre la pente d’excavation,
c’est-a-dire la pente partant du point
Exc_Infra_D. Par défaut, une pente de -1:3.

Tome 2 — Chap. 1 — DNO06
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Description Remarque(s) Référence(s)
o PenteExc_G, paramétre la pente d’excavation,
c’est-a-dire la pente partant du point
Exc_Infra_G. Par défaut, une pente de 1:3.
= Les conditions de raccordement Condition Complexe
Remblai - Déblai (G) et Condition Complexe Remblai -
Déblai (D) sont appliquées aux points /nfra_Infra G et
Infra_Infra_D.
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Les gabarits de cette catégorie servent a la représentation d’ouvrages d’art (pont, viaduc, ponceau, etc).
= Des composants de poutres en acier (Poutre ACIER) ou en béton (Poutre NEBT) peuvent étre ajoutés pour améliorer le réalisme de la modélisation.
=  Contrainte paramétrique commune :

o EpaisSemelle; détermine I'épaisseur de la semelle en béton.
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Nom Description Remarque(s)

Pont (Gliss 210B) Structure de pont avec
dispositif de retenu de type
210B

Contraintes paramétriques :

(0]

HautChasseRoue D, établit la hauteur du chasse-
roue droit;

HautChasseRoue G, établit la hauteur du chasse-
roue gauche;

HautPoutre, détermine la hauteur de poutre du
pont;

LargAccPavint_D, spécifie la largeur de
I’accotement intérieur droit;

LargAccPavint_G, spécifie la largeur de
I’'accotement intérieur gauche;

LargChasseRoue D, établit la largeur du chasse-
roue droit;

LargChasseRoue G, établit la largeur du chasse-
roue gauche;

PenteSemelle D, définit la pente de la semelle
droite;

PenteSemelle G, définit la pente de la semelle
gauche.

Référence(s)
Tome 3 — Chap. 2
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Description Remarque(s) Référence(s)
Pont (Gliss 301) Structure de pont avec Tome 3 — Chap. 2
dispositif de retenu de type
301
Pont (Gliss 311B) Structure de pont avec Tome 3 — Chap. 2

dispositif de retenu de type - ComirEllis RE G |

311B o DemilargGlisBas, établit la demi-largeur du bas
de la glissiere au centre.
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Les profils en travers de cette catégorie sont utilisés pour effectuer divers travaux de réhabilitation de chaussée.
= Les profils en travers sont disponibles en chaussée double ou quadruple. Ony retrouve la mention (4 voies) situé a la fin du nom dans la librairie de gabarits.
=  Contraintes paramétriques :
o EpaisBbBaselnt, détermine I'épaisseur de béton bitumineux de base définie en couche intermédiaire;
o FondSurLarg D, spécifie une surlargeur de fondation et de pavage intermédiaire a droite par rapport au point Chev_D;
o FondSurlLarg G, spécifie une surlargeur de fondation et de pavage intermédiaire a gauche par rapport au point Chev_G.
o LargMarqu_D, détermine la largeur de la voie droite adjacente au point CL, spécifique aux gabarits (4 voies);
o LargMarqg_G, détermine la largeur de la voie gauche adjacente au point CL, spécifique aux gabarits (4 voies);
o PenteMarqu_D, établit la pente de la voie droite adjacente au point CL, spécifique aux gabarits (4 voies);

o PenteMarqu_G, établit la pente de la voie gauche adjacente au point CL, spécifique aux gabarits (4 voies).
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Conservation —
Chaussée
Existante

146

Profils en travers pour la
validation des pentes existantes
d’une chaussée

Sert a établir les pentes moyennes d’une chaussée
existantes pour permettre I'identification des pentes
transversales d’une chaussée par un code de couleurs.

Code de couleur :
o Pente <-2% en vert;
o Pente comprise entre -2% et 2% en ;
o Pente > 2% en rouge.

Points de contréle :
o Exi_CL, se positionne sur le centre ligne existant de
la chaussée;
o Exi_D, se positionne sur la ligne de rive droite
existante ;
o Exi_G, se positionne sur la ligne de rive gauche
existante.

Retraitement en
place des {_,jf \\\%
chaussées fff Y,
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. . N L Retraitement en
= Les contraintes paramétriques devront étre ajustées en
place des

fonction du type de route désiré. .
chaussées

Type B,C,D,E,F Profil en travers pour la
reconstruction d’une route de
tout type jusqu’a la sous-
fondation = Le composant de AjoutFond permet d’ajouté une quantité

supplémentaire de matériel de fondation épousant la forme s
de la surface cible.
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Type B,C,D,E,F - Profil en travers complet pour la . R Retraitement en :
. . = Points de controle : :
Conservation comparaison des pentes i . . . place des !
. o Exi_CL, se positionne sur le centre ligne existant de g vl
transversales existantes et . chaussées i .
, 9 . la chaussée; o ;
proposées d’un projet de , . . . . /
. , o Exi_D, se positionne sur la ligne de rive droite
correction de couche d’usure ) S
existante ;
o Exi_G, se positionne sur la ligne de rive gauche
existante.
=  Contraintes paramétriques :
o Aff=0, raccordement avec talus extérieur (par -
défaut); g k"“—" '
o Aff=1, raccordement a un carrefour;
o Aff= 2, raccordement a une entrée privée en gravier;
o Aff= 3, raccordement a une entrée privée pavée;
o DégagGliss> 0, affiche une glissiere de sécurité de
type M-W/BE/1905.
Type B,C,D,E,F - Profil en travers pour la ) . . q R o Retraitement en
n
Corr. Couche correction de la couche d’usure fes c9ntr3|ntes pzrametrlqdu’e§ levront etre ajustees en place des S
Usure de pavage onction du type de route desire. chaussées -
=  Utilisé en conjonction avec les outils dans le
, ce gabarit permet d’optimiser le calcul S

des quantités de pavage nécessaire pour une correction.

= |l est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.
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Type B,C,D,E,F - Profil en travers pour la

Corr. Couche correction de la couche d’usure

Usure (4 voies) de pavage d’une chaussée a 4
voies

Type B,C,D,E,F - Profil en travers pour effectuer un

Déco décohésionnement de chaussée

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Utilisé en conjonction avec les outils dans le
, ce gabarit permet d’optimiser le calcul
des quantités de pavage nécessaire pour une correction.

Il est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’une voie
supplémentaire.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Remplace la structure de chaussée existante jusqu’a la
fondation.

Il est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

Ce profil en travers peut contenir trois couches de pavages
(BbBase, BbBaselnt et Bbsurf).

Retraitement en
place des
chaussées

Retraitement en
place des
chaussées
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Type B,C,D,E,F — Profil en travers pour effectuer un ] . . q R o Retraitement en
Déco (4 voies) T es contraintes paramétriques devront étre ajustées en place des

. s . fonction du type de route désiré. . T ]
chaussée a 4 voies chaussées

= Remplace la structure de chaussée existante jusqu’a la
fondation. S

= |l est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

= Ce profil en travers peut contenir trois couches de pavages
(BbBase, BbBaselnt et Bbsurf).

= Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’une voie
supplémentaire.

Type B,C,D,E,F - Profil en travers pour effectuer un . o R o Retraitement en
= Les contraintes paramétriques devront étre ajustées en

Déco (AccGra 300 décohésionnement de chaussée a i R place des
min — 4 voies) 4 voies avec positionnement d’un fonction du type de route désiré. chaussées
accotement ayant au minimum *  Un accotement de 300mm de largeur sera positionné avec
300mm de largeur ce profil en travers. S

= Remplace la structure de chaussée existante jusqu’a la
fondation.

= |l est possible d'utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

= Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’'une voie
supplémentaire.
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Type B,C,D,E,F - Profil en travers pour effectuer un ] . . q R o Retraitement en
Déco (AccGra 300  décohésionnement de chaussée €s cgntramtes parametrlqu,es ,evront GUEEIB IS EL place des
. . ; fonction du type de route désiré. 2
min) avec positionnement d’un chaussées
accotement ayant au minimum = Un accotement de 300mm de largeur sera positionné avec
300mm de largeur ce profil en travers. s
= Remplace la structure de chaussée existante jusqu’a la
fondation.
= |l est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.
Type B,C,D,E,F - Profil en travers pour effectuer un ] . . q R o Retraitement en
n
Déco (AccGraTemp  décohésionnement d’une es contraintes paramétriques devront étre ajustées en place des

fonction du type de route désiré.

chaussées U/L\U

—4 voies) chaussée a 4 voies avec
1+ ’ 7 . . by
positionnement d’un accotement = Remplace la structure de chaussée existante jusqu’a la
en gravier temporaire fondation. S

= |l est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

= Ce profil en travers peut contenir trois couches de pavages
(BbBase, BbBaselnt et Bbsurf).

=  Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’'une voie
supplémentaire.
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Type B,C,D,E,F - Profil en travers pour effectuer un . . R o Retraitement en
. , L . . = Les contraintes paramétriques devront étre ajustées en
Déco décohésionnement de chaussée fonction du t 4 te désird place des .
(AccGraTemp) avec positionnement d’un onction du type de route desire. chaussées M\ﬂ
accotement en gravier temporaire = Remplace la structure de chaussée existante jusqu’a la

fondation. S

= |l est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

= Ce profil en travers peut contenir trois couches de pavages
(BbBase, BbBaselnt et Bbsurf).
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Type B,C,D,E,F - Profil en travers pour effectuer un

Déco (Glis— 4 décohésionnement d’une

voies) chaussée a 4 voies avec
positionnement d’un dispositif de
retenu

Type B,C,D,E,F -
Déco (Glis)

Profil en travers pour effectuer un
décohésionnement de chaussée
avec positionnement d’un
dispositif de retenu

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905 est affiché par
défaut.

Remplace la structure de chaussée existante jusqu’a la
fondation.

Il est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

Ce profil en travers peut contenir trois couches de pavages
(BbBase, BbBaselnt et Bbsurf).

Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’une voie
supplémentaire.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905 est affiché par
défaut.

Remplace la structure de chaussée existante jusqu’a la
fondation.

Il est possible d’utiliser les Features de style ANB de la
surface de terrain naturel pour positionner les bords
d’accotements non pavés.

Ce profil en travers peut contenir trois couches de pavages
(BbBase, BbBaselnt et Bbsurf).

Retraitement en
place des
chaussées

$

Tome 8 — Chap.
3 -DN GSR 003

Retraitement en
place des
chaussées

s

Tome 8 — Chap.
3 - DN GSR 003

153



Power InRoads (Conception)

Type B,C,D,E,F -
Déco (GTB-TAH)

Type B,C,D,E,F -
Déco (GTB-TAH-
TAB)

154

Profil en travers pour effectuer un
décohésionnement en tenant
compte des glissieres de sécurité
et des hauts de talus existant

Profil en travers pour effectuer un
décohésionnement en tenant
compte des glissieres de sécurité,
des bas et des hauts de talus
existant

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Remplace la structure de chaussée existante jusqu’a la
fondation. La structure de chaussée se prolonge jusqu’au
talus extérieur.

Le gabarit s’accroche automatiquement avec les styles TAH

et GTB présents dans une surface existante.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Remplace la structure de chaussée existante jusqu’a la
fondation. La structure de chaussée se prolonge jusqu’au
talus extérieur.

Le gabarit s’accroche automatiquement avec les styles TAH,

TAB et GTB présents dans une surface existante.

Retraitement en
place des
chaussées

Retraitement en
place des
chaussées
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Type B,C,D,E,F - Profil en travers pour effectuer un . oo R o Retraitement en
Déco (Pleine décohésionnement d’une " Lles c9ntra|ntes parametrlqu’e§ C,Ievront etre ajustees en place des e R
largeur — 4 voies) chaussée a 4 voies avec structure fonction du type de route désire. chaussées
de chaussée en pleine largeur = Remplace la structure de chaussée existante jusqu’a la
fondation. La structure de chaussée se prolonge jusqu’au S
talus extérieur.
= |l nécessaire d’utiliser des points de contréle droit et gauche
s’accrochant horizontalement et verticalement sur les
accotements non pavés provenant d’une surface de terrain
naturel.
= Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’une voie
supplémentaire.
Type B,C,D,E,F - Profil en travers pour effectuer un . . R o Retraitement en
Déco (Pleine décohésionnement de chaussée - s cgntramtes parametrlqu’e§ cllevront SR IS CiF place des _ s
largeur) avec structure de chaussée en fonction du type de route désiré. chaussées
pleine largeur = Remplace la structure de chaussée existante jusqu’a la
fondation. La structure de chaussée se prolonge jusqu’au S

talus extérieur.

= |l nécessaire d’utiliser des points de controle droit et gauche
s’accrochant horizontalement et verticalement sur les
accotements non pavés provenant d’une surface de terrain
naturel.
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Type B,C,D,E,F (4 Profil en travers pour la

voies) reconstruction d’'une route a 4
voies de tout type jusqu’a la sous-
fondation

156

Retraitement en
place des
chaussées

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Le composant de AjoutFond permet d’ajouté une quantité
supplémentaire de matériel de fondation épousant la forme s
de la surface cible.

Les contraintes paramétriques LargMarqu et PenteMarqu
permettent de gérer la largeur et la pente d’'une voie
supplémentaire.
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= Lestermes 1 et 2° classe servent a identifier la nature du déblai.

= Le terme 1 classe est utilisé pour spécifier la présence de déblai de roc dans un projet. Les profils en travers de la catégorie Ruraux — 1¢ classe sont employés dans le cadre d’étude
préliminaire a des fins de quantités ou de validation des paliers de roc. Une chaussée sur roc est affichée.

= Leterme 2° classe est utilisé pour définir I'absence de déblai de roc. Les profils en travers de la catégorie Ruraux — 1" et 2° classe servent dans le cadre d’étude préliminaire a des fins de
guantités ou de validation des paliers de roc. La structure de chaussée se modifie en fonction du type de classe rencontré. Une chaussé sur roc est affiché lors d’un sol en 1 classe et une
chaussée standard en 2° classe.

= Lorsque la phase préliminaire est terminée, c'est-a-dire que les hauteurs de paliers et que les zones dont la nature du sol ont été établies, il est possible de générer des profils en travers
combinant une structure de chaussée selon la nature du sol et des conditions de raccordement spécifiques aux plans et devis. Par exemple, pour établir une position exacte d’un palier de
roc, on peut utiliser la condition de raccordement Coupe Roc (D) et/ou Coupe Roc (G). On coche I'option Benching Count et From Datum dans la propriété de la condition de raccordement.
On assigne une valeur d’élévation correspondant a la hauteur de palier désirée.

= Les fossés de créte ajoutés a la fin de chaque palier peuvent étre supprimés au besoin.

= Les profils en travers sont paramétrés pour viser une surface appelée Roc. Si la surface porte un autre nom ou qu’il y a plusieurs surfaces de roc, on pourra les associer avec la(les) cible(s)
(Target) dans le avec I'outil
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=  Contraintes paramétriques communes :
o EpaisFondinfSurRoc, détermine I’épaisseur de fondation inférieure assise sur le roc (le dessous de ce composant représente I'infrastructure);
o EpaisFondSurRoc, détermine I'épaisseur de fondation en présence de roc;
o LargBermeSup, spécifie la largeur de berme supérieure;
o PentePalExt D, détermine la pente de palier droite;
o PentePalExt G, détermine la pente de palier gauche;
o PenteTalRoc(0<H<3) D, assigne la pente de talus de roc dans condition de raccordement situé entre 0 et 3 métres a partir du fossé intérieur droit;
o PenteTalRoc(0<H<3) G, assigne la pente de talus de roc dans condition de raccordement situé entre 0 et 3 métres a partir du fossé intérieur gauche;
o PenteTalRoc D, assigne la pente de talus de roc dans condition de raccordement situé a plus de 3 metres a partir du fossé intérieur droit;

o PenteTalRoc G, assigne la pente de talus de roc dans condition de raccordement situé a plus de 3 métres a partir du fossé intérieur gauche.

Fossé de créte, sl requls Variable

Berme
supérleure

3000 min, 41 Mort-terraln |
2 min,
z >
) 2 [ | : —

= Limite de I'emprise —
o

o

N

(=]

(=]

(=]

3

1

=

o7

Paller (4)

‘ 6000 min,

Q 1ee—
Berme inférieure, si requise 15
Ligne de sous-fondation

T

Roc

wgl<H

® 00024

\ W gos 1

158 Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Power InRoads (Conception)

Type A - Roc

Type A - Roc (Bermelnf)

Profil en travers
d’autoroute en
présence de roc

Profil en travers
d’autoroute en
présence de roc
avec berme
inférieure

Les accotements sont définis a la méme largeur. Pour une
chaussée définie a droite la distance de I'accotement a
gauche devrait étre rapetissée. Pour une chaussée a
gauche, I'accotement a droite devrait rapetisser.

Les accotements sont définis a la méme largeur. Pour une
chaussée définie a droite la distance de I'accotement a
gauche devrait étre rapetissée. Pour une chaussée a
gauche, I'accotement a droite devrait rapetisser.

La berme inférieure est utilisée pour respecter un
dégagement de la paroi de roc par rapport a I'extérieur
de fossé.

Contraintes paramétriques :

o DégaglaterRoc D, détermine une distance de
dégagement du bas de la paroi latérale de roc par
rapport au point Rive_D;

o DégaglaterRoc G, détermine une distance de
dégagement du bas de la paroi latérale de roc par
rapport au point Rive_G;

o PenteBermelnf D, spécifie la pente de talus
extérieur droite entre le point FosExt D et le bas
de la paroi de roc;

o PenteBermelnf G, spécifie la pente de talus
extérieur gauche entre le point FosExt G et le bas
de la paroi de roc.
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Profils en travers
Tome 1 - Chap.5 —
DNOO1

Terrassement

Tome 2 - Chap.1 —
DNO01@003 et DN025
Structure de chaussée
Tome 2 — Chap.2 -
DNO04@006

Profils en travers
Tome 1 - Chap.5 -
DNOO1

Terrassement

Tome 2 - Chap.1 -
DNOO1@003 et DN025
Structure de chaussée
Tome 2 — Chap.2 -
DNO0O04@006

ﬂ
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Type B,C,D,E,F - Roc

Profil en travers
d’une route
nationale,
régionale,
collectrice ou

= Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5 —
DN002 @006
Terrassement
Tome 2 - Chap.1 —

locale en présence DNO01@003 et DN025

de roc =  Structure de chaussée
Tome 2 — Chap.2 -
DNO04@006
Type B,C,D,E,F - Roc Profil en travers =  Profils en travers

= Les contraintes paramétriques devront étre ajustées en

(Bermelnf) d’une route - o Tome 1- Chap.5 -
nationale, fonction du type de route désiré. DN002@006
régionale = Laberme inférieure est utilisée pour respecter un = Terrassement
collectrice ou dégagement de la paroi de roc par rapport a I'extérieur Tome 2 - Chap.1-
locale en présence de fossé. DN001@003 et DN025 o <

de roc avec berme =  Structure de chaussée
inférieure = Contraintes paramétriques : Tome 2 — Chap.2 —

o DégaglaterRoc_D, détermine une distance de DN004@006

dégagement du bas de la paroi latérale de roc par
rapport au point Rive_D;

o DégaglaterRoc G, détermine une distance de
dégagement du bas de la paroi latérale de roc par
rapport au point Rive_G;

o PenteBermelnf D, spécifie la pente de talus
extérieur droite entre le point FosExt D et le bas
de la paroi de roc;

o PenteBermelnf G, spécifie la pente de talus
extérieur gauche entre le point FosExt G et le bas
de la paroi de roc.
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Type B,C,D,E,F - Roc
(Bord)

Type B,C,D,E,F - Roc
(Glis - Bord)

Type B,C,D,E,F - Roc
(Glis)

Profil en travers
d’une route
nationale,
régionale
collectrice ou
locale en présence
de roc avec
bordure

Profil en travers
d’une route
nationale,
régionale
collectrice ou
locale en présence
de roc avec
bordure et
dispositif de retenu

Profil en travers
d’une route
nationale,
régionale
collectrice ou
locale en présence
de roc avec
dispositif de retenu

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Une glissiére semi-rigide de type W/BE/1905 est affiché
par défaut.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905 est affiché
par défaut.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.
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Profils en travers
Tome 1 - Chap.5 —
DNO02@006
Terrassement

Tome 2 - Chap.1 —
DNO01@003 et DN025
Structure de chaussée
Tome 2 — Chap.2 -
DNO04@006

Dispositifs de retenue
Tome 8 — Chap. 3 - DN
GSR 001

Profils en travers
Tome 1 - Chap.5 -
DN002 @006
Terrassement

Tome 2 - Chap.1 -
DNOO1@003 et DNO25
Structure de chaussée
Tome 2 —Chap.2 -
DN004 @006

Dispositifs de retenue
Tome 8 — Chap. 3 - DN
GSR 001

Profils en travers
Tome 1 - Chap.5 -
DNO02@006
Terrassement

Tome 2 - Chap.1 -
DNO01@003 et DN025
Structure de chaussée
Tome 2 —Chap.2 -
DNO04@006
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Power InRoads (Conception)

Type B,C,D,E,F - Roc
(RembPier)

Type B,C,D,E,F —
Transition
Sol-Roc (D)

Type B,C,D,E,F —
Transition
Sol-Roc (G)

162

Profil en travers
d’une route
nationale,
régionale,
collectrice ou
locale en présence
de roc avec
composant de
remblai de pierre

Profil en travers
d’une route
nationale,
régionale,
collectrice ou
locale en présence
de roc partiel a
droite

Profil en travers
d’une route
nationale,
régionale,
collectrice ou
locale en présence
de roc partiel a
gauche

Le composant RembPier permet d’évaluer la quantité de
remblai de roc.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

Chaussée en présence de roc partiel a droite avec une
sous-fondation a gauche.

Contraintes paramétriques :

o EpaisRocBrisé, définit I'épaisseur de roc brisé
sous la fondation inférieure; .

o PenteExc D, détermine la pente pour |’excavation
a partir du point InfraSurRoc_G, le point de
rencontre avec le roc;

o ProfondeurP, parametre la profondeur par
rapport au point CL pour la recherche a
I’horizontal du raccordement au roc.

Chaussée en présence de roc partiel a gauche avec une
sous-fondation a droite.
Contraintes paramétriques :

o EpaisRocBrisé, définit I'épaisseur de roc brisé
sous la fondation inférieure;

Profils en travers
Tome 1 - Chap.5 -
DN002@006
Terrassement

Tome 2 - Chap.1 -
DNO0017

Structure de chaussée
Tome 2 — Chap.2 -
DN004@006

Profils en travers
Tome 1 - Chap.5 -
DNO02@006
Terrassement

Tome 2 - Chap.1 -
DNO0017

Structure de chaussée
Tome 2 —Chap.2 -
DNO04@006

CCDG 2017
11.4.3.3.1et11.4.3.4

Profils en travers
Tome 1 - Chap.5 -
DN002@006
Terrassement
Tome 2 - Chap.1 -
DNO0017
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Power InRoads (Conception)

Type D,E,F - Roc Profil en travers

(Sans AccPav - d’une route
Bermelnf) nationale,
régionale

collectrice ou
locale en présence
de roc avec berme
inférieure et sans
accotement pavé

PenteExc D, détermine la pente pour I'excavation
a partir du point InfraSurRoc_D, le point de
rencontre avec le roc;

ProfondeurP, paramétre la profondeur par
rapport au point CL pour la recherche a
I’horizontal du raccordement au roc.

Les contraintes paramétriques devront étre ajustées en
fonction du type de route désiré.

La berme inférieure est utilisée pour respecter un
dégagement de la paroi de roc par rapport a I'extérieur
de fossé.

Contraintes paramétriques :

O
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DégaglaterRoc D, détermine une distance de
dégagement du bas de la paroi latérale de roc par
rapport au point Rive_D;

DégaglaterRoc G, détermine une distance de
dégagement du bas de la paroi latérale de roc par
rapport au point Rive G;

PenteBermelnf D, spécifie la pente de talus
extérieur droite entre le point FosExt D et le bas
de la paroi de rog;

PenteBermelnf G, spécifie la pente de talus
extérieur gauche entre le point FosExt G et le bas
de la paroi de roc.

Structure de chaussée
Tome 2 — Chap.2 -
DN004@006

CCDG 2017
11.4.3.3.1et11.43.4

Profils en travers
Tome 1 - Chap.5 -
DN004@006
Terrassement

Tome 2 - Chap.1 -
DN0O01@003 et DN025
Structure de chaussée
Tome 2 — Chap.2 —
DN004 @006
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Power InRoads (Conception)

Nom Description Remarque(s) Référence(s) Image(s)

Type D,E,F - Roc Profil en travers . . R o = Profils en travers

(Sans AccPav) d’une route = Les c9ntra|ntes parametr|qu,e§ cllevront étre ajustées en Tome 1 - Chap.5 — V\Q,I F[;/ﬁ
nationale, fonction du type de route désiré. DNO04@006
régionale = Terrassement
collectrice ou Tome 2 - Chap.1 -
locale en présence DNOO01@003 et DN025
de roc sans = Structure de chaussée
accotement pavé Tome 2 — Chap.2 -

DNO0O4@006
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Power InRoads (Conception)

Les profils en travers de cette catégorie sont utilisés en milieu rural (drainage généralement ouvert). Le terme 2e classe identifie la nature du déblai.

Type A Profil en travers

, =  Les accotements sont définis a la méme largeur.
d’autoroute

Pour une chaussée définie a droite la distance de
I’'accotement a gauche devrait étre rapetissée. Pour
une chaussée a gauche, I'accotement a droite
devrait rapetissée.

= Contraintes paramétriques :

o EpaisEpaul, détermine I'épaisseur de sous-
fondation en dessous de I'épaulement
adjacent aux talus extérieurs;

o PenteEpaul, assigne la pente de la partie
intérieure de I'épaulement.

Type A Profil en travers
(Chaussée Séparée) d’autoroute en chaussée
séparée

= Une regle d’affichage indique que si la distance
entre les deux rives est plus petite ou égale a 18
metres, un dispositif de retenu rigide médian
apparait entre les deux chaussées, tel que montré
par I'image du haut. Dans le cas contraire, un fossé
apparait tel qu’illustré dans I'image du bas.

= Contraintes paramétriques :

o EpaisEpaul, détermine I'épaisseur de sous-
fondation en dessous de I'épaulement
adjacent aux talus extérieurs;

o PenteEpaul, assigne la pente de la partie
intérieure de I'épaulement.
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Profils en travers
Tome 1 - Chap.5 -
DNOO01

Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS et
DNOO06

Profils en travers
Tome 1 - Chap.5 -
DNO0O01

Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNOO1, DNOOS5 et
DNOO06
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Power InRoads (Conception)

Type A (D) Profil en travers
d’autoroute chaussée
droite

Type A (G) Profil d’autoroute

chaussée gauche

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale

Type B,C,D,E,F
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Les largeurs ont des accotements pavés gauches et
droites ont été ajustées en fonction d’une chaussée
coOté droit.

Contraintes paramétriques :

o EpaisEpaul, détermine I'épaisseur de sous-
fondation en dessous de I'épaulement
adjacent aux talus extérieurs;

o PenteEpaul, assigne la pente de la partie
intérieure de I'épaulement.

Les largeurs ont des accotements pavés gauches et
droites ont été ajustées en fonction d’une chaussée
cOté gauche.

Contraintes paramétriques :

o EpaisEpaul, détermine I'épaisseur de sous-
fondation en dessous de I'épaulement
adjacent aux talus extérieurs;

o PenteEpaul, assigne la pente de la partie

intérieure de I'épaulement.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5 -
DNOO01

Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNO0O01, DNOOS et
DNO06

Profils en travers
Tome 1 - Chap.5 -
DNOO1

Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS et
DNOO06

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNOO1, DNOOS et
DNO06
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Power InRoads (Conception)

Type B,C,D,E,F (4 voies) Profil en travers d’'une ) . . =  Profils en travers
. = Les contraintes paramétriques devront étre m——

route nationale, o ¢ ion d f désiré Tome 1 - Chap.5 - .

régionale, collectrice ou ajustees en fonction du type de route desire. DN002@DNO007

locale a quatre voies = Contraintes paramétriques : = Terrassement

Tome 2 - Chap.1 -
o LargMarqu_D, détermine la largeur de la DNO25
voie droite adjacente au point C/; = Structure de chaussée

Tome 2 — Chap.2 —

o LargMarq G, détermine la largeur de la
DNOO1, DNOO05 et

voie gauche adjacente au point CL;

DNO006
o PenteMarqu_D, établit la pente de la voie
droite adjacente au point CL;
o PenteMarqu G, établit la pente de la voie
gauche adjacente au point CL.
Type B,C,D,E,F (BbBase Profil en travers d’une ) o R =  Profils en travers
sous AccPav) route nationale, : L?S c?ntralntes pérametrlques cledrats ?tre, Tome 1 - Chap.5 - Wi
régionale, collectrice ou ajustées en fonction du type de route désiré. DN002@DNO007
locale affichant un enrobé = Terrassement
bitumineux de base en Tome 2 - Chap.1 —
pleine longueur en DNO025
dessous de I'accotement = Structure de chaussée
pavé Tome 2 - Chap.2 -
DNOO1, DNOO5 et
DNOO6
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Power InRoads (Conception)

Nom
Type B,C,D,E,F
(Bord)

Description

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale avec bordure

Remarque(s)

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Référence(s)

Profils en travers
Tome 1 - Chap.5 -
DN002@DN007 // AN
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 —Chap.2 -
DNO0O1, DNOOS et
DNO006
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Power InRoads (Conception)

Type B,C,D,E,F Profil en travers d’une

(Carrefour) (D) route nationale,
régionale, collectrice ou
locale c6té droit pour un
exemple pour de
traitement d’un carrefour
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Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Le point Rive_D est le point d’insertion du gabarit.
Le point CL doit étre controlé :

o horizontalement et verticalement sur le
point de corridor CL ou Rive (droite ou
gauche) sur la voie principale jusqu’a
I'intersection entre cette ligne et le CL de la
voie secondaire;

o horizontalement et verticalement sur le CL
de la voie secondaire de I'intersection
jusqu’a l'intersection avec la Rive (droite ou
gauche) ou le CL de la voie principale.

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNO0O01, DNOOS et
DNO06
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Power InRoads (Conception)

Type B,C,D,E,F
(Carrefour) (G)

Type B,C,D,E,F

170

(Engazonnement)

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale c6té gauche pour
un exemple pour de
traitement d’un carrefour

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale pour un exemple
pour le calcul de surface
d’engazonnement

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Le point Rive G est le point d’insertion du gabarit.
Le point CL doit étre controlé :

o horizontalement et verticalement sur le
point de corridor CL ou Rive (droite ou
gauche) sur la voie principale jusqu’a
I'intersection entre cette ligne et le CL de la
voie secondaire;

o horizontalement et verticalement sur le CL
de la voie secondaire de l'intersection
jusqu’a l'intersection avec la Rive (droite ou
gauche) ou le CL de la voie principale.

Ce profil en travers est a titre d’exemple pour
calculer la superficie d’engazonnement d’un projet.
Dans le , 'outil

permet d’effectuer ce calcul et de
générer un rapport (composant (SURF)
Engazonnement_D et (SURF) Engazonnement_G).

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré
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Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS et
DNOO06

Engazonnement
Tome 4 — Chap.9 -
DNOO1 et DN0O2
Profils en travers
Tome 1 - Chap.5 —
DN0O02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNO0O01, DNOOS et
DNO006




Power InRoads (Conception)

Type B,C,D,E,F
(FondInf)

Type B,C,D,E,F
(Glis - Bord)
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Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale avec fondation
inférieure

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale avec dispositif de
retenu et bordure

La contrainte paramétrique EpaisFondinf permet
d’assigner I’épaisseur de fondation inférieure.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905 est
affiché par défaut.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS et
DNOO06

Dispositifs de retenue
Tome 8 — Chap. 3 - F_//—/\‘”Qﬂ\\
DN GSR 003

Profils en travers
Tome 1 - Chap.5 —
DN0O02@DNO007
Terrassement

Tome 2 - Chap.1 —
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNO0O1, DNOOS5 et
DNO006
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Power InRoads (Conception)

Type B,C,D,E,F

172

(Glis)

Type B,C,D,E,F

(Glis) (Param)

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale avec dispositif de
retenu

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale avec dispositif de
retenu apparaissant sur
demande

Une glissiére semi-rigide de type W/BE/1905 est
affiché par défaut.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905
apparait sur demande, en attribuant une valeur
supérieure a 0 pour la contrainte paramétrique
DégagGlis_D et inférieure a 0 pour DégagGlis_G.

L'image du bas montre le résultat lorsque les deux
valeurs sont paramétrées. Dans le

, al’aide de I'outil
il est possible de gérer la présence d’une glissiere
entre un tel et tel chainage.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

’

Dispositifs de retenue
Tome 8 — Chap. 3 -
DN GSR 003

Profils en travers
Tome 1 - Chap.5 -
DNO0O0O2@DNO0O07
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 —Chap.2 -
DNO0O1, DNOOS5 et
DNO006

Dispositifs de retenue
Tome 8 — Chap. 3 -
DN GSR 003

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNO0O01, DNOOS et
DNOO06
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Power InRoads (Conception)

Type B,C,D,E,F Profil en travers d’une

(Gradins) route nationale,
régionale, collectrice ou
locale pour un exemple
de calcul de gradins
d’élargissement de

remblai
Type B,C,D,E,F Profil en travers d’une
(Isolant) route nationale,

régionale, collectrice ou
locale avec isolant
thermique en polystyréne
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Ce profil en travers permet de reproduire des
composants avec les largeurs et les hauteurs de
gradins correspondants aux critéres du tableau, tel
gue montré dans I'image du bas, en fonction de la
hauteur du remblai.

Points de contréle horizontaux et verticaux a
assigner dans le

o ArrExist_D et ArrExist_G, choisir dans la
surface de terrain naturel un Feature
représentant le haut de talus extérieur
existant droite et gauche;

o FosIntExist D et FosIntExist G, choisir dans
la surface de terrain naturel un Feature
représentant le fossé intérieur existant.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Le calcul de I'épaisseur de fondation se fait entre le
point Fond_CL et Isolant_CL.

Contrainte paramétrique :

o Epaislsolant, détermine I'épaisseur totale
(comprend toutes les feuilles de
polystyrene) de I'isolant a partir du point
Isolant _CL.

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement
Tome 2 - Chap.1 -
DNOO5, DNOO6 et
DNO025

Structure de chaussée

Tome 2 — Chap.2 -
DNO0O1, DNOOS et
DNOO6

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement
Tome 2 - Chap.1 -
DNOO5, DNOO6 et
DNO025

Structure de chaussée

Tome 2 — Chap.2 —
DNO0O01, DNOOS5,
DNOO6 et DN029
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Power InRoads (Conception)

Type B,C,D,E,F Profil en travers d’'une Profi isé | . ion d = Marquage
(Marquage) route nationale, I‘r0| Zn travers utilisé polur a rtlapreser)tanon' es Tome 5 — Chap. 6 —
régionale, collectrice ou Ignes de marquage au sol pour la representation Annexe A—P.15

d’un modele tridimensionnel :

locale pour un exemple =  Profils en travers

de marquage de chaussée o Lignes continus blanches simples sur les Tome 1 - Chap.5 -
rives; DN002@DN007
= Terrassement
o Ligne doubles continus jaunes sur le centre Tome 2 - Chap.1—
ligne. DN0O05, DNOO6 et
DNO025

= Les lignes de marquage apparaissent uniquement

que sous Microstation =  Structure de chaussée

Tome 2 —Chap.2 -
=  Les contraintes paramétriques devront étre DNOO1, DNOQS et
ajustées en fonction du type de route désiré. DNO006
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Power InRoads (Conception)

Type B,C,D,E,F Profil en travers d’une

(Remblai sous infra<1m) route nationale,
régionale, collectrice ou
locale pour un exemple
de calcul lorsque le
remblai est plus petit
qu’un métre
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La couche de terre végétale doit étre enlevée
partout ou la surface du terrain naturel est a 1,0 m
ou moins de la ligne de I'infrastructure et a
I'intérieur de la zone comprise entre les pentes de
1V : 1H tracées a partir de I'extérieur des
accotements, au niveau du revétement, sauf
indication contraire aux plans et devis. Ce
déblaiement, méme s’il doit étre fait séparément,
fait partie des déblais de deuxieme classe. Le style
(COMP) SolCompactable permet de calculer cette
quantité. Le composant RemblaiSousInfra est
paramétré par défaut a 0,3 metre. La contrainte
paramétrique FpaisDécap permet de modifier la

valeur au besoin. L'image du bas montre le résultat.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement
Tome 2 - Chap.1 -
DNOO5, DNOO6 et
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS et
DNOO06

CCDG 2016
11.45.3.2
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Power InRoads (Conception)

Type B,C,D,E,F
(Repére Glis)

176

Profil en travers d’'une
route nationale,
régionale, collectrice ou
locale pour exemple
d’affichage de lignes de
repéres pour la nécessité
d’un dispositif de retenu

Profil en travers permettant d’identifier les zones
ayant besoins potentiellement d’une pose de
glissiere de sécurité semi-rigide, en fonction de la
hauteur du talus extérieur. Ne tient pas en compte
les autres critéres pour la nécessité de glissiére.

Les repéres indiquent également les emplacements
de talus extérieurs lorsqu’une glissiére pourrait étre
appliquée, tel qu’illustré avec I'image du milieu.

Par défaut, la hauteur de recherche est établiea 5
metres. Il est possible de modifier les regles
Repére_D et Repére_G au besoin.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905
apparait sur demande, en attribuant une valeur
supérieure a 0 pour la contrainte paramétrique
DégagGlis_D et inférieure a 0 pour DégagGlis_G.

L'image du bas montre le résultat lorsque les deux
valeurs sont paramétrées. Dans le

, al’aide de 'outil ,
il est possible de gérer la présence d’une glissiere
dans un intervalle de chainage.

Dispositifs de retenue
Tome 8 —Chap.3—-DN
GSR 003

Profils en travers
Tome 1 - Chap.5 -
DNO0O0O2@DNO0O07
Terrassement

Tome 2 - Chap.1 -
DNOO5, DNOO6 et
DNO025

Structure de chaussée
Tome 2 —Chap.2 -
DNO0O1, DNOOS et
DNOO6
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Power InRoads (Conception)

Type B,C,D,E,F (SFond
avec Déblai)

Type Chemin Gravier

Type Chemin Gravier
(Glis) (Param)
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Profil en travers d’'une
route nationale, régionale
collectrice ou locale avec
une sous-fondation en
déblai

Profil en travers d’un
chemin en gravier

Profil en travers d’un
chemin en gravier

Utilisé pour placer un composant de sous-fondation

lorsque la profondeur minimum de fossé n’est pas
respectée :

o Raccord a la pente de talus extérieure en
condition de remblai ;

o Raccord en excavation en condition de

déblai (méme pente que le talus en déblai).

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Utilisé pour un chemin sans revétement de béton
bitumineux.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Utilisé pour un chemin sans revétement de béton
bitumineux.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Une glissiere semi-rigide de type W/BE/1905
apparait sur demande, en attribuant une valeur
supérieure a 0 pour la contrainte paramétrique
DégagGlis_D et inférieure a 0 pour DégagGlis_G.

Profils en travers
Tome 1 - Chap.5 -
DNO02@DNO007
Terrassement

Tome 2 - Chap.1 -
DNO025

Structure de chaussée
Tome 2 — Chap.2 —
DNO0O01, DNOOS et
DNO06

Terrassement
Tome 2 - Chap.1 -
DNO025

Dispositifs de retenue
Tome 8 — Chap. 3 —
DN GSR 003
Terrassement

Tome 2 - Chap.1—
DNO25
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Nom Description Remarque(s) Référence(s) Image(s)
Type D,E,F (Sans AccPav) Profil en travers d’'une . L . =  Profils en travers
route nationale, régionale . L('es c?ntralntes pfarametnques devront (’at'rel Tome 1 - Chap.5 -
collectrice ou locale sans ajustées en fonction du type de route désiré. DNO04@DNO06
accotement pavé = Terrassement
Tome 2 - Chap.1 -
DNO025

= Structure de chaussée
Tome 2 —Chap.2 -
DNO0O1, DNOOS et
DNO006
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Les profils en travers de cette catégorie sont utilisés en milieu rural (drainage généralement ouvert) dans le cadre d’étude préliminaire. lls ont été créés dans I'optique de faire varier les

conditions de raccordement en fonction de la hauteur de talus.
= Leterme Projection au design signifie que la structure de chaussée est projetée sur la pente de talus extérieur.

= Leterme 2e classe identifie la nature du déblai.

Type B,C,D,E,F Profil en travers d’une
route nationale,
régionale, collectrice ou

= Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

locale
Type B,C,D,E,F Profil en travers d’une U lissi _rigide d W/BE/1905
(Glis - Bord) route nationale, ne glissiere semi-rigide de type W/BE/ est

. . affiché par défaut.
régionale, collectrice ou P

locale avec dispositif de = Les contraintes paramétriques devront étre
retenu et bordure ajustées en fonction du type de route désiré.

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

Profils en travers
Tome 1 - Chap.5—
DN002@DNO007
Terrassement

Tome 2 - Chap.1—
DNO025

Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS5 et
DNO06

Dispositifs de retenue
Tome 8 — Chap. 3 —
DN GSR 003

Profils en travers
Tome 1 - Chap.5 -
DNOO2@DNOO7
Terrassement

Tome 2 - Chap.1-
DNO25

Structure de chaussée
Tome 2 — Chap.2 -
DNOO1, DNOOS et
DNOO6
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Nom Description Remarque(s) Référence(s) Image(s)
Type B,C,D,E,F Profil en travers d’'une o o = Dispositifs de retenue
(Glis) e refenele, = Un'e gII|55|ere lseml—rlglde de type W/BE/1905 est Tome 8 — Chap. 3 -
régionale, collectrice ou affiché par défaut. DN GSR 003
locale avec dispositif de = Les contraintes paramétriques devront étre =  Profils en travers
retenu ajustées en fonction du type de route désiré. Tome 1 - Chap.5-
DNO002@DNO007

= Terrassement
Tome 2 - Chap.1—
DNO025

=  Structure de chaussée
Tome 2 — Chap.2 -
DNO0O01, DNOOS et
DNO006
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Les profils en travers de cette catégorie sont utilisés dans un milieu en présence de tourbieres.

Consolidation par Profil en travers ) . o oG Tome 2 — Chap.1 - DNO13
surcharge d’une route a contrainte paramétrique EpaisSurchage permet

. . d’établir la hauteur de surcharge par rapport a la D it I =
nationale, régionale, ; gep PP =
. couche de sous-fondation.
collectrice ou locale

par consolidation par = Le composant SurfinitChargeReduite permet de
surcharge sur sol calculer le décapage par rapport a la surface de
organique terrain naturel selon I'épaisseur définie par la

contrainte paramétrique EpaisSurfinit(-0.9) par
défaut établie a 0,9 métre.

Consolidation sans Profil en travers Tome 2 —Chap.1-DNO014

surcharge d’une route . i_j?lcoz;c.ralmthe paramsztrlque TI;Zpa(ljsSIfonq1(?(15|oerr\net T
nationale, régionale, établir la hauteur de sous-fondation a 0,15 métre

. s’établissant dans la fondation.
collectrice ou locale

par consolidation = Le composant SurfinitChargeReduite permet de
sans surcharge sur sol calculer le décapage par rapport a la surface de
organique terrain naturel selon I'épaisseur définie par la

contrainte paramétrique £paisSurfinit(-0.9) par
défaut établie a 0,9 métre.

Déblai sol organique Profil en travers L S q leul Tome 2 — Chap.1 - DNOO7 S
(Epais) Fure rauE e composant RemblaiSousInfra permet de calculer

. - le dé rr rtal rf rrain
nationale, régionale, € (;JecalpafTIe pla,', a_pp° tz,""f,s‘f ace Ide e ta .

. natur n i r défini r ntrain
collectrice ou locale aw e,:e. 0 ;pa' ssse/tz) € Zﬁ‘a ta’(’:cobl' a\ 0e5
L aramétrique EpaisSolOrg par défaut établie a
en déblai de sol P a P gp ’

. meétre.
organique par
rapport a une
épaisseur déterminée

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif 181



Power InRoads (Conception)

Nom Description Remarque(s) Référence(s) Image(s)
Déblai sol organique (Surf) z'rlcj);ltleig;c::vers = Le composant RemblaiSousinfra permet de calculer Tome 2= Chap.1 - DNOO7 P
nationale, régionale, le décapage par rapport a la surface de terrain
collectrice ou locale naturel selon I'Iépaisseur définie par la contrainte m
en déblai de sol paramétrique EpaisSolOrg par défaut établiea 0 / \
metre. La condition de raccordement peut /

organique par
rapport a une surface
sondée

s’effectuer directement sur la surface sondée.
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Les profils en travers de cette catégorie sont utilisés pour calculer des volumes de tranchées.

= Au préalable, I'utilisateur aura généré les surfaces suivantes :

o Terrain naturel ;

o Roc (si applicable) ;

o Terrassement (ou infra) résultante de la surface alternative produite par le

s’il s’agit d’'une tranchée proposée ;

o Terrassement (ou infra) résultante d’'un sondage ou d’un décalage de la surface de terrain naturel en fonction de I'épaisseur de la chaussée existante jusqu’a I'infrastructure.

Tranchée Tranchée pour le calcul
d’excavation

Tranchée (Conduites) Tranchée pour le calcul
d’excavation avec
diverses conduites

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

Agencement des conditions de raccordement
Tranchée D, Tranchée G avec un fond
d‘excavation.

La largeur du fond d’excavation est controlée par
les contraintes paramétriques LargFondExc D et
LargFondExc_G.

Agencement des conditions de raccordement
Tranchée D, Tranchée G avec un fond d‘excavation
et diverses conduites.

Les fonds d’excavation peuvent étre controlés
horizontalement et verticalement par les radiers
des conduites a 'aide de I'outil du

Les rayons des diverses conduites peuvent étre
paramétrés par les contraintes paramétriques
suivantes :

RayonConduitel D;
RayonConduite2 D;
RayonConduitel_G;
RayonConduite2_G.

O O O O

Tome 2 — Chap.1 - DN021

Tome 2 — Chap.1 — DN021
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184

Tranchée (Ponceau Circ) Tranchée pour le calcul
d’excavation d’une

conduite circulaire

= Contraintes paramétriques :

o

DégagExc_D, assigne le dégagement du
point /nfra_Exc D par rapport a la paroi
extérieure droite de la conduite;
DégagExc G, assigne le dégagement du
point /nfra_Exc G par rapport a la paroi
extérieure gauche de la conduite;
EpaisCoussin, détermine la hauteur du
coussin entre le fond d’excavation et le
radier de la conduite;

EpaisHautFond, assigne la hauteur de
fondation par-dessus le ponceau;
EpaisPonceau, détermine I'épaisseur du
ponceau;

HautMaxTalDeb D, attribue la hauteur
maximale du bas de talus de déblai droit
par rapport au fond de I’excavation (point
Infra_Exc _D;

HautMaxTalDeb G, attribue la hauteur
maximale du bas de talus de déblai gauche
par rapport au fond de I’excavation (point
Infra_Exc_G;

HautPonceau, détermine la hauteur
intérieure du ponceau;

LargPortée, assigne la largeur intérieure du
ponceau;

PenteExc D, spécifie la pente d’excavation
droite de la conduite;

PenteExc G, spécifie la pente d’excavation
gauche de la conduite;

RayonTuyauExt, spécifie le rayon extérieur
de la conduite.

Tome 3 — Chap.4 —
DN0O02@005B , DNOO7A
et DNOO7B
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Nom Description Remarque(s)

Tranchée (Ponceau Rect)  Tranchée pour le calcul
d’excavation d’un

ponceau rectangulaire o

= Contraintes paramétriques :

DégagExc_D, assigne le dégagement du
point /nfra_Exc D par rapport a la paroi
extérieure droite du ponceau;

DégagExc_G, assigne le dégagement du
point /Infra_Exc_G par rapport a la paroi
extérieure gauche du ponceau;

EpaisCoussin, détermine la hauteur du
coussin entre le fond d’excavation et le
radier de la conduite;

HautMaxTalDeb_ D, attribue la hauteur
maximale du bas de talus de déblai droit
par rapport au fond de |’excavation (point
Infra_Exc_D;

HautMaxTalDeb_G, attribue la hauteur
maximale du bas de talus de déblai gauche
par rapport au fond de I’excavation (point
Infra_Exc_G;

PenteExc_D, spécifie la pente d’excavation
droite de la conduite;

PenteExc G, spécifie la pente d’excavation
gauche de la conduite.

Référence(s)

Tome 3 — Chap.4 — DN0OO1
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Type B,C,D,E,F (Transition) Profil en travers d’une . . Tome 2 — Chap.1 — DN021
. Gabarit servant au calcul de quantité de la
route nationale,

. . surexcavation de la transition longitudinale 1:20 a
régionale, collectrice ou . ) . N
locale partir du début de la profondeur P a gauche et a

droite de la tranchée.
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Les profils en travers de cette catégorie sont utilisés dans un milieu urbain (drainage fermé).

= |l est fortement recommandé de définir au préalable toute la géométrie en plan d’un projet en milieu urbain. On entend par géométrie, les voies, les bordures, les trottoirs, les flots, etc.

Par la suite, il sera possible d’accrocher les différents points des profils en travers sur la géométrie a I'aide de I'outil

dans le

= Pour augmenter le nombre de voies, on peut insérer dans les profils en travers, des points Marqu entre le CL et la Rive (droite ou gauche) et ajuster les parametres horizontaux et de
pentes ou utiliser le gabarit Urbain (Centre) en y combinant le c6té droit ou gauche d’un profil en travers de bordure ou de trottoir.

Urbain (AccGra)

Urbain (Bord — Multi)

Urbain (Bord)

Profil en travers d’une
route nationale, régionale
collectrice ou locale avec
accotement en gravier

Profil en travers d’une
autoroute, route
nationale, régionale
collectrice ou locale avec
bordure

Profil en travers d’une
autoroute, route
nationale, régionale
collectrice ou locale avec
bordure
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Ce profil en travers sert généralement a la
transition entre un milieu rural et urbain.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Agencement d’un profil en travers urbain avec
bordure et condition de raccordement avec
multiple talus.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5—
DNO0Q9, DNO10 et
DNO13
Terrassement
Tome 2 - Chap.1 -
DNO025

Profils en travers

Tome 1 - Chap.5 -

DNO009, DNO10 et

DNO13

Terrassement e
VN I

Tome 2 - Chap.1-

DNO025

Profils en travers
Tome 1 - Chap.5 -
DNO009, DN010 et ‘
DNO13

Terrassement u ‘ 7
Tome 2 - Chap.1 -

DNO025
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Nom
Urbain (Carrefour-Bord) (D)

Description

Profil en travers d’'une
autoroute, route
nationale, régionale,
collectrice ou locale coté
droit pour un exemple
pour de traitement d’un
carrefour en milieu urbain

Remarque(s)

Le point Rive_D est le point d’insertion du gabarit.

Le point CL doit étre contrélé :

O

horizontalement et verticalement sur le
point de corridor CL ou Rive (droite ou
gauche) sur la voie principale jusqu’a
I'intersection entre cette ligne et le CL de la
voie secondaire;

horizontalement et verticalement sur le CL
de la voie secondaire de I'intersection
jusqu’a l'intersection avec la Rive (droite ou
gauche) ou le CL de la voie principale.

Référence(s) Image(s)

=  Profils en travers
Tome 1 - Chap.5 - /
DNO009, DN010 et —_— <
DNO013

= Terrassement
Tome 2 - Chap.1 -
DNO025

188
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Urbain (Carrefour-Bord) (G)

Urbain (Centre)

Urbain (Glis - Bord)

Profil en travers d’une
autoroute, route
nationale, régionale,
collectrice ou locale coté
gauche pour un exemple
pour de traitement d’un
carrefour en milieu urbain

Structure de chaussée
représentant le centre

Profil en travers d’une
autoroute, route
nationale, régionale
collectrice ou locale avec
bordure et dispositif de
retenu
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= Le point Rive G est le point d’insertion du gabarit.
= Le point CL doit étre contro6lé :

o horizontalement et verticalement sur le
point de corridor CL ou Rive (droite ou
gauche) sur la voie principale jusqu’a
I'intersection entre cette ligne et le CL de la
voie secondaire;

o horizontalement et verticalement sur le CL
de la voie secondaire de I'intersection
jusqu’a l'intersection avec la Rive (droite ou
gauche) ou le CL de la voie principale.

= Cette structure est utilisée pour définir deux voies
supplémentaires lorsque I'on désire passer d’'une
chaussée deux voies a une chaussée quatre voies.

= Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5—
DNO009, DN010 et
DNO013
Terrassement
Tome 2 - Chap.1—
DNO025

Dispositifs de retenue
Tome 8 — Chap. 3 - DN
GSR 003

Profils en travers

Tome 1 - Chap.5 —
DNOOQ9, DNO10 et DNO13
Terrassement

Tome 2 - Chap.1 — DN025

o

i

e e S

Il
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Urbain (Terre-plein - Bord)

Urbain (Terre-plein - Trot)

190

Profil en travers d’une
autoroute, route
nationale, régionale
collectrice ou locale avec
bordure et affichage d’un
terre-plein sur demande
(CLinchangé)

Profil en travers d’une
autoroute, route
nationale, régionale
collectrice ou locale avec
trottoir et affichage d’'un
terre-plein sur demande
(CL inchangé)

Les points /lot D et llot G permettent I'affichage
d’un terre-plein au centre lorsque la valeur entre
ces deux points est plus grande que 0. Ils peuvent
étre contrélés horizontalement par des

ou des dans le

Le point CL demeure au centre de I'alighement
horizontal et vertical peu importe si le terre-plein se
déplace de droite a gauche.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Les points /ot D et llot G permettent I'affichage
d’un terre-plein au centre lorsque la valeur entre
ces deux points est plus grande que 0. lls peuvent
étre contrélés horizontalement par des

ou des dans le

Le point CL demeure au centre de I'alighement
horizontal et vertical peu importe si le terre-plein se
déplace de droite a gauche.

Les contraintes paramétriques devront étre
ajustées en fonction du type de route désiré.

Profils en travers
Tome 1 - Chap.5-
DN008@013 it
Terrassement D ‘ ‘ 7

Tome 2 - Chap.1 -

DNO025

— Ly
Profils en travers
Tome 1 - Chap.5 - > 4
DN008@013 SRS M o
Terrassement % | ﬁ
Tome 2 - Chap.1—
DNO025

S
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Urbain (Terre-plein) Structure de chaussée au
centre avec affichage d’un
terre-plein sur demande
(CLinchangé)

Urbain (Terre-plein CL) Structure de chaussée au
centre avec affichage d’un
terre-plein sur demande
(CL décalé au milieu du
terre-plein)
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Cette structure est utilisée par défaut dans les
profils en travers urbains avec terre-plein.

Les points /lot_D et llot_G permettent I'affichage
d’un terre-plein au centre lorsque la valeur entre
ces deux points est plus grande que 0. lls peuvent
étre contrélés horizontalement par des

ou des dans le

Le point CL demeure au centre de I'alignement
horizontal et vertical peu importe si le terre-plein se
déplace de droite a gauche.

Les points Ctrl_D et Ctrl_G permettent I'affichage
d’un terre-plein au centre lorsque la valeur entre
ces deux points est plus grande que 0,6 métre. lls
peuvent étre controlés horizontalement par des

ou des dans
le

Le point CL se décale par rapport au milieu du terre-
plein. L’alignement horizontal est décalé mais
I'alignement vertical demeure égal.
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Description Remarque(s) Référence(s)

Urbain (Trot) Profil en travers d’'une . L R = Profils en travers
autoroute, route = Lgs ccl)ntramtes pérametrlques devront (let.rel Tome 1 - Chap.5 —
nationale, régionale ajustées en fonction du type de route désiré. DN009, DNO10 et
collectrice ou locale avec DNO013
trottoir = Terrassement

Tome 2 - Chap.1 -
DNO025
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Tables des dévers

Le répertoire Preferences/TableDevers contient les tables de dévers utilisées dans le Roadway Designer (Superelevation > Create Superelevation Wizard > Table) pour assigner a chacune des
courbes d’un tracé, une longueur de transition et une valeur de dévers en fonction de vitesses de conception et d’'un nombre de voies.

Les fichiers SUP se réféerent aux données de conception du Tome 1 — Chap.6 des normes sur les Ouvrages Routiers.
lIs ont été générés a partir des tableaux suivants :

= Dévers et longueurs de raccordement pour courbes circulaire sans spirale en milieu urbain a faible vitesse, emax= 0,04 m/m

= Dévers et longueurs pour courbes de raccordement (spirale) en milieu urbain a faible vitesse, €m.x= 0,04 m/m

= Dévers et longueurs de raccordement pour courbes circulaires sans spirale, emsx= 0,06 m/m en milieu urbain a haute vitesse et en milieu rural
= Dévers et paramétre minimal de spirale pour courbe circulaire, emax= 0,06 m/m en milieu urbain a haute vitesse et en milieu rural

= Longueurs de transition (Runoff) de 0 % au plein dévers

= Valeur en pourcentage du plein dévers (Full Super)

Normal Crown

>

>

Full Super

Bombement
normal

& P&

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

193


http://www2.publicationsduquebec.gouv.qc.ca/transports/html/1c6.html

Power InRoads (Conception)

Tables des surlargeurs
Le répertoire Preferences/TableSurlargeurs contient les fichiers de surlargeurs utilisées dans le Roadway Designer (Tools > Curve Widening) pour assigner une surlargeur d’accotement pavé a
I'intérieur des courbes d’un tracé en fonction d’un véhicule de type WB-20, d’une vitesse de conception et d’un type de route (B,C,D).

Les fichiers WID se référent aux données de conception du Tome 1 — Chap.5 des normes sur les Ouvrages Routiers.

Ils ont été générés en fonction du tableau suivant :
= FElargissement de la chaussée dans une courbe en fonction d’une semi-remorque (WB-20)

NI

(1) Laccotement doit conserver la méme largeur dans une courbe ol les voies ont été élargies.
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Fichiers de validations de tracés en plan

Les fichiers CheckHorizMTQ2019_FaibleVitesse.txt et CheckHorizMTQ2019_HauteVitesse.txt sont utilisés avec les outils Geometry > Horizontal Curve Set > Design Criteria et Geometry >
Horizontal Curve Set > Define Curve afin de déterminer le rayon minimum, le coefficient de frottement latéral et le dévers maximal en milieux rural et urbain a haute vitesse et en milieu urbain
a basse vitesse pour la conception des courbes horizontales d’un tracé.

Les fichiers TXT se référent aux données de conception du Tome 1 — Chap.6 des normes sur les Ouvrages Routiers.

lIs ont été générés en fonction des tableaux suivants :

Fichier de validation de profil en long
Le fichier CheckVertMTQ2019.txt est utilisé avec les outils Geometry > Vertical Curve Set > Design Criteria et Geometry > Vertical Curve Set > Define Curve afin de déterminer les longueurs
minimums de paraboles d’un profil a utiliser, en fonction d’une vitesse de conception.

Le fichier TXT se référe aux données de conception du Tome 1 —Chap.6 et Tome 1 — Chap.7 des normes sur les Ouvrages Routiers.

Il a été généré a partir des tableaux suivants :
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Fichier pour le module Drafting

Le fichier DraftingMTQ2019.dft est utilisé avec les outils du menu . Ce menu est utilisé pour placer diverses annotations en interaction avec les fichiers spécifiques a InRoads. Par exemple,
si on place une annotation en plan identifiant le chainage/offset d’un point et que I'on change le chainage par la suite, I'annotation se verra transformée avec les nouvelles valeurs en effectuant
une mise a jour des annotations ( ).

Ch_Off Chainage et offset d’un point

Ch_off_EI(ElémGraphique) Chainage, offset et élévation d’un point selon I'élévation de I’entité graphique
Ch_Off_EI(ElémSurface) Chainage, offset et élévation d’un point selon I'élévation d’une surface

Chainage Chainage

Coord_ChYXZ (ElémGraphique)  Chainage, coordonnées et élévation d’un point selon I’élévation de I'entité graphique
Coord_ChYXZ (ElémSurface) Chainage, coordonnées et élévation d’un point selon I'élévation d’une surface

Coord_YX Coordonnées d’un point

Limite Travaux Chainage et indication de limite des travaux

PonceauPente Type de ponceau, classe, diametre, chainage de départ et longueur d’une entité graphique linéaire
PonceauRadier Chainage, offset et élévation (affiché comme Radier) d’un point selon I'élévation de I’entité graphique
Ch_Off Chainage et offset d’un point

Conduite(ElémGraphique) Type de ponceau, classe, diameétre, longueur horizontale et pente

Conduite(ElémSurface) Type de ponceau, classe, diameétre, longueur horizontale et pente

ConduiteRadier Elévation d’un radier

Longueur_Pente Longueur horizontale et pente d’une entité graphique linéaire

Elévation Elévation d’un point

Off_El Offset et élévation d’un point

Pente Pente d’une entité graphique

Pente_Longueur(Elément) Longueur et pente d’une entité graphique

Pente_Longueur(Repére) Longueur et pente entre deux points sélectionnés a I’écran.
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Fichier pour le module Drainage

Le fichier DrainagelDF.idf est utilisé avec les outils du menu Drainage. Dans la commande File > Project Defaults, on assigne ce type de fichier dans la partie Rainfall Data. Il s’agit ici d’un fichier
exemple pour définir un tableau afin de calculer I'intensité, la durée et la fréquence d’accumulation d’eau selon des scénarios définis en années. Les données de ce tableau devront étre modifiées
en fonction de la zone du projet. Ces données sont disponibles sur le site d’Environnement Canada. |l permet de déterminer I'injection d’eau dans une aire ou un réseau donné.

Le fichier DrainageRapportsMTQ2019.rpl sert a paramétrer les différents rapports produits par le module. On utilise ce fichier par la fonction Tools > Drainage > Reports.

Le fichier DrainageStructMTQ2019.dat est utilisé avec les outils du menu Drainage. |l s’agit du fichier de structure qui sert a paramétrer les propriétés des types de conduites, de ponceaux, de
regards, de puisards, de pompes ou de fossés. On peut également y définir les styles pour I'affichage. On utilise ce fichier par la fonction Tools > Drainage > Structures File.

Fichier pour le module Quantity Manager
Le fichier QmMTQ2019.mdb est une base de données qui contient tous les articles au bordereau de paiement tel que défini par le Ministere. Celui-ci fonctionne avec les outils du menu Quantities
(applications complémentaires) du logiciel.

Pour le moment, ce fichier demeure un projet qui, lorsqu’il sera opérationnel et complété, permettra d’associer des éléments de surfaces a des items au bordereau. Le but de cette démarche est
de fournir aux concepteurs et ingénieurs, des rapports qui pourront étre annexés directement aux devis d’un projet.

Fichier pour le module Modeler

Le fichier SiteMTQ2019.spf est utilisé avec les outils du menu Site Modeler (application complémentaire). Il sert a paramétrer les différents types d’affichage lorsque I'on veut effectuer
I'aménagement d’un site. On entend par aménagement de site la conception de stationnement, de plateforme de batiment, de bassin de rétention, etc. Ce type d’intervention est rarement
effectué au Ministere.

Fichiers pour le module Survey
Les fichiers TIW sont utilisés avec les outils du menu Survey. lls servent a I'importation de données provenant de divers types d’appareil d’arpentage.
= TRIMBLE CSV données CSV provenant d’'un GPS de la compagnie Trimble.

= MCP_RAW données RAW provenant de Vision Terrain (auparavant Multicarnet) de la compagnie Géo-Plus.
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Requétes SML/Gemini

Norme2013

#1632
o

#1633

#1634

#2005

#2006

#2006

#2157

#2238

Tools > Named Symbology Manager. Ajout des styles (SURF) Pont pour représenter une surface de pont et (SURF) EauJour, pour une surface d’eau du jour.

Tools > Named Symbology Manager. Ajout des symbologies pour affichage en section pour les styles PBA, TTO, TTP, TBA sur le calque E-DRA-PONCEAU.

Geometry > View Geometry > Stationing. Ajout des préférences (GEO) LignRefExist et 1:500 — Text inv. (Existant) pour des annotations automatiques sur les alignements horizontaux
existants.

Geometry > View Geometry > Vertical Annotation. Ajout de la préférence (GEO) LignRefExist pour des annotations automatiques sur les alignements verticaux existants.

GabMTQ2013.itl. Ajout des gabarits Type B,C,D,E,F - Transition Sol-Roc (D) et Type B,C,D,E,F - Transition Sol-Roc (G).

GabMTQ2013.itl. Ajout du gabarit Type B,C,D,E,F (Isolant).

GabMTQ2013.itl. Ajout des gabarits Type B,C,D,E,F - Elarg (Racc RiveExist - FondInf), Type B,C,D,E,F - Elarg (Racc RiveExist) et Type B,C,D,E,F - Elarg (Racc TN - FondInf).

Geometry > View Geometry > Vertical Annotation. Ajout des préférences (GEO) FosseGauche et (GEO) FosseDroit pour des annotations automatiques sur les alignements verticaux
représentant des fossés.

Preferences/TableDevers. Correction des tables de dévers 04_30K_2013.sup @ 04_80K_2013.sup.
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Norme2014
#2313
o Preferences/TableSurlargeurs. Ajustement des tables de surlargeurs dans les courbes en fonction d’un véhicule WB-20.
#2323
o Drafting > Place Coordinate Grid. Ajustement des préférences Defaut et 1:1000 pour les affixes, les espacements. Suppression de la préférence Effacer.
#2324
o Geometry > View Geometry > Stationing. Correction du nom de la préférence 1:500 — Texte inv. (Existant) et du positionnement des points cardinaux.
#2388
o GabMTQ2014.itl. Ajout du gabarit Type Chemin Gravier.
#2465
o GabMTQ2014.itl. Ajouts de profils en travers ruraux pour les carrefours giratoires.
#2466
o GabMTQ2014.itl. Correction du style AccPav pour le composant BbSurface dans les gabarits de carrefours giratoires.
#2467
o GabMTQ2014.itl. Ajouts de profils en travers sur roc pour les carrefours giratoires.
#2468
o GabMTQ2014.itl. Ajout du profil en travers Type B,C,D,E,F - Roc (Bord) dans la catégorie Profils en travers/Ruraux 1¢" et 2¢ classe.
#2478
o Geometry > View Geometry > Curve Set Annotation. Suppression du suffixe m pour la constante de spirale A.
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#2480
o Geometry > View Geometry > Stationing. Affichage de la constante de spirale A plut6t que la longueur dans toutes les préférences.
#2499
o GabMTQ2014.itl. Ajout des gabarits Resurfacage Piste et Tumulus dans un nouveau dossier Profils en travers/Aéroportuaires.
#2524
o Tools > Named Symbology Manager. Ajout de la symbologie (GEO) PtEvenTemp pour affichage de points événements temporaire.
#2525
o Tools > Named Symbology Manager. Ajout de la symbologie (DRAFT) Temp pour effectuer des annotations temporaires a partir du menu Drafting.
#2543

o GabMTQ2014.itl. Modifications des conditions de bermes inférieures pour les profils en travers Type A — Roc (Bermelnf), Type B,C,D,E,F - Roc (Bermelnf) et Type D,E,F - Roc (Sans AccPav
- Bermelnf) dans la catégorie Profils en travers/Ruraux 1° et 2° classe.

#2544
o Tools > Style Manager. L'option Cross Section Display > Annotation a été activée pour le style Berme.
#2622
o GabMTQ2014.itl. Correction de la condition de raccordement Condition Complexe Remblai - Déblai (D) dans le dossier Conditions de raccordement/Rurales.
#2659
o Tools > Named Symbology Manager. Adaptation la norme CDAO 2014.
o Supression de la symbologie et du style:
o PTG
o Modification de la symbologie et du style :

LPN, LAC, MPI (Description)

RAT, RIP (Symbole)

TUF, TIF (Nouveau Symbole)

POE, PTR, PYL, PEL, PLT, MTI, REE, RCE, TES, PET, PTT, CEA, CTA, HAU, POG, PTL, PLR, PNI, PUV, BJT, POT, RET, RCT, BOD (Calque)
LAL, LAH, LPI, LAV (Calque, Description, Symbole)

PTE (Nouveau)

O O o0 O o0 O

200 Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif



Requétes SML/Gemini

#2691
o CivMTQ2014.xin. Adaptation a la norme CDAO 2014. Modification du style de texte mtqgroman pour Arial.
#2692
o Tools > Style Manager. Correction de la description du style (SURF) Surcharge.
#2593
o Tools > Named Symbology Manager. Ajout des symbologies et styles RtTn_Inv et HtTn_Inv pour des styles de traits inversés. Modification de la symbologie Glis_G.
#2694
o Preferences/TableDevers. Mise a jour selon les normes. Correction des tables 04_30K_2013.sup @ 04_80K_2013.sup et spi04_30K_2013.sup @ spi04_80K_2013.sup.
#2696
o GabMTQ2014.itl. Ajout de profils en travers (4 voies) pour tous les gabarits de |la catégorie Réhabilitation de chaussée et Type B,C,D,E,F (4 voies) de la catégorie Ruraux - 2e classe.
#2703
o GabMTQ2014.itl. Suppression des Feature Name Override HtRoc et BermeSup des gabarits possédant des conditions de raccordement de roc.
#2704
o GabMTQ2014.itl. Ajout des gabarits Bordure (Param) (D) et Bordure (Param) (G) dans la catégorie Composants/Bordures.
#2705
o GabMTQ2014.itl. Correction de la hauteur de la bordure des gabarits Enrobée (D) et Enrobée (G) dans la catégorie Composants/Bordures.
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Norme2015

Power InRoads (Plateforme)

#2084
o

o

#2146

#2401

#2487

202

Répertoire Bentley/Norme2015/Images/SIGN renommé Bentley/Norme2015/Images/SIG.

Bentley/Norme2015/Images/SIG. Modification des fichiers en format PNG au lieu de TIF pour en réduire la taille.

Transfert des fichiers PAL dans le répertoire Bentley/Norme2015/Support/

Modification du nom de la palette mtq2014 par mtq_textures pour assurer une intégrité des fichiers lors d’'une mise a jour de la norme.
Ajout de la palette mtq_panneaux.pal contenant les images des panneaux de signalisation.

Correction des palettes des cellules 3D, des DGNLIB de mtq201X.pal par mtq_textures.pal.

mtq2015.cel et mtq2015_niveaux.dgnlib. Modification de la cellule QUADPROF. Ajout des niveaux suivants :
o PRO-GRILLE-AXE, PRO-GRILLE-MAJEURE, PRO-GRILLE-MINEURE
o SEC-GRILLE-AXE, SEC-GRILLE-MAJEURE, SEC-GRILLE-MINEURE

mtg2015 > modification_mtq. Ajout de I'outil Edition de cartouche permettant d’éditer et/ou mettre a jour les attributs d’un cartouche.

mtq2015_textdim.dgnlib. Ajout du style de cotation Hexagone pour I'ajout d’un numéro de point sur le niveau GEO-POINT-HEXAGONE en remplacement du bloc dynamique
NUMPOINTZ2 disponible sous AutoCAD.

mtq2015.cel. Ajout de la cellule POTELECSEC représentant un poteau électrique en section.

mtq2015.cel. Correction des cellules NUMAUTO, NUMAUTO_DIR, NUMROUTE et NUMROUTE _DIR. Les cellules s’affichent correctement lors de I'insertion.
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#2738 - 2794

o mtq2015.cel. Les extrémités biseautées (BUSES) sont incluses dans la barre de taches. Pour I'insertion du symbole a gauche plutot qu’a droite, il est possible d’activer I'option Mirror
Vertical dans I'outil Place Cells (Placer cellules). Enlevement du point d’insertion.

#2743

o PresentConcep.dgn et PresentArpent.dgn. Mise a jour de la légende du modeéle \/-2381 en fonction des cellules ajoutées dans cette norme.
#2747

o mtq2015_niveaux.dgnlib. Le niveau DRA-EGOUT-REFOULE a été remplacé par SER-EGOUT-REFOULEMENT.
#2763

o mtq2015.cel. Remplacement des cellules ECHELHOR et ECHELVER par la bibliotheque de cellules echel_dyn.cel.
#2795

o PresentConcep.dgn et PresentArpent.dgn. Remplacement de 8 étiquettes dans plusieurs cartouches.
#2832

o mtq2015.cel. Correction des cellules TELQUECO pour spécifier qu’il s’agit d’un plan final de I'ouvrage tel que construit.
#2833

o mtq2015.cel. Retrait des cellules SCEAU et SCEAU _E.
#2840

o mtq2015_niveaux.dgnlib. Ajout des statuts a démolir (D-) et tel que construit (C-) pour le niveau MOD-FRONTIERE.
#2847

o PresentConcep.dgn et PresentArpent.dgn. Suppression de I'étiquette CRT /D TECH H dans plusieurs cartouches.
#2908

o mtq2015.cel. Modification de la cellule PLANTELL.
#2916

o mtq2015.cel. Modification des cellules de type point par graphique dans la bibliothéque a I’exception des cellules de repéres et de regards.
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#2920
o

o

#2921

#2922

#2923

#2924

#2925

Ajout du style d’affichage MTQ_ Pente pour la vue 7 du prototype mtq2015_3D.dgn permettant I'affichage du modele selon un code de couleur en élévation.

Ajout du style d’affichage MTQ_FElévation pour la vue & du prototype mtq2015_3D.dgn permettant I'affichage du modéle selon un code de couleur de pente.

mtg2015 > modification_mtq. Ajout des outils Définir la Direction Générale, Définir la Direction Territoriale et Définir le service permettant de définir les étiquettes d’un cartouche.

mtg2015 > parammodel_mtq. Ajout d’un outil permettant de définir un systéme de coordonnées en fonction d’une direction territoriale.

mtq2015_3D.dgn. Correction de I'assignation de la bibliotheque de cellules mtq2015.cel dans le prototype pour permettre I'affichage adéquat des symbologies des Features d’'une
surface lors de la création d’'un nouveau modele Design.

Les modeles Présentationl et Présentation2 ont été retirés de tous les prototypes.

Les cartouches servant a I'impression des sections en travers ont été déplacés dans le répertoire \Bentley\Norme2015\Preferences\Sections\. Ajout du format LEGAL et ajustement du
format TABLOID pour les mandataires et a I'interne au Ministére.

#2927-#4014

o
#2928

©)

#2929

204

mtg2015.lin. Correction du fichier afin que les styles de trait s’affichent correctement lors de I'importation.

mtq2015 > fichier_mtq > Convertir en DWG. Correction des options de sauvegarde. Le fichier MTQ_convertDWG.bcnv était localisé dans le répertoire TEMP ce qui occasionnait des
problémes lorsque celui-ci était supprimé.

mtg2015 > PAP. Amélioration et correction de I'outil. Le style de trait et I'épaisseur ne sont plus sur des attributs forcés. Il est possible maintenant de sélectionner une échelle de
dessin puis un format de papier qui définit Iaire.
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#2930

o

#2931

#2932

#2933

#2934

#2935

#2937

mtg2015 > dessin_mtq > Impression de sections en travers. Amélioration et correction de I'outil. L’outil fait un scan de toutes les sections créées par les préférences LEGAL100,
LEGAL200, TABLOID100 et TABLOID200 de I'outil InRoads Evaluation > Cross Section > Cross Sections > Create Cross Section et les classifient dans un dossier distinct soit LEGAL et
TABLOID dans I'outil Print Organizer.

mtq2015_niveaux.DGNLIB. Fichier contenant tous les niveaux de la norme CDAO 2015 incluant les niveaux pour la modélisation 3D.

mtq2015 > dessin_mtq. Ajout d’'une barre d’outils servant a créer des éléments d’'un modele.
mtg2015 > modification_mtq. Ajout d’une barre d’outils servant a modifier les éléments d’un modele.

mtq2015_textdim.DGNLIB. Fichier contenant les styles de texte et les styles de cotation de base d’'un modele.

mtq2015.cfg. Ajout d’une seconde variable MS_DGNLIBLIST pointant vers le répertoire C:\Users\<nom usager>\Documents\Bentley\MTQ\<nom usager>_V8i. Ceci permet a
I"utilisateur de se créer des fichiers DGNLIB dans ce répertoire et ils sont modifiables. Le fichier <nom usager>_V8i.DGNLIB est présent a titre d’exemple.

mtq2015.cfg, mtq2015.pcf. Suppression des variables TMP, MIS TMP et MIS BACKUP.

mtq_pdf.pltcfg, mtq_pdf_CTB.pltcfg, RGB_B2W.pen. Ajout de fichiers de configuration d’impression PDF incluant les différents formats de papier utilisés au Ministére. De plus, le
fichier mtq_pdf_ctb.pltcfg définit les parameétres pour I'utilisation de la table de plume mtq2015(monochrome).ctb et un script correctif RGB_B2W.pen pour les masques d’un dessin
DWG.

mtq2015 > fichier_mtqg > Connexion au Service Vidéo Numeérique. Ajout d’un outil permettant de se connecter au service vidéo numérique (SVN) par un simple clic sur un alignement
de référence. Un systéeme de coordonnées doit étre défini au préalable. Fonctionne uniquement sur le domaine MTQ.

mtg2015 > fichier_mtq > Générateur de rapport XML (GRX). Ajout d’une icbne permettant de démarrer I'application complémentaire GRX. L’icne est visible seulement si I'application
est installée sur le poste.

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif 205




Requétes SML/Gemini

#2938

©)

#3894

#3954

#3972

#3973

206

mtq2015 > modification_mtq. Des outils permettent maintenant de sélectionner I'échelle d’insertion pour I'aire, de sélectionner le format de papier, d’assigner la direction générale, la
direction territoriale et le service et de mettre a jour I'information dans le cartouche.

47pc_mtq2015(couleur).ctb, 47pc_mtq2015(couleur).ctb, mtq2015(monochrome).ctb et mtq2015(couleur).ctb. Modification de |’opacité des couleurs 245 et 255 (1%) dans tous les
fichiers CTB.

mtq2015 > fichier_mtq > Charger AutoTURN. Ajout de I'utilisation de la version 9 de I'application. L’'icone permet également de décharger 'application au besoin.

mtq2015 > fichier_mtq > Charger Descartes. L'icone permet de décharger I'application afin de retourner la licence au serveur.

mtqgb_Norme2015.bat. Lors de l'installation des fichiers de configuration, les fichiers sont installés localement sur le poste dans le répertoire racine du logiciel
(C:\ProgramData\Bentley\PowerInRoads V8i\WorkSpace\Projects\MTQ_Norme2015) permettant de travailler en mode local.

mtq2015 > fichier_mtq > Exporter les configurations réseau localement. Permet de copier les fichiers de configuration du réseau vers le répertoire MTQ_Norme2015 local a I'aide du
fichier mtqb_ ExportLocal.bat.

mtq2015.cel. Ajout des cellules CH DEBUT+FIN, PROJET NE, PROJET NO, PROJET SE et PROJET SO servant a la localisation des projets.

mtq2015_niveaux.dgnlib. Ajout des niveaux suivants :

o E-SEC-ARGILE, E-SEC-AUTRE, E-SEC-TNAERO, E-SEC-TNCONYV, E-SEC-TNMNA, E-SEC-TNMOBILE, E-SEC-TNPHOTO, E-SEC-TNTQC

o E-PRO-ARGILE, E-PRO-AUTRE, E-PRO-TNAERO, E-PRO-TNCONV, E-PRO-TNMNA, E-PRO-TNMOBILE, E-PRO-TNPHOTO, E-PRO-TNTQC

mtq2015_niveaux.dgnlib. Ajout d’un filtre de niveaux Existant-Projeté permettant de faire afficher uniguement les niveaux dont le statut est existant et projeté.

Bentley\Norme2015\Documentation. Ajout des documents pour I'explication de la norme. Modification de la tdche Documentation pour pointer sur ce répertoire.
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#4053

o

#4055

#4063

#6093

#6095

#7087

#7092

PresentConcep.dgn et PresentArpent.dgn. Remplacement de I'étiquette CRT_SERVICE par CRT_SERVICE 1 et CRT_SERVICE_2 dans plusieurs cartouches.

(2D) SIG-PAN-TRAVAUX.cel. Ajout de panneaux de signalisation de travaux dans la bibliotheque de cellules.

(3D) SIG-ECL.cel. Ajout de nouveaux équipements d’éclairage (Caisson, flts, potences, massifs et couronnes).

mtq2015 > dessin_mtq > Placer Annotation — Plan ou Placer Annotation — Profil ou Placer Annotation — Section.
positionnement d’annotation en plan, en profil et en section en travers selon différentes méthodes.
mtg2015 > dessin_mtq > Placer Annotation — Surface. Utilitaires pour annoter des surfaces.

mtq2015_niveaux.dgnlib. Ajout de priorités dans les niveaux.

PresentConcep.dgn. Correction du modeéle V-2381 pour éliminer des lignes de géométrie erronées.

Outils provenant du menu /nRoads Drafting permettant le

mtg2015 > modification_mtq > Supprimer le remplissage des composants. L'outil ne fonctionnait pas pour les composants d’un dessin en format DWG. 1l fonctionne maintenant pour

le mode DWG et DGN.

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif

207




Requétes SML/Gemini

Power InRoads (Conception)

#2146

o

#2926

#2939

#2940

#2941

#2942

#2943

Evaluation > Cross Section > Cross Sections > Create Cross Section et Evaluation > Profile > Create Profile. Les niveaux P-PRO-GRILLE et P-SEC-GRILLE servant a |’affichage général des
quadrillages ont été séparés par ...-GRILLE-AXE pour les lignes d’axe, ...-GRILLE-MAJEUR pour les lignes de quadrillage majeures et ...-GRILLE-MINEUR pour les lignes de quadrillage
mineures. Les lignes de quadrillages étant sur une couleur par niveau et sur des niveaux distincts, celles-ci seront plus facilement modifiables que par une couleur forcée sur un seul

niveau. Toutes les préférences ont été ajustées.

Evaluation > Cross Section > Cross Sections > Create Cross Section. Remplacement des préférences VIS 100 et MS 200 par TABLOID100 et TABLOID200. Ajout des préférences

LEGAL100 et LEGAL200.

Mise a jour des liens de la section Fichier GabMTQ2015.itl.

Correction de I'image de la section Fichier GabMTQ2015.itl > Bretelles.

CivMTQ2015.xin. Le fichier XIN est lié au fichier mtq2015_tasks.dgnlib pour I'utilisation des styles lors de I'utilisation des outils Civil.

Preferences/TableDevers. Mis a jour selon les normes.

Preferences/TablesSurlargeurs. Correction des espaces et des colonnes des fichiers WID. Mis a jour selon les normes.

CheckHorizMTQ2015_FaibleVitesse.txt et CheckHorizMTQ2015_HauteVitesse.txt. Mise a jour selon les normes

ChecksVertMTQ2015.txt. Ajout des valeurs en fonction d’une vitesse de 120km/h.

DrainageStructMTQ2015.dat, DrainageRapportsMTQ2015.rpl. Adaptation des fichiers pour le module de Drainage.

QmMTQ2015. Adaptation du fichier de calcul des quantités.
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#2946
o SiteMTQ2015.spf. Adaptation des fichiers pour le module Site Modeler.
#2947
o MCP_RAW.tiw, TRIMBLE_CSV.tiw. Adaptation des fichiers pour le module Survey.
#3962
o Tools > Named Symbology Manager et Tools > Style Manager. Styles de surfaces pour les vues en profil et section.
o Modification des symbologies (SURF) Autre et (SURF) Argile.
o Ajout des styles et symbologies suivantes :

(SURF) TnConv
(SURF) TnAero
(SURF) TnMNA
(SURF) TnMobile
(SURF) TnPhoto
(SURF) TnTQC

O O O O O O

#3978

o Tools > Named Symbology Manager et Tools > Style Manager. Ajout de symbologies et styles permettant |'utilisation de couleurs pour représenter des variantes d’alignements
horizontaux et verticaux (ex. (GEO) LignRefProj-V/1).

#3981

o GabMTQ2015.itl. Correction de la valeur verticale par défaut des points Glisimpla 0,555m au lieu de 0,53m dans tous les gabarits contenant une glissiere de type W/BE/1905. Ajout d’un
point Glisimpl pour tous les gabarits avec glissiere de type W/A/1905 et W/AE/1905. Ajout du point Glisimpl dans la liste des noms de points (Point Name List).

#4052
o GabMTQ2015.itl. Modification des points AccPavint par AccPav du gabarit Pont (Gliss 210B) de la catégorie Ouvrages d’art.
#4054

o GabMTQ2015.itl. Correction du style FosCL D par FosCL G sur les points FosCL1 G et FosCL G pour le gabarit Condition Complexe Remblai-Déblai (G) de la catégorie Conditions de
raccordement.
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#4062
o GabMTQ2015.itl. Correction des contraintes verticales des points Fond Chev et Fond CL pour les gabarits a trois couches de pavage de la catégorie Réhabilitation de chaussée.
#6089

o Tools > Named Symbology Manager et Tools > Style Manager. Ajout de symbologies et styles permettant I'utilisation de couleurs pour représenter des variantes de couche gabarit (ex.
(SURF) Gabarit_V1).

#6090

o GabMTQ2015.itl. Correction des composants RembHorsStruct G et RembHorsStruct D qui empiétaient sur les bordures du gabarit Type B,C,D,E,F (Glis — Bord) de la catégorie Rural — 2e
classe.
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Requétes SML/Gemini

Norme2015v2

Power InRoads (Plateforme)
#9321

o mtq2015v2. Refonte compléete de barre de taches pour résoudre un probleme de lenteur et pour faciliter I'utilisation.
#9325

o  mtq2015v2 > mise_en_page_mtq > Définir le service. Correction de I'étiquette Service par la suppression du «s» a la fin.
#9343

o ParamPowerInRoads2015v2. Correction de la table des matieres pour permettre I'acces spécifiques aux répertoires de gabarits.

o mtq2015v2 > fichier_mtg. Correction du nom de serveur pour les orthophotos (SCO).

o ParamPowerInRoads2015v2. Ajout des liens internet manquants dans la documentation.

o mtq2015v2 > fichier_mtg. Déplacement de I'outil Impression de sections en travers dans la barre d’outils fichier_mtq.

o  mtq2015v2 > cotation_mtq > Cotation arc. Modification de I'outil pour permettre I'affichage d’une cotation d’arc en longueur ou en angle.
o mtq2015v2 > cellules_mtq > Sélectionner cellules. L'outil ne fonctionnait pas.

o  mtq2015v2 > parammodel_mtg et mise-en-page_mtqg. Correction des directions générales et directions territoriales pour la sélection de syst. de coord. et d’étiquette de cartouches.

Power InRoads (Conception)
#9268

o Tools > Named Symbology Manager. Correction du style de trait pour la symbology Glis_G.
#9289

o DraftingMTQ2015v2.dft. Drafting > Place Cross Section Note. Correction des paramétres du texte pour la note Section 1:100 > Elévation.
#9279

o Evaluation > Profile > Create Profile > Grid > General. Corrections de toutes les préférences. Désactivation de la symbologie Minor Horizontal car deux lignes superposées étaient
affichées pour chaque ligne horizontale.
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Requétes SML/Gemini

Norme2016

Power InRoads (Plateforme)
#2634 —2701 - 2837 — 2887 —2888 — 7131 — 3999 — 8209

o mtmdet2016_niveaux.dgnlib et mtmdet2016_tasks.dgnlib. Ajout des calques et taches :
DRA-MUR
VOI-GLI-TOL-ACI-2F
E-GEO-IMA
P-GEO-GIRATION
P-GEO-SIMULATION
P-VOI-CLO-CHANTIER
P-VOI-DET-PIETONS
P-VOI-ENTRAVE
P-SEC-PROTECTION
FON-MRC-LIMITE
FON-MUNICIPAL-LIMITE
FON-C-FONCIERE-LIMITE
FON-C-ELECTORALE-LIMITE
FON-AUTRES-LIMITE
SIG-ACCESSOIRE

O 0O O O O O O O 0O O O O O o0 O

#2810 - 2837 —-7124 — 8152

o mtmdet2016_niveaux.dgnlib et mtmdet2016_tasks.dgnlib. Modification des calques et taches :
DRA-FOSSE-FOND

VOI-GLI-CAB-ACI-2F

E-FON-ZONAGE

VOI-GLI-TOL-AC

VOI-GLI-CAB-AC-2F

VOI-GLI-TOL-BO

O O O O O O
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Requétes SML/Gemini

#2701 —2907 - 3999 — 3976 - 7131

mtmdet2016_niveaux.dgnlib et mtmdet2016_tasks.dgnlib. Ajout des cellules et taches :
TRV7
CAMERA-VIDEO
CAPTEUR
COMPTEUR
DETECTEUR
NUMSORT_G
NUMSORT_D
CONE

CHEVRON
PASUTILISECONSTR
ATTIMP

O 0O 0O O O O O O o0 0 O

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif 213



7

R

Requétes SML/Gemini

#8154 - 8174

mtmdet2016_niveaux.dgnlib et mtmdet2016_tasks.dgnlib. Modification des cellules et taches :

O OO OO OO O0OO0OO0OO0OOO0oOO0OO0OO0OO0OO0OO0OO0OO0OO0OO0OO0OO0OO0

#9258 — 9277

CARCOOURB
CARSPIRA
CERTIPIQ
COORPOIN
DIRECTD
DIRECTG
EMPREXIS
EMPRPROJ
ENGAZONN
EQUATION
NOMPTGEO
NONACCES
NONACCPR
NOTE_DESC
NUMMODIF
NUMPOINT
NUMPOINT2
PLANTELL
QUADPROF
REPARPEN
REPPLANT
SONDAGE
SOUMISSI
TABMODIF
ZONEA
ZONENONA

o echel_dyn.cel. Ajout de I'échelle H 1:200 /V 1:200. Modification pour remplacer le mot Echelle par Horizontale pour les échelles sans aspect vertical.

#2907

o mtmdet2016_textdim.dgnlib. Ajout du style de texte ARIALN associé a la police de caractére Arial Narrow.
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Requétes SML/Gemini

#7109

©)

#3957 —

o

#6092

#9253

#9257

#9327

#9404

#9407

#9416

Fichiers de tracage CTB. Modification des fichiers CTB existants et ajout du fichier mtq2016(signalisation).ctb.
8152 — 8160 — 8221 —9280 - 9363 - 9295

PresentConcep.dgn et PresentArpent.dgn. Modifications diverses des cartouches :
o Etiquettes
o Légendes
o Logos

mtmdet 2016 > fichier_mtqg > Impression de sections en travers. Permet maintenant I'impression en couleur (Dossiers TABLOID COULEUR et LEGAL_COULEUR). Détection automatique
des cartouches du modele (en référence ou non).

mtmdet 2016 > fichier_mtqg > Exporter en format DWG. Amélioration de I'outil.
mtmdet 2016 > fichier_mtqg > Exporter modeéle courant en format DWG. Ajout de I'outil permettant d’exporter le modéle courant seulement en format DWG.

PresentConcep.dgn. Corrections des tables des matieres des feuilles V-2380 et Tables des matieres.

mtmdet_motif.cel. Ajout d’une bibliotheque de cellules permettant d’effectuer divers motifs d’hachurage. Incorporation cette la bibliothéque de tous les motifs d’hachurage présents
dans la bibliotheque mtq2015v2.cel.
mtmdet 2016 > hachures_mtq >Hachure par motif. Assignation par défaut de la bibliotheque mtmdet_motif.cel et du motif RE\V/_PROT.

mtmdet 2016 > textes_mtq > Editer texte. Ajout d’un outil permettant I’édition du texte dans la barre de taches.

mtmdet2016_textdim.dgnlib. Désactivation de I'option d’affichage de la lignhe de repére des cotations de petites tailles pour tous les styles de cotations.

mtmdet_motif.cel. Modification du motif d’hachurage IMM_ACQUERIR _MS. Les points de I’hachurage sont définis avec une largeur pour permettre I'affichage adéquat du motif.
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Requétes SML/Gemini

#9420

o mtmdet 2016 > mise_en_page_mtqg > Définir la Direction Territoriale. Ajout de la Direction des projets et de I'exploitation du réseau.
o mtmdet 2016 > mise_en_page_mtq > Définir le Service. Ajout du Service de la conception.

#9488
o mtmdet 2016 > fichier_mtq > Liens internets. Corrections des liens.
o mtmdet 2016 > fichier_mtq > AutoTurn. Support de la version 10 du logiciel.
o mtmdet 2016 > cellules_mtqg > Changer Tags. Ajout de I'outil pour permettre la modification globale des jeux d’étiquettes.
o mtmdet 2016 > lignes_dessin_mtqg > Attributs lignes. Ajout des outils pour les attributs lignes (EX/, PRO et DEM).
o mtmdet2016_niveaux. Corrections des priorités d’affichage.
o mtmdet 2016 > marquage...3D. Corrections du positionnement des icones et du texte dans le document.
o (2D) SIG-PAN-DANGER.cel, (2D) SIG-PAN-INDIC.cel, (2D) SIG-PAN-PRESC.cel et (2D) SIG-PAN-TRAVAUX.cel. Ajout de nouveaux panneaux dans les bibliotheques de cellules.
o PresentConcep.dgn. Modele \/-2381. Correction de quelques éléments du cartouche.
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Power InRoads (Conception)
#2837

o Tools > Named Symbology Manager et Tools > Style Manager. Ajout de la symbologie PEP pour relever les piéces d’extrémité de ponceau.
#2634

o Tools > Named Symbology Manager et Tools > Style Manager. Ajout de la symbologie VUR pour relever les murs autre que les murs de souténement.
#2701

o Tools > Named Symbology Manager et Tools > Style Manager. Ajout des symbologies :
o CAM pour une caméra-vidéo;
o CTR pour un capteur,;
o CMR pour un compteur;
o DTR pour un détecteur.

#2837

o Tools > Named Symbology Manager et Tools > Style Manager. Ajout des symbologies :
o GDF pour les glissiéres a deux faces en téle ondulée;
o GDC pour une glissiere a 2 cables, poteau d'acier.

#6086

o Evaluation > Cross Section > Cross Sections > Create Cross Section. Ajout de la préférence TABLOID500 permettant la création d’un jeu de section en travers a I’échelle 1:500. Changement
du chemin de recherche pour les préférences affichant des cartouches.

#9272
o GabMTMDET2016.itl. Ajout du gabarit Composants > Divers > Isolation polystyréne pour définir une isolation en remblai léger.
#9264

o GabMTMDET2016.itl. Corrections de toutes les conditions de raccordement et les profils en travers de 1" classe (Roc) :
o Ajout des conditions de raccordements Coupe Roc SansBermelnf (D) et Coupe Roc SansBermelnf (D);
o Ajout d’une condition de raccordement TalRoc(3<H<6) D et TalRoc(3<H<6) D pour refléter la norme;
o Ajout des points PtConstrRoc D et PtConstrRoc G pour corriger un probléme avec la création de surface alternative.

Paramétrage Power InRoads — Norme 2019-V2 — Guide explicatif 217



Requétes SML/Gemini

#9488

o GabMTMDET2016.itl. Ajouts et corrections :
o Ajustements des valeurs des tous les gabarits avec des trottoirs monolithiques;
o Ajout dans la documentation des composants SFond Transition Sol-Roc (D) et SFond Transition Sol-Roc (G) dans Composants > Structure de chaussée — Rural;
o Ajout des gabarits Conservation - Chaussée Existante et Type B,C,D,E,F — Conservation dans Profils en travers > Réhabilitation de chaussée;
o Ajout dans la documentation des profils en travers 4 voies.
o 06_40K_2016.sup, spi06_40K_2016.sup, 06_100K_2016.sup et spi06_100K_2016.sup. Corrections des valeurs des tables.
o Evaluation > Profile > Create Profile. Ajout des préférences Ponceau et 1:100.
o Drafting.bat. Correction de la mention MTQ par MTMDET.
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Norme 2017

Power InRoads (Plateforme)
#2286

o mtmdet2017.dgnlib.
o Ajout des niveaux d’une nouvelle catégorie Gestion de la Sécurité Routiere (GSR) pour définir des schémas d’accidents.
o Ajout des gabarits d’éléments de cellules (points) de la nouvelle catégorie.
o Ajout des gabarits d’éléments de cellules (points) de la nouvelle catégorie.

o mtmdet.cel. Ajout des cellules de la nouvelle catégorie.
#4066

o mtmdetConversion.dgn. Prototype servant a la conversion de coordonnées dans le systeme de projection MTQ Québec Lambert.
#6095

o mtmdet2017.dgnlib. Correction des priorités dans les niveaux.

#9525 — 9532 — 9549 - 9594
o PresentConcep.dgn, PresentArpent.dgn. Modeles \/-2381.
o Modification de la longueur lignes des styles de traits pour la catégorie Services Publics pour I'affichage adéquat du style de trait.
o Réorganisation des colonnes.
o Corrections de fautes d’orthographes.

#9263

o mtmdet_acadcolor.tbl, mtmdet_acadcolor.ba, mtmdet_acadcolor.bas. Correction de la couleur 224 (RGB) par 'utilisation d’une nouvelle table de couleur affectée a tous les dessins.
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#9369
o mtmdet.cel. Ajout de la cellule CartConcep2382 SansCadre pour placer I'information /-2382 dans un feuillet dont la largeur est non standard.

o mtmdet.cel. Suppression de la cellule CartConcep2381.

#9384

o mtmdet.cel., mtmdet2017.dgnlib. Ajout des cellules bartrav, flechetrav_double, flechetrav_barre, flechetrav_droite et flechetrav_gauche.

#9407
o mtmdet2017.dgnlib. Ajout du style FlecheV L permettant d’effectuer des cotations avec une orientation de texte a la verticale.

o mtmdet 2017 > cotation_mtqg > Renverser texte d’une cote. Ajout d’un outil permettant de renverser texte selon le texte d’une cotation selon I'orientation de la vue.

#9425
o echel_dyn.cel. Ajout de I'échelle H 20000.
#9462
o mtmdet_motif.cel, mtmdet2017.dgnlib. Ajout des hachures ENTRAVE-GC, TROTTOIR, CH-GRAVIER et PAVAGE-DEM.
#9482
o PresentConcep.dgn, PresentArpent.dgn. Modeles Feuillet 11 x 17 — MITMDET et Feuillet 11 x 17 - Mandataire. Ajout d’un espace réservé pour un sceau d’ingénierie.
#9500
o PresentArpent.dgn. Ajout de I'attribut (étiquette) CRT_LIEU_SIGN dans tous les modéles.
#9530

o mtmdet2017.dgnlib. Correction de la couleur (121) des niveaux E-DRA-PONCEAU et E-DRA-PROTECTION.
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#9585

o  mtmdet 2017 > fichier_mtq > Liens Web. Correction du lien pour PLN et suppression du lien pour SVIL.
o  mtmdet 2017 > fichier_mtq > Exporter les configurations réseau localement. Modification des propriétés de I'outil.
o  mtmdet 2017 > fichier_mtq > Ouvrir Femplacement dans Google Maps. Ajout de I'outil permettant d’ouvrir Google Maps a la localisation d’un point du modéle.
o mtmdet.cel. Correction de la cellule CartConcep2382.
o PresentConcep.dgn. Correction des feuilles MTQ pour MTMDET.
o mtmdet 2017 > textes_mtq > Appliquer/Supprimer I’arriére-plan d’un texte. Correction de I'outil.
o mtmdet 2017 > textes2_mtq > Placer annotation. Correction des outils.
o  mtmdet 2017 > fichier_mtq > Créer carte WMS. Mise-a-jour des liens WMS.
o mtmdet 2017 > cotation_mtg Remplacement du style Fleche L par le style Fleche LM par défaut.
o mtmdet2017.dgnlib. Regroupement de tous les fichiers DGNLIB en un seul.
BENTLEY — 156479

o mtmdet 2017 > mise-en-page_mtq > sm_mtq, dg_mtq et dir_mtq. Modifications des étiquettes de cartouche et de tous les prototypes pour refléter les changements administratifs.
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Power InRoads (Conception)
#9515

o GabMTMDET2017.itl.
o Ajout du gabarit RembPier dans Composant > Structure de chaussée — Rural;
o Ajout des gabarits Type B,C,D,E,F (SFond avec Déblai) dans Profils en travers > Ruraux — 1ére classe et Type B,C,D,E,F - Roc (RembPier) dans Profils en travers > Ruraux — 1ére classe.
o Ajout de la symbologie et du style RembPier.

#9523

o GabMTMDET2017.itl. Correction de la hauteur des poteaux a 780mm pour les gabarits contenants des glissiéres semi-rigides de type W/AE/1905 et W/BE/1905.
#9568

o CivMTMDET2017.xin. Ajout des symbologies et des styles GlisExi D, Gliskxi G, GlisAciExi_D et GlisAciExi_G pour la représentation de glissieres existantes dans les gabarits.
#9298

o GabMTMDET2017.itl. Ajout des gabarits Type Chemin Gravier (Gils) (Param) dans Profils en travers > Ruraux — 2e classe.
o Norme2017 > Documentation. Ajout de I'utilitaire Excel Générateur de Parameétres de Contraintes (GPC2.xls) permettant de produire les parametres de contraintes pour le positionnement
de glissiere de sécurité semi-rigide.

#9558
o Geometry > View Geometry > Stationing. Ajout de la préférence 1:250 pour I'annotation des chainages a cette échelle.
#9585

o CivMTMDET2017.xin.
o Ajout des symbologies et styles ServitudeExi et ServitudePro.
o Ajout des symbologies et styles (COMP) BbPlanage et (COMP) BbCorrection.
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Norme 2019

Power InRoads (Plateforme)

Gemini - Norme-160680 / TP_DAO-157411, Norme-160692 / TP_DAO-157112 et TP_CONCEPT-203151
o PresentConcep.dgn. Ajustement de la partie inférieure du modele V-1350.
Gemini - Norme-160671 / TP_DAO-154032 et Norme-160679 / TP_DAO-157412
o PresentConcep.dgn. Corrections du modele /-2381.
Gemini Norme-160684 / TP_DAO-157372
o PresentConcep.dgn. Correction de la justification des attributs Nature des modifications de tous les modeles V/-*.
Gemini - Norme-160682 / TP_DAO-157374
o PresentConcep.dgn. Ajout de I'attribut CRT_RTSS dans la case Description du modéle Feuillet 875 x 14 - MITQ.
Gemini - Norme-160673 / TP_DAO-141893
o PresentConcep.dgn. Ajustement des attributs de titres dans la case Titre des modeéles \/-2382 et \/-2383.
Gemini - Norme-160674 / TP_DAO-141883
o PresentConcep.dgn. Ajout des attributs CRT FQ TECH 1, CRT EQ TECH 2,CRT EQ TECH 3, CRT EQ TECH 4 dans la section Equipe technique de la plupart des modéles du dessin.
Gemini - Norme-160685 / TP_DAO-157371
o PresentAccident.dgn. Modification de tous les modéles du dessin. Ajout du tableau Surface/Temps et d’une légende graphique au tableau Total des accidents.
Gemini - MMTQ-160599 / TP_DAO-160648
o mtq2019.dgnlib. Ajout du niveau E-FON-IMPORT-LOT.
Gemini - Norme-160681 / TP_DAO-157381
o mtq2019.dgnlib. Ajout du niveau E-FON-CADAS-LOT-TREF.
Gemini - Norme-160676 / TP_DAO-135125

o mtq2019.dgnlib. Ajout des niveaux E-TOP-LIDAR_AERO, E-TOP-LIDAR_TER et E-TOP-LIDAR_MOB.
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Gemini - Norme-204649 / TP_DAO-202815

o

PresentArpent.dgn. Gel du niveau PAP-FEUIL-RUBRIQ-GES dans les cartouches d’arpentage

Gemini - Norme-160670 / TP_DAO-160142

o

mtq2019.dgnlib. Ajout du niveau P-TOP-CHANG-PENTE.

Gemini - Norme-160668 / TP_DAO-160141

o

projet.cel. Ajout des cellules LmTravaux G et LmTravaux_D pour indiquer la limite de travaux.

Gemini - Norme-160683 / TP_DAO-157373 et Norme-160683 / TP_DAO-157373

O
©)

projet.cel. Ajout des cellules RegModif Ent et RegModif Desc pour le registre des modifications.
projet.cel. Supression de la cellule Tabmodif.

Gemini - Norme-160672 / TP_DAO-153609

©)

projet.cel. Ajout d'un symbole de croix sur le point d’insertion des blocs de glissiéres.

Gemini - BENTLEY-203071 / TP_CONCEPT-160032

0O 0O 0O O O o o0 O o o o

projet.cel. Modification du nom de la bibliothéque de cellules mtq.cel.
accident.cel. Création de la bibliotheque de cellules.

projet.cel. Suppression des cellules pour les accidents.

signalisation.cel. Création de la bibliothéque de cellules.

projet.cel. Suppression des cellules pour la signalisation.

motif.cel. Modification du nom de la bibliotheque de cellules mtq_motif.cel.

Fichiers prototypes. Ajustement des prototypes pour attacher projet.cel comme bibliothéque de cellules.

Fichiers TXT. Ajustement des bibliothéques de cellules dans les fichiers TXT du répertoire Tasks.
mtq2019.dgnlib. Modification du fichier pour refléter les changements des bibliotheques de cellules.
mtq2019.dgnlib. Modification du fichier pour refléter les changements de nom mtmdet par mtq.
mtq3D.dgn.

Gemini - BENTLEY-160779 / TP_CONCEPT-159439

224

©)
©)

mtg 2019 > hachure_mtq > Hachurage par motif. Suppression du motif REV PROT par défaut.
motif.cel. Correction des motifs MG-112 et CG-14.
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Gemini - BENTLEY-181940 / TP_CONCEPT-161483

o mtq 2019 > mise-en-page_mtq > direction_mtq. Les attributs de I'unité administrative « Direction des projets - Etudes et structures » s’écrient sur deux lignes.

Gemini - BENTLEY-181941 / TP_CONCEPT-181937

o PresentConcep.dgn. Modification du niveau PAP-FEUIL-RUBRIQ-VERIF dans la partie Vérificateur du modele \/-2381. Ce niveau est désactivé par défaut.

Gemini - BENTLEY-161381 / TP_CONCEPT-161201

o PresentConcep.dgn. Ajout des libellés du nom de modele et de la date/heure dans le modele Feuillet Avant-Projet.
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Power InRoads (Conception)

Gemini - BENTLEY-203071 / TP_CONCEPT-160032

©)
©)
(©)

o

mtq2019.dgnlib. Ajustement du fichier XIN dans Project Explorer.

gabMTQ2019.itl. Ajustement de la hauteur du poteau a 780mm dans tous les gabarits contenant un dispositif de retenu.

civMTQ2019.xin. Correction des préférences (GEO) LignRefProj V1 @ V8 pour I'assignation de la couleur de courbe verticale a partir de I'outil Geometry > View Geomatry > Vertical
Annotation sous I'onglet Curves.

gabMTQ2019.itl. Ajout du gabarit Type B,C,D,E,F (BbBase sous AccPav) .utilisant un enrobé bitumineux de base en pleine longueur en dessous de I'accotement pavé.

Gemini - BENTLEY-160791 / TP_CONCEPT-159042

O
O
O

civMTQ2019.xin. Ajout du style projeté Parapet dans Tools > Style Manager.
gabMTQ2019.itl. Ajout de Parapet dans Point Name List.
gabMTQ2019.itl. Modification des noms et styles de point Gliss par Parapet du gabarit Pont (Gliss 210B) de la catégorie Profils en travers > Ouvrages d’art.

Gemini - BENTLEY-153710 et TP_CONCEPT-204184

o

civMTQ2019.xin. Ajout des symbologies et styles GlisExi et GlisAciExi dans Tools > Style Manager.

Gemini - TP_CONCEPT-203719

o

civMTQ2019.xin. Ajout de la préférence LEGAL pour I'impression en format 8.5X14 d’un diagramme de masse dans |'outil Evaluation > Cross Section > Cross Sections, arborescence End-
Area Volumes.

Gemini - TP_CONCEPT-157437

o

acad.pat. Ajout du fichier de motif d’hachurage d’AutoCAD dans le répertoire Norme2019-V2/Support.

Gemini - BENTLEY-160998 / TP_CONCEPT-160975

o

gabMTQ2019.itl. Ajout des gabarits Type B,C,D,E,F - Déco (GTB-TAH) et Type B,C,D,E,F - Déco (GTB-TAH-TAB) dans la catégories Profils en travers > Réhabilitation de chaussée. Les gabarits
s’accrochent automatiquement avec les styles TAH, TAB et GTB présents dans une surface existante.

Gemini - TP_CONCEPT-203945

O
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DWGsave.dws. Ajustement de I'option de sauvegarde des polylignes en 3D pour I'utilisation des outils MTQ 2019 > ficher_mtq > Exporte en DWG et Exporte modeéle courant DWG.
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Requétes SML/Gemini

Gemini - BENTLEY-124262 / TP_CONCEPT-160028

o gabMTQ2019.itl. Ajout des gabarits Elarg (D) (G), Elarg (D) (G) (Terre-plein Bord), Elarg (D) (G) (Terre-plein Trot), Elarg (D) (G) (Terre-plein), Elarg (D) (Tranchée) et Elarg (G) (Tranchée)
dans la catégorie Profils en travers > Elargissements.

Gemini - BENTLEY-160793 / TP_CONCEPT-159035 et TP_CONCEPT-203152

o DraftingMTMDET2019.dft. Ajout des notes Limite Travaux dans les outils Drafting > Place Alignment Intersection Note, Place Profile Note et Place Plan Note dans les catégories
Intersection 1:1000, Intersection 1:500, Plan 1:1000, Plan 1:500, Profil 1:1000 et Profil 1:500.

Gemin - BENTLEY-160792 / TP_CONCEPT-157868
o ¢civMTQ2019.xin. Ajout des symbologies et styles ServitudeExi et ServitudePro permettant I'affichage du positionnement des servitudes existantes et projetées en section en travers.
Gemini - BENTLEY-161260 / TP_CONCEPT-160965

o gabMTQ2019.itl. Suppression de SFond Transition Sol-Roc (D) et SFond Transition Sol-Roc (G). Remplacer par Transition Sol-Roc (D) et Transition Sol-Roc (D) dans la catégorie Composants
> Structure de chaussée - Rural. Modification des gabarits Type B,C,D,E,F - Transition Sol-Roc (D) et Type B,C,D,E,F - Transition Sol-Roc (G) dans la catégorie Profils en travers > Ruraux -
lere et 2e classe.

Gemini - BENTLEY-153469 / TP_CONCEPT-160030

o gabMTQ2019.itl. Ajout du gabarit Type B,C,D,E,F (Transition) dans la catégorie Profils en travers > Tranchée pour permettre le calcul de quantité de la surexcavation de la transition
longitudinale 1:20 a partir du début de la profondeur P a gauche et a droite de la tranchée.
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Requétes SML/Gemini

Norme 2019-V2

Power InRoads (Plateforme)
Gemini BENTLEY-251016

mtq2019.dgnlib. Adaptation a la norme (XIN, CTB).

DWGsave.dws. Correction pour la sauvegarde des fichiers en format DWG.
drafting.bat. Adaptation a la norme.

2019-V2.cfg. Adapatation a la norme.

0O O O O

Gemini - Norme-228105 / TP_DAO-228096

o PresentConcep.dgn. Ajout de I'attribut CRT_RTSS dans les modeles de dessin suivants :
o Feuillet 8,5x14 — Mandataire
o Feuillet 8,5x14 — MTQ
o Feuillet 11 X17- Mandataire
o Feuillet 11 X 17 - MTQ

Gemini - Norme-228645 / TP_DAO-228525

o PresentConcep.dgn. Modifications a tous les cartouches pour refléter les informations du Guide de réalisation de plans d’infrastructures de transport.

Gemini - Norme-250011 / TP_DAO-135160
o mtq2019.dgnlib. Ajout des calques pour le systeme //T.
Gemini - Norme-250850 / TP_DAO-135147
o mtq2019.dgnlib. Ajout des niveaux pour Panneaux.
Gemini - Norme-250850 / TP_DAQO-135147
o (2D) SIG-PAN-TRAVAUX.cel. Remplacement des cellules.
Gemini - TP_CONCEPT-250892 / BENTLEY-250893
o WmsServerlList.xml. Ajout d’un lien SCO pour les utilisateurs externes.
Gemini - TP_CONCEPT-192051 / BENTLEY-250737

O aires.cel. Ajout des aires de cartouches pour les feuillets d’accidents Feuillet A - 11 x 17, Feuillet B - 11 x 17 et Feuillet 8% x 14.
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https://www.transports.gouv.qc.ca/fr/entreprises-partenaires/entreprises-reseaux-routier/guides-formulaires/documents-preparationprojetsroutiers/GuideRealisationPlansInfrastructuresTransport.pdf

Requétes SML/Gemini

Power InRoads (Conception)
Gemini - TP_CONCEPT-160559 / BENTLEY-160780

o CivMTQ2019-V2.xin. Correction des cellules pour les styles de glissiéres.
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Notes
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